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ПРИМЕЧАНИЕ 
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Напечатанная инструкция пользователя 
Зарегистрированным владельцам ПО BERNINA Embroidery Software разрешается распечатать 1 (одну) копию 
Инструкции пользователя ПО BERNINA Embroidery Software для личного пользования. Копия может быть распечатана 
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Ограниченная Гарантия 
Фирма BERNINA International AG гарантирует, что в течение 90 дней с даты приобретения Вами программного 
обеспечения программные продукты не содержат дефектов по материалам и качеству исполнения. Вам 
предоставляется исключительное право в случае обнаружения таких дефектов возвратить изделия вместе с 
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использования и принимает весь риск относительно результатов применения программного обеспечения. В 
соответствии с правовыми условиями гарантии фирма BERNINA International AG не принимает на себя все другие 
гарантии и условия, которые могут быть явно выражены или подразумеваемы, включая без ограничения, гарантии и 
условия пригодности для продажи, соответствия для специфического использования и отсутствие контрафакции. 
Фирма BERNINA International AG специально не гарантирует, что программное обеспечение будет соответствовать 
всем требованиям покупателя или будет выполняться без прерываний или ошибок, в полном соответствии с описанием 
в сопровождающей документации. 
 
Ограничения Ответственности 
Фирма BERNINA International AG, ее разработчики, менеджеры, служащие или работники филиалов в соответствии с 
применимым законом, ни в коем случае не несут ответственности за любые последующие прямые или косвенные 
убытки (включая убытки от потери деловой прибыли, перерывов в работе, потери коммерческой информации и т.п.), 
возникшие в результате неправильного использования программного обеспечения или прилагаемых защитного 
устройства и кабеля, а также сопровождающей документации, независимо от обоснования требования и даже, если 
фирма BERNINA или ее уполномоченный представитель уведомлялся относительно возможности таких убытков. 
В некоторых государствах законодательство или судебная практика не допускают исключения случайных, последующих 
или специальных убытков, так что вышеупомянутое ограничение или исключение не может быть применимо к Вам. 
 
Прекращение Действия Лицензионного Соглашения  
Ваша Лицензия на использование программного обеспечения фирмы BERNINA действительна до тех пор, пока Вы 
выполняете условия Лицензионного соглашения. Действие Лицензии завершится автоматически без уведомления 
фирмы BERNINA International AG, если Вы будете не в состоянии выполнять любое из условий Лицензионного 
соглашения. Вы можете прекратить действие этой Лицензии в любое время,  возвратив программное обеспечение и 
все его копии этого, аппаратный ключ "донгл" (Dongle), кабель и всю сопровождающую документацию фирме BERNINA 
International AG. 
 
КОНТАКТНЫЕ ТЕЛЕФОНЫ 
Если у Вас возникнут любые вопросы, обращайтесь, пожалуйста, Вашему дистрибьютору фирмы BERNINA, или 
BERNINA International AG  
CH-8266 Штекборн/Швейцария 
Тел.: (41) 52-762 11 11 
Факс: (41) 52-762 16 11 
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ГЛАВА 1 

 

 
ВВЕДЕНИЕ 

---------------------------------------------- 
 
 
 
Приглашаем Вас ознакомиться с программным обеспечением 
BERNINA Embroidery Software – ведущим программным продуктом 
для домашнего машинного вышивания. Вышивальное программное 
обеспечение BERNINA Embroidery Software является программным 
продуктом, основанным на операционной системе Windows, поэтому 
в нем используются многие команды, с которыми хорошо знакомо 
большинство пользователей персональных компьютеров. 

 
Программное обеспечение для вышивания BERNINA® Embroidery 
Software уникально в том плане, что оно отлично интегрируется с 
самым популярным среди домашних пользователей векторным ПО 
для рисования CorelDRAW® Essentials 4 от Corel Corporation. Сочетание возможностей 
ПО для вышивания BERNINA® Embroidery Software и графических возможностей пакета 
CorelDRAW® обеспечивает наиболее эффективные и удобные для пользователя 
возможности разработки образцов вышивок. Оно позволяет пользователям создавать не 
только образцы для вышивки, но и настоящие мультимедийные объекты дизайна. 
 
ВНИМАНИЕ: CorelDRAW® Essentials 4 и родственный пакет Corel PHOTO-PAINT® 
Essentials 4 могут использоваться и как самостоятельные приложенния. Полное описание 
инструментария пакета CorelDRAW® Essentials 4  имеется в электронном Руководстве 
пользователя, которое можно найти в разделе меню Windows Start > Programs. 
Дополнительно, программа имеет систему он-лайновой помощи, обратиться к которой 
можно через раздел меню Graphics->Help. 
 
 
 
 
 
 

Первичным пользователям 
Если Вы впервые приобрели вышивальное ПО 
BERNINA, то Вам очень понравятся гибкие 
возможности оцифровывания изображений и 
легкость, с которой Вы сможете создавать и 
редактировать образцы вышивки и простота, с 
которой можно добавлять или создавать свои 
собственные тексты. Однако прежде чем Вы 
начнете работать с программами, нужно 
прочитать главу Введение в оцифровывание 
проектов вышивки  в руководстве 
пользователя. В этой главе представлен обзор 
основных концепций оцифровывания функциями 
BERNINA Embroidery Software  и даются важные 
указания по использованию программы для 
получения наилучших результатов. 
Вы должны также ознакомиться с главой 
Основные процедуры  этого руководства. Здесь 

Вы узнаете, как запускать приложение, создавать 
или открывать проект, распечатывать рисунки 
вышивок и как использовать некоторые наиболее 
важные инструментальные средства и  
возможности, которые обеспечивает BERNINA 
Embroidery Software.  
 
Пользователям, обновляющим 
программное обеспечение 
Вышивальное ПО BERNINA Embroidery Software 
является усовершенствованной версией 
установленного у Вас ранее программного 
продукта. В нем предусмотрено много новых и 
расширенных функциональных возможностей. 
Ознакомьтесь с главой Введение в 
оцифровывание проектов вышивки в 
руководстве пользователя, чтобы быстро 
ознакомиться со всеми модификациями. 
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Уровни программного продукта BERNINA 
Embroidery Software  
Имеются два уровня вышивального 
программного обеспечения BERNINA: 
◄ BERNINA EditorPlus  
◄  BERNINA DesignerPlus 
 
Внимание: Уровни программного продукта 
контролируются аппаратным (электронным) 
ключом. Это устройство является наиболее 
важной и ценной частью Вашей системы, и с ней 
нужно обращаться осторожно. 
 

Примечание: Пользователи вышивального ПО 
BERNINA могут приобрести программы 
обновления непосредственно через Интернет. 
 

Программа BERNINA EditorPlus 
Программа BERNINA EditorPlus дает 
возможность редактировать существующие 
проекты и добавлять надписи. Вы можете также 
создавать привлекательные вышивки с 
минимумом усилий по отсканированным 
рисункам. Воспользуйтесь мощными средствами 
автоматического оцифровывания, такими как 
Auto Digitizer, Magic Wand и PhotoSnap. Эта 
система также позволяет: 
◄ изменять последовательности цветов для 

улучшения качества вышивки; 
◄ редактировать индивидуальные стежки для 

точной настройки обработки мотива. 
◄ использовать функцию Auto Digitizer для 

автоматического создания привлекательных  
вышивок по отсканированным оригиналам; 

◄ использовать инструмент Magic Wand 
("Волшебную палочку") для преобразования 
рисунка в вышивку; 

◄ использовать функцию PhotoSnap, чтобы 
преобразовать фотографии в строчечные 
вышивки. 
 
 

 
Программа BERNINA DesignerPlus 
Программа Designer Plus обладает мощными 
функциями, позволяющими оцифровывание, 
редактирование и создание надписей с 
использованием как автоматических, так и 
ручных инструментальных средств и способов 
оцифровывания. В частности, с этой системой 
можно: 
◄ использовать отсканированные или 

импортированные изображения для 
оцифровывания проектов на экране монитора; 

◄ в дополнение к автоматическим средствам 
оцифровывания можно использовать 
специализированные инструменты 
оцифровывания, а также большой набор 
художественных декоративных узоров 
заполнения; 

◄ создавать аппликации функцией Auto 
Applique; 

◄ преобразовывать любой шрифт Windows 
TrueType в вышивальный алфавит; 

◄ сохранять все предпочитаемые настройки в 
файле шаблона. 

 
Примечание: Для идентификации функций, 
реализуемых Вашей конкретной моделью, и 
опций, которые могут быть Вами выбраны, см. 
Список функций вышивального 
программного обеспечения BERNINA в этом 
руководстве. 
 
Документация BERNINA Embroidery Software 
Вышивальное ПО BERNINA предоставляет Вам 
разные способы доступа к информации по 
Вашему программному обеспечению и 
пользованию им как в печатном виде, так и в 
экранном отображении через меню Help. 
 
Внимание: Экранные иллюстрации в 
пользовательской документации дают лишь 
примерное представление и не являются 
точными копиями экранных изображений, 
воспроизводимых программным обеспечением. 
Процедурные описания могут слегка различаться 
при разных настройках при инсталляции в 
зависимости от принимаемых по умолчанию 
системных установках.  
 
Печатная документация 
В зависимости от приобретенного Вами уровня 
программного продукта вместе с установочным 
диском DVD Вы получаете следующую печатную 
документацию: 
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Краткое справочное руководство 
Краткое руководство пользователя BERNINA 
Embroidery Software содержит указания по 
инсталляции, а также  общую информацию по 
Вашему вышивальному программному 
обеспечению BERNINA. Там имеется также 
раздел с кратким справочником, содержащим все 
экранные и клавиатурные команды, 
используемые в Вашем программном 
обеспечении. В дополнении здесь же 
предлагается полностью обработанный образец 
проекта вышивки. Дополнительные средства 
обучения предусматриваются в отображаемом на 
экране руководстве. Хотя обучающие средства 
не охватывают всех функций, они дают полезную 
информацию для всех уровней программного 
обеспечения. 
 
Совет: Для детального ознакомления со всеми 
функциями вышивального программного 
обеспечения BERNINA (по всем уровням 
программного продукта) и приложений BERNINA 
Portfolio обратитесь к отображаемому на экране 
руководству, доступному через меню Help. Для 
идентификации источников информации, 
имеющих отношение к Вашей конкретной 
модели, и опций, которые могут быть Вами 
выбраны, см. Список функций вышивального 
программного обеспечения BERNINA в этом 
руководстве. 
 
Отображаемая на экране документация 
(только на английском языке): 
Документация отображается на экране в двух 
форматах – HTML Help и Adobe Acrobat. В 
зависимости от приобретенного Вами уровня 
программного продукта Вы получите следующую 
документацию в полном наборе или только часть 
из них: 
 
Замечания к программному обеспечению  
Комплект замечаний включается при 
инсталляции программного пакета. В них 
содержится детальная информация о новых и 
модернизированных функциях, а также прямые 
ссылки к соответствующим разделам экранного 
руководства. 
 
Краткое справочное руководство 
 
Краткое справочное руководство BERNINA также 
предоставляется в отображаемой на экране 
форме. В нем содержится дополнительная 
информация об обновлении программного 
продукта, а также прямые ссылки к 
дополнительным обучающим указаниям 
экранного руководства. 

 
Отображаемое на экране руководство 
В отображаемом на экране руководстве 
содержатся детальные процедурные описания 
всех функций вышивального программного 
обеспечения BERNINA, а также приложений 
пакета BERNINA Portfolio. Приводятся сотни 
пошаговых инструкций вместе с примерами и 
экранными изображаениями. Приложения 
BERNINA Cross Stitch и BERNINA Quilter 
документированы в отдельных дополнительных 
руководствах, описанных ниже. 
 

Онлайновая справка 
Онлайновая справка обеспечивает быстрый 
доступ к общей информации о функциях 
вышивального ПО BERNINA и к пошаговым 
инструкциям. 
 

Дополнительные руководства пользователя 
Ваш установочный DVD  BERNINA Embroidery 
Software позволяет также установить следующие 
дополнительные отображаемые на экране 
руководства: 
 

Экранное руководство BERNINA Cross Stitch 
В этом дополнительном руководстве 
описываются возможности специального 
приложения BERNINA Cross Stitch, позволяющего 
выполнять вышивки крестом. Вышивка крестом 
является популярной техникой заполнения 
больших фрагментов малым количеством 
стежков. Такие стежки можно использовать также 
для оконтуривания и обрамления. Вышивание в 
такой технике подходит для украшения 
домашнего текстиля, скатертей, детской одежды 
и фольклорных мотивов. Стежок для вышивки 
крестом иногда комбинируют с аппликацией. 
 

Экранное руководство BERNINA Quilter 
Onscreen 
В этом дополнительном руководстве 
описываются возможности специального 
приложения BERNINA Quilter, позволяющего 
работать в технике лоскутного шитья –пэчворка. 
Пэчворк – это популярная техника компоновки и 
сшивания лоскутов ткани в блоки. Программа 
BERNINA Quilter может быть использована для 
размещения лоскутных узоров на квилтах по 
существующим или по создаваемым 
собственноручно проектам. Используйте эту 
программу для экспериментирования с лоскутами 
ткани и цветом, чтобы создавать прекрасные 
квилты, отражающие вашу индивидуальность. 
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Условные, обозначения принятые в 
Руководстве 
 
В тексте руководства приняты следующие 
условные обозначения. 
 
Команды 
В этом руководстве команды меню или подменю 
указываются со ссылками на имена меню и 
команды. Например, команда ‘Show All’ 
(‘Показать Все’) из меню ‘View’ (‘Вид’) 
указывается как View > Show All. 
 
Диалоговые окна 
Диалоговые окна показываются в руководстве 
только в том случае, когда в них отображена 
важная информация для использования ПО 
BERNINA. Экранные иллюстрации дают лишь 
примерное представление и не являются 
точными копиями экранных изображений, 
воспроизводимых программным обеспечением. 
 

Команды для действий мышью 
 
Указание Символ Действие 
Щелчок 
мышью 
 

Щелкнуть левой 
кнопкой мыши  

Щелчок пра-
вой кнопкой 
мыши 

Щелкнуть правой 
кнопкой мыши  

Двойной 
щелчок 
 

Дважды щелкнуть 
кнопкой, не 
перемещая мышь  

Нажмите 
кнопку ОК. 

 

 

Щелкнуть мышью по 
кнопке OK 
диалогового окна, 
или нажать клавишу 
Enter клавиатуры, 
чтобы завершить 
действие.  

 
 
Комбинация 
клавиш 

Описание 

[Ctrt] + [S]  Удерживая нажатой клавишу CTRL, 
нажать клавишу буквы "S" в нижнем 
регистре  

[Clrl] + [Shift] + 
[H]  

Удерживая нажатой клавишу CTRL, 
нажать клавишу SHIFT и клавишу буквы 
"Н".  

 
Полный перечень клавиатурных команд 
приводится в Кратком справочном руководстве 
 
Просмотр отображаемой на экране информации 
 
Выберите Help Topics (из меню Help), чтобы 
просмотреть онлайновую справку. 
Выберите Online Manual (из меню Help), чтобы 
просмотреть онлайновое руководство. 
 
Выберите Bernina International Home Page (из меню 
Help), чтобы просмотреть международный сайт 
Bernina. 
 
Выберите Bernina of America Home Page (из меню 
Help), чтобы просмотреть сайт Bernina of 
America. 
 
Выберите Embroidery Onscreen (из меню Help), 
чтобы просмотреть сайт Embroidery Online. 
 
Экранная документация пользователя 
предоставляется в форме экранного руководства и 
экранных справок. 
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Просмотр онлайновой справки 
Онлайновая справка обеспечивает быстрый доступ 
к общей информации о функциях вышивального ПО 
BERNINA и к пошаговым инструкциям. 
 
Как просмотреть онлайновую справку 
1 Выберите Help > Help Topics, чтобы открыть 

главное окно справки  Help. 
2 Нажмите кнопку Contents (Содержание), чтобы 

открыть главный список тем справки. Темы 
сгруппированы под заголовками высшего уровня 
со значками "Книга". 

3 Дважды щелкните по значку "Книга", чтобы 
просмотреть список тем, а затем дважды 
щелкните по выбранной теме. 

 
Совет: Альтернативно нажмите кнопку Find (Найти) 
и введите ключевое слово, чтобы найти 
интересующий вас ответ.  
 
Просмотр экранного руководства 
Вы можете прочитать экраннон руководство, 
используя программу Adobe Acrobat™ Reader. Эта 
программа поставлена вам вместе с вышивальным 
ПО BERNINA. В экранном руководстве вы можете 
быстро найти нужную вам информацию, используя 
стандартные функции программы Adobe Acrobat™ 
Reader. 
 
Как просмотреть экранное руководство 
 
◄ Выберите Help > Onscreen Manual. 
 
Примечание: Если программа BERNINA не 
запущена, вы можете открыть экранное руководство 
непосредственно из Windows Explorer (Проводника 
Windows). Для этого найдите папку ..\Program 
Files\BERNINA\Embroidery Software 6\bin и дважды 
щелкните по файлу UserManual.pdf. 
 
Соединение с веб-сайтами BERNINA®  
Вы можете получить доступ к информации о 
приобретении и поддержке программных продуктов 
непосредственно из ПО. 
 
Примечание: Вы должны иметь правильно 
сконфигурированный веб-браузер в своей системе 
совместно с доступом к Интернету. 
 
Как соединиться с сайтом BERNINA®  
 
◄ Соединитесь с вашим интернет-провайдером.  
◄ Выберите Help > BERNINA Web Page. 

Вы непосредственно соединитесь с домашней 
страницей BERNINA® по следующим адресам:  
◄ Bernina International -http://www.bernina.com/ 
◄ Bernina of America - 

http://www.berninausa.com/ 
◄ Embroidery Online -  

http: / /www. embroider yonline. com
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ГЛАВА 2 

 

 
 

ИНСТАЛЛЯЦИЯ И НАСТРОЙКА 
----------------------------------------------
 
 
Комплект вышивального программного обеспечения 
BERNINA содержит следующие компоненты: 
◄ Установочный DVD BERNINA Embroidery 

Software  
◄ Аппаратный ключ для USB-порта с 

присоединенным ярлыком 
◄ Краткое справочное руководство BERNINA 

Embroidery Software  
 

Примечание: На установочном DVD BERNINA 
Embroidery Software записаны все программные 
продукты, включая BERNINA DesignerPlus, BERNINA 
EditorPlus,  BERNINA Portfolio, BERNINA Cross Stitch 
и BERNINA Quilter. 
 

 
Системные требования 
Чтобы запустить вышивальное ПО BERNINA, Вы 
должны убедиться в том, что выполнены 
приводимые ниже обязательные системные 
требования. 
 

Характеристики компьютера 
Проверьте, соответствует ли Ваш ПК системным 
требованиям. Проверьте центральный процессор и 
оперативную память, а также свободное 
пространство на жестком диске. В таблице  
приведены минимальные и рекомендованные 
системные требования. 

 

Аппаратные 
средства 

Минимальные требования 
 

Центральный 
процессор 

Single Core 1 ГГц) или более 
производительный процессор 
 

Операционная 
система 

Windows XP® SP2 (Home или 
Professional) 
  

Подключение к 
Интернету 

Опционально: Для доступа к сайту 
Bernina для регулярной 
информации о программных 
продуктах и обновления 

Web-браузер Internet Explorer 6.х 
  

Память 1 Гб для многократных 
приложений  

Свободное 
пространство на  
жестком диске 

30 Гб перед инсталляцией 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Аппаратные 
средства 

Минимальные требования 
 

Свободное дисковое 
пространство 
 

2ГБ, или более 10 % от общего объема 
жесткого диска, смотря что больше 

Дисковод Для DVD-ROM для инсталляции ПО 
Графическая карта Поддержка High Color (16-bit) и высокая 

разрешающая способность – по 
меньшей мере 1024 x 768 

Монитор 15" или больше для оцифровывания на 
экране  

Порт USB Выделенный порт USB для защитного 
ключа 
Дополнительный порт USB для 
подключения прибора BERNINA 
Reader/Writer Box или для прямого 
подключения вышивальной машины  

Последовательные 
порты 

Дополнитнльнвый последовательный 
порт для подключения прибора 
BERNINA Reader/Writer Box 
(опционально) 

Сканер Совместимый с MS Windows® XP 
Принтер Совместимый с MS Windows® XP 
Мышь Совместимый с MS Windows® XP 
Звуковая карта Не требуется 
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Защитный аппаратный ключ 
 
Вышивальное ПО BERNINA контролируется 
защитным устройством – аппаратным ключом 
("донглем"), подключаемым к компьютеру, а также 
защитными кодами доступа, вводимыми в 
программное 
обеспечение. Каждый 
аппаратный ключ имеет 
серийный номер и 
идентификационный код, 
так что Ваша система 
может быть однозначно 
распознана. 

Аппаратный ключ для 
порта USB 

 Внимание: Не вставляйте аппаратный ключ 
до тех пор, пока не появится соответствующее 
требование программы установки. В противном 
случае будет использован собственный драйвер 
USB, предотвращающий правильную работу 
системы защиты. 
 
Все последние выпуски программного пакета, 
нового или для обновления предыдущей версии, 
поставляются с аппаратными ключами для порта 
USB – аппаратные ключи для параллельного порта 
больше не применяются. При обновлении ПО вам 
нужно выполнить перенести данные с предыдущего 
аппаратного ключа на новый (функция 'brain 
transplant').  

Внимание: Если при работе с ПО BERNINA 
аппаратный ключ будет удален или потеряет 
контакт, появится сообщение об ошибке. Удалите 
это сообщение и затем закройте программу 
BERNINA Embroidery Software. При этом будут 
потеряны несохраненные изменения в проекте. 
Вставьте повторно аппаратный ключ в ПК, обратив 
внимание на плотность контактов, затем 
перезапустите программу BERNINA Embroidery 
Software. 
 

 
Опции инсталляции 
 
Имеется возможность выбрать одну из следующих 
опций инсталляции: 
◄ в каком месте вашего ПК или в сети будет 

установлено ПО и коллекции образцов 
◄ какие компоненты должны быть установлены, - 

например, дополнительные языки, программа 
BERNINA Portfolio  

◄ какие файлы документации будут установлены 
 

Примечание: Флажок в окошке "BERNINA 
Embroidery Software" должен быть установлен 
всегда. Опция "Extra Languages" ("Дополнительные 
языки") может отсутствовать в зависимости от 
приобретенного вами выпуска программного 
изделия. 
 
Слияние версий программного обеспечения 
Вы можете выбрать слияние с уже установленной 
версией ПО. Существующие компоненты 
обрабатываются следующим образом: 
 
Мотивы вышивок 
Вышивальное программное обеспечение BERNINA 
позволяет добавлять мотивы к любому заранее 
определенному комплекту мотивов, а также 
создавать новые. Они могут быть также изменены 
для последней заводской версии этих файлов. 
Программа инсталляции проверяет все 
существующие в вашем ПК мотивы и производит их 
преобразование для совместимости с новой 
версией ПО. 
 
Шаблоны 
Вышивальное программное обеспечение BERNINA 
позволяет также изменять установленные шаблоны 
и создавать новые. Они могут быть также изменены 
для последней заводской версии этих файлов. 
Программа инсталляции проверяет все 
существующие в вашем ПК шаблоны и производит 
их преобразование для совместимости с новой 
версией ПО. 
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Таблицы ниток 
Если вы изменили установки в таблицах ниток, они 
будут сохранены. 
Материалы аппликаций 
Образцы материалов аппликаций используются 
теперь в приложениях BERNINA Embroidery Software 
и BERNINA Quilter. Вы могли добавить или изменить 
материалы в существующей установке BERNINA 
Quilter. При установке материалов инсталляционная 
программа проверяет существующие файлы 
материалов и преобразует их для новой версии. 
 
Примечание: Любые изменения, которые вы 
произвели в существующей библиотеке BERNINA 
Quilter, будут преобразованы для последней версии. 
 
Что можно и чего нельзя делать 
◄ Никогда не удаляйте установленное ПО 

BERNINA Embroidery Software вручную путем 
выделения программных файлов и нажатия 
клавиши Delete. Это относится ко всем 
приложениям Windows. 

◄ Избегайте удаления ПО BERNINA Embroidery 
Software путем выбора функции Programs > 
BERNINA Embroidery Software > Uninstall из 
меню кнопки Start/Пуск на рабочем столе 
Windows или использования функции 
Add/Remove Programs / Установка/Удаление 
программ в Панели управления Windows. Оба 
эти метода удалят все файлы ПО, и вы 
потеряете все ваши персональные настройки. 

◄ Вместо этого позвольте установочной программе 
деинсталировать предыдущую версию в 
процессе установки новой версии BERNINA 
Embroidery Software в порядке обновлении 
программного обеспечения. Таким образом, 
программа инсталляции объединит уже 
выполненные пользовательские настройки с 
новыми установками. 

◄ При инсталляции ПО ваш компьютер 
автоматически перезагружается, чтобы 
обеспечить успешную установку программного 
обеспечения. Убедитесь в том, что перед  
перезагрузкой компьютера все файлы 
сохранены и закрыты все приложения. 
Установочная программа запросит вас об этом 
перед перезаспуском. 

◄ Если Вы удалили ПО BERNINA с 
использованием процедуры Programs > … > 
Uninstall или Add/Remove Programs, процесс 
деинсталяции может оставить некоторые файлы 
в папке. Вам потребуется вручную удалить эту 
папку и ее содержимое, используя Windows 
Explorer/ Проводник Windows. 

 

 
Установка вышивального программного 
обеспечения BERNINA  
 
Имеется возможность выбрать одну из следующих 
опций инсталляции: 
◄ в каком месте вашего ПК или в сети будет 

установлено ПО и коллекции образцов 
◄ какие компоненты должны быть установлены, - 

например, дополнительные языки, программа 
BERNINA Portfolio  

◄ какие файлы документации будут установлены 
 

Внимание: При обновлении программного 
обеспечения не удаляйте предыдущую версию. 
Позвольте установочной программе сделать это за 
вас. См. также Слияние версий программного 
обеспечения в этом руководстве.  
Как установить программное обеспечение 
BERNINA  
 
1 Убедитесь в том, что ваш компьютер 

соответствует требованиям программного 
средства BERNINA Embroidery Software. 
Подробнее см. Системные требования в этом 
руководстве.  

2 Закройте все программы Windows, но оставьте 
работающей ОС Windows  

Внимание: Не вставляйте аппаратный 
ключ до тех пор, пока не появится 
соответствующее требование программы 
установки. В противном случае будет 
использован собственный драйвер USB, 
предотвращающий правильную работу системы 
защиты. 
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3 Вставьте установочный DVD BERNINA 

Embroidery Software. Инсталляционная 
программа запустится через 30 секунд с 
появлением экрана с приветствием.  

4 Нажмите кнопку Next. 
5   Выберите, какую из программ следует 

установить и щелкните по Next. 
6.. Нажмите кнопку Next. 
     Появится экран с Лицензионным соглашением 

(License Agreement). Кнопка  станет Next серой 
до тех пор, пока вы не подтвердите согласие с 
условиями лицензионного соглашения ('I accept 
the terms of the license agreement'). 

 
Совет: Кнопкой Print вы можете распечатать 
текст Лицензионного соглашения.  

7  Щелкните по кнопке 
     для подтверждения и  
     нажмите Next. 

 
Появится окно Select Components (Выбор 
компонентов). Флажок в окошке "BERNINA 
Embroidery Software" должен быть установлен 
всегда. Если вы устанавливаете многоязыковую 
версию ПО, поставьте флажок опции Install 
extra languages. 

 
8  Выберите, какие из компонентов следует 
установить и щелкните по Next. Появится окно 
Choose Installation Folder (Выберите папку 
для установки). 

 

 
◄ Чтобы согласиться с предложенной по 

умолчанию папкой, нажмите кнопку Next. 
 

◄ Чтобы выбрать другое место, щелкните по 
Browse, назначьте существующую папку или 
создайте новую папку и щелкните по Next. 
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Примечание: Если в выбранной папке уже 
установлена программа, система выдаст 
предупреждение. 

 
 
9  Когда откроется диалоговое окно Choose 

Destination Location (Выбор места 
установки), выберите папку, в которой Вы 
хотите хранить свои образцы. 

 

 
 
По умолчанию предлагается папка My Designs – 
Embroidery Software 6. Коллекции образцов, 
включая входящие ПО, будут храниться в этой 
папке.  

◄ Чтобы согласиться с предложенной по 
умолчанию папкой, нажмите кнопку Next.  

◄ Чтобы выбрать другое место, щелкните по 
Browse, назначьте существующую папку или 
создайте новую папку и щелкните по Next. 
Если вы выбрали для установки ПО ту же папку, 
в которой уже установлена прежняя версия, то 
новая версия будет установлена сверх старой с 
одновременным слиянием. 

 
Примечание: Ваши собственные проекты не 
удаляются и не перезаписываются, но старые 
проекты могут быть замещены новыми с тем же 
именем.  
 

10 Нажмите кнопку Next. 
Если в вашем компьютере уже установлена одна 
или несколько старых версий ПО BERNINA:  
◄ Появится предложение удалить прежнюю 

версию (или версии). Если вы выберете эту 
опцию, старое ПО будет удалено. 

◄ Старая версия будет слита с новой после 
перезапуска ПК. 

11 Нажмите кнопку Next. 
Откроется окно Ready to Install (Готово для 
инсталляции). 

12 Щелкните по Install для продолжения. 
     
 
Теперь вам будет предложено вставить в порт USB 
компьютера аппаратный ключ (dongle). 

      
     
 
 
 
 
 
 
 
 
 

  
 

Если Вы приобрели  комплект ПО для обновления 
(Update), Вам будет предложено вставить в порт 
Ваш старый аппаратный ключ тоже.  
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13 Нажмите кнопку Next. 
 
В окне Setup Status будет появляться 
информация о ходе инсталляции.  
Программа CorelDRAW Essentials 4 будет 
инсталлирована в рамках  нормальной 
инсталляции BERNINA Embroidery Software. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

По завершении установки появится диалоговое 
окно Installation Complete. 
 
14 Щелкните по кнопке Finish, чтобы завершить 
установку.  У Вас теперь возможность 
перезагрузить компьютер.      Рекомендуется 
перезагрузить компьютер немедленно. 
На рабочем столе Windows появится 
соответствующий значок, а в меню кнопки Пуск 
группа программ BERNINA Embroidery Software.  
Если вы обновляете прежнюю версию, процесс 
слияния может занять некоторое время, – до 15 
минут – и может появиться экран системы DOS. 

Любые изменения, которые вы произвели в старой 
библиотеке BERNINA Quilter, будут преобразованы 
для последней версии. При инсталляции будут 
также сохранены все пользовательские образцы 
или проекты. Подробнее см. в разд. Слияние 
версий программного обеспечении. 
 
 

 
Модификация установленного ПО 
 
Если вы хотите обновите уже установленную 
программу BERNINA® Embroidery Software или если 
вы хотите удалить установленную программу – вы 
должны следовать одной и той же процедуре.   
При последующем запуске установочной 
программы, она автоматически проверит, имеется 
ли уже установленная программа BERNINA® 
Embroidery Software на вашем компьютере и 
предложит выбрать желаемый вариант: обновить, 
исправить или заменить старую программу. Это 
предотвращает возможность одновременной 
установки на вашем компьютере нескольких версий 
программы BERNINA® Embroidery Software. 
 
Модификация установленной программы 
 
1 Закройте все приложения Windows, но саму 
систему Windows не отключайте. 
 
2 Вставьте установочный DVD-ROM диск 
программы BERNINA® Embroidery Software. 
Если программа BERNINA® Embroidery Software уже 
установлена на вашем компьютере, отобразится 
следующее приветственное сообщение: 
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Если программа BERNINA® Embroidery Software уже 
установлена на вашем компьютере, отобразится 
следующее приветственное сообщение: 
 
 

 
 
3 Выберите требуемое действие—Modify, 
Repair, Remove (: обновить, исправить или удалить 
старую программу)—и нажмите Next (Продолжить). 
• Modify (обновить): будут изменены некоторые 

из установленных компонент  
• Repair (исправить): будут заменены некоторые 

из установленных компонент на такие-же 
• Remove (удалить): программа будет удалена. 
 
Если вы выберите обновление установленной 
программы, появится экран выбора компонент 
(Select Components). 
 

 

 
4 Выберите функции и языки, которые надо 
добавить. Отмените выбор для тех тех компонент, 
которые надо удалить. 
 
5 Нажмите Next (продолжить). 
Появится экран Ready to Install (готовность к 
установке). 
 
6 Нажмите Install (установить). 
После успешного завершения установки программы 
и других дополнительных файлов Windows, которые 
требовали обновления, появится экран Maintenance 
Complete (работа завершена). 
Внимание: Если выбран вариант Repair 
(исправить), имевшиеся ранее компоненты будут 
переустановлены. 
 
7 Нажмите Finish. 
 
 
 
Обновление версии 
 
BERNINA Embroidery Software контролируется 
защитным устройством – аппаратным ключом 
("донглем"), подключаемым к компьютеру, а также 
защитными кодами доступа, вводимыми в 
программное обеспечение. Номер аппаратного 
ключа „Dongle Number“ является наиболее важным 
номером. Каждому аппаратному ключу присвоен 
уникальный номер, указываемый на ярлыке, 
прикрепленному к аппаратному ключу.  
Каждый аппаратный ключ имеет уникальный 
серийный номер „Serial Number“ и сохраняемый 
внутри идентификационный код „Identity Code“, так 
что ваша система может быть однозначно 
идентифицирована. Идентификационный код может 
быть получен через программу BERNINA Embroidery 
Software. Могут быть добавлены новые опции или 
обновлены программные продукты путем изменения 
опций аппаратного ключа.  
 
Идентификация вашего аппаратного 
ключа 
 
При ссылке на вашу систему при переписке или 
телефонном разговоре вам нужно указывать номер 
вашего аппаратного ключа (Dongle Number). Вам 
может потребоваться также ссылка на серийный 
номер и идентификационный код. Эту информацию 
можно найти как в бланке заказа кода доступа 
(Access Code Order Form), так и диалоговом окне 
Security Device. 
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Как идентифицировать ваш 
аппаратный ключ 
 
Найдите на ярлыке, приклеенном к аппаратному 
ключу (dongle), номер вашего аппаратного ключа 
(dongle number). Это 7-значный номер, 
начинающийся с буквы ‘A’. 

 

 
 
• �Проверьте серийный номер „Serial Number“ и 

идентификационный код „Identity Code“, одним 
из следующих способов: 

• Выберите Help > Access Codes Order Form. 
 
Откроется форма заказа кода доступа Access Code 
Order Form. Серийный номер „Serial Number“ и 
идентификационный код „Identity Code“, вашего 
аппартного ключа отображаются в верхней части 
формы.  
 
 
 

 
◄ Выберите Settings > Security, чтобы открыть 

диалоговое окно Security Device.  
Откроется диалоговое окно Set Security Device 
Options (Опции настройки аппаратного 
ключа).  

 

 
Серийный номер и Идентификационный код 
вашего аппаратного ключа отображаются в 
верхней части диалогового окна. 

 
 
Примечание: В поле “серийный номер” (Serial 
Number) отображается внутренний серийный номер 
аппаратного ключа (перед дефисом). Это 
индивидуальный номер, который считывается с 
ключом, подсоединенного к вашему компьютеру. Он 
отличается от номера, указанного на ярлыке ключа 
и на самом устройстве. Мы рекомендуем записать 
этот номер на всякий случай. 
 
 

1-я сторона: 
Указывается уровень 
продукта или  
обновленный 
уровень продукта 
 
 
 
 
 
 
2-я сторона: Номер 
аппаратного ключа –  
ссылайтесь на этот 
номер при 
обращении к вашему 
дилеру 
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Заказ кодов доступа у дилера 
 
Если по каким-либо причинам вам не удается 
обновить ПО через интернет, можно заказать коды 
доступа у вашего дилера.  Самый простой способ 
сделать это – форма заказа кодов доступа (Access 
Code Order Form). Ее надо заполнить, распечатать 
и отправить вашему дилеру по почте (или сразу по 
электронной почте). В последнем случае вам 
необходимо предварительно узнать электронный 
адрес вашего дилера.  
 
Как заказать коды доступа у дилера: 

1 Выберите Help > Access Codes Order Form.  
Появится бланк заказа кода доступа (Access 
Code Order Form).   

 

 

 
2 Введите ваши данные. 
Примечание: Проверьте, что номер устройства 
содержит семь знаков.  Если их только 6, добавьте 0 
перед номером. 
 
3 Укажите тип запрашиваемого кода доступа. 
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4 Информацию о дилере вводить не надо – эти поля 
дилер заполнит сам. 
 
5 Укажите, отправляете ли вы форму по  
электронной почте или ее надо распечатать.   
В последнем случае вы должны будете отправить 
распечатанную форму обычной почтой. Дилер 
пришлет ответное письмо с распечатанными кодами 
доступа. Вы должны будете ввести их в ваш 
компьютер вручную Подробности описаны в 
разделе “Ввод кодов доступа”.  
При отправке формы по электронной почте, 
откроется диалог отправки Email. 
6 Введите электронный адрес дилера. Вы должны 
предварительно узнать его у вашего дилера. 
7 Наберите текст письма дилеру и нажмите кнопку 
“Отправить” (Send). 
Коды доступа будут посланы вам в приложении к 
ответному письму. Сохраните файл приложения в 
удобном месте, например – на рабочем столе 
вашего РС. Теперь вы можете импортировать коды 
доступа. Подробности описаны в разделе “Импорт 
кодов доступа”  
Подсказка: Когда вы открываете форму заказа 
кодов доступа ( Access Code Order Form), 
программа  BERNINA® Embroidery Software создает 
специальную директорию для кодов доступа: 
..\Program Files\BERNINA\Embroidery 
Software 6\ACCESSCODES. В целях безопасности, 
сохраните файл с кодами доступа в этой папке. 
 
 
Ввод кодов доступа 
Если по какой-либо причине вам неудается 
обновить вашу программу в режиме online, вы 
можете ввести коды доступа вручную для 
обновления программы до новой версии и новых 
функций. Ваш дилер предоставит вам эти коды. См. 
раздел “Заказ кодов доступа у дилера”. 
 
Подсказка: Коды доступа можно ввести путем 
импорта из текстового файла.  Это экономит время 
и позволяет избежать опечаток Подробности 
описаны в разделе “Импорт кодов доступа”  

 
Как ввести коды доступа 
1  Выберите Settings > Security. 
 Откроется диалоговое окно Set Security Device 

Options (Опции настройки аппаратного ключа). 
 

 
 
2  Проверьте, соответствует ли Серийный номер и 

Идентификационный код указанным в 
текстовом файле сообщении электронной почты, 
содержащем новые коды доступа. Оба кода 
должны быть идентичными. 
 

3  Введите коды доступа в поля, используя 
клавишу Tab или Enter для перехода от одного 
поля к другому.  

 

 
 
 
 
Подсказка: при вводе кодов доступа, программа, 
BERNINA® Embroidery Software автоматически 
добавляет пробел после каждых четырех символов. 
Вводить пробелы вручную не надо. 
 
4 Нажмите OK. 
Появится сообщение об успешном вводе кодов.   
 
5 Перезапустите программу BERNINA® Embroidery 
Software. 
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Импорт кодов доступа 
 
Вы можете импортировать защитные коды доступа 
из текстового файла. Это экономит время. 
Текстовые файлы обычно пересылаются 
электронной почтой. 
Ваш дилер пришлет вам файл электронной почтой. 
См. также раздел Заказ кодов доступа у дилера. 
 
 
Как импортировать коды доступа 
 
1  Когда вы получите коды доступа (как 
приложение к электронному письму), сохраните 
файл в безопасном месте на вашем жестком диске 
– например, на рабочем столе PC. См. также раздел 
Заказ кодов доступа у дилера. 
 
 

2 В BERNINA Embroidery Software выберите 
Settings > Security, чтобы открыть диалоговое 
окно Set Security Device (Настройка 
аппаратного ключа). 

 
 
 
 

 
 

 
3    Проверьте, соответствует ли Серийный номер и 

Идентификационный код указанным в 
текстовом файле сообщении электронной почты, 
содержащем новые коды доступа. Оба кода 
должны быть идентичными. 

4  Нажмите кнопку Import Codes. 
 Откроется диалоговое окно Open (Открыть. 

 

 
5 Найдите папку, где Вы сохраняли файл с 
кодами доступа – например – на рабочем 
столе вашего РС. 
 

 
 

5  Выберите текстовый файл, содержащий новые 
коды доступа, и нажмите кнопку Open. 

  
 
      Коды будут автоматически обновлены. 

 
6  Перезапустите BERNINA Embroidery Software. 
 
 
 
 
 

 

Кнопка 
импорта 
кодов 
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ЧАСТЬ I 

 

ОСНОВЫ 
------------------------------------------- 
 
 
 
Проекты, создаваемые вышивальным ПО BERNINA Embroidery Software составляются из 
"вышивальных объектов". Они называются "объектами", так как они являются дискретными 
блоками, которые можно обрабатывать независимо друг от друга. Каждый объект обладает 
определенными характеристиками, или "свойствами", такими как цвет, размеры, 
положение и т.п. Наиболее важным свойством объекта вышивки является тип стежка. 
 
 
Введение в оцифровывание проектов вышивки 
 
Программное обеспечение BERNINA Embroidery Software предоставляет возможность 
быстрым и гибким образом создавать и редактировать вышивальные проекты. В этом 
разделе дается обзор процесса оцифровывания мотивов вышивки, используемого в ПО 
BERNINA. Подробнее см. в главе Введение в оцифровывание проектов вышивки в 
экранном руководстве  
 
 
Основные процедуры 
 
В этом разделе описывается, как запустить приложения BERNINA Embroidery Software и 
соответствующие команды и инструменты. Они требуются для открытия, создания и 
сохранения файлов с проектами. Объясняется, как активировать пяльцы и линии сетки и 
получать доступ к свойствам объектов. Подробнее см. в главе Основные процедуры. 
 
 
Просмотр проектов 
 
В этом разделе разъясняются режимы просмотра проекта, предоставляемые BERNINA 
Embroidery Software, а также различные настройки просмотра проекта. Описываются 
функции изменения масштаба и панорамирования, а также просмотра последовательности 
вышивания. Объясняется, как отображать на экране оригиналы проектов и изменять фон. 
Также объясняется, как получать информацию о ваших проектах. Подробнее см. в главе 
Просмотр проектов. 
 
 
Выбор объектов 
 
В этом разделе описывается, как выбирать объекты, используя инструменты выбора и 
клавиатуру. Также объясняется, как выбирать цветные блоки или индивидуальные 
объекты, используя функцию Color Film. Подробнее см. в главе Выбор объектов. 
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Закрепление проектов в пяльцах 
 
В этом разделе описывается, как выбирать и отображать пяльцы в ПО BERNINA 
Embroidery Software. Объясняется, как создавать и модифицировать пользовательские 
пяльцы. Также даются указания, как закреплять в пяльцах крупные проекты. Подробнее см. 
в разделе Закрепление проектов в пяльцах руководства. 
 
 
Настройка аппаратных и программных средств 
 
В этом разделе описывается, как настраивать вышивальные машины и сканеры и как 
калибровать монитор. Кроме того, объясняется, как изменять интервал сетки и опции 
пялец. Также рассматриваются настройки общих опций, таких как автосохранение, 
отображение положения указателя мыши и т.п.  
Подробнее см. в разделе Настройка аппаратных и программных средств 
руководства. 
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ГЛАВА 3 

 

 
ОСНОВНЫЕ ПРОЦЕДУРЫ 

------------------------------------------- 
 

 
 
Для работы с программным обеспечением 

BERNINA Embroidery Software вам требуется 

знать основные процедуры, такие как запуск 

программ, открытие и создание проектов и 

сохранение. После запуска BERNINA Embroidery 

Software вы должны пользоваться командами 

или пиктограммами и диалоговыми окнами, 

чтобы выполнять соответствующие задачи. 

Команды выбираются таким же образом, как и в других приложениях Windows, – 

из меню или панелей инструментов. 

В приложениях BERNINA Embroidery Software открываются файлы в "родном" 

формате .ART, а также файлы других вышивальных форматов, хранящиеся на 

жестком диске компьютера, дискете или компакт-диске. 

Программный пакет BERNINA Embroidery Software предлагает вам на выбор 

широкий диапазон стандартных пялец. Используйте линии сетки, чтобы точно 

совместить или установить требуемые размеры объекта вышивки. Наиболее 

важным диалоговым окном в BERNINA Embroidery Software является диалоговое 

окно Object Properties (Свойства объекта). Это и диалоговое окно Effects 

(Эффекты) являются "немодальными" диалоговыми окнами, это означает, что в 

окне Design они остаются открытыми до тех пор, пока они нужны. 
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Интерфейс программы BERNINA 
Embroidery Software 
Программа BERNINA Embroidery Software 
интегрируется с программой CorelDRAW® 
Essentials 4 , образуя единое приложение. 
Оно позволяет пользователям создавать 
не только образцы для вышивки, но и 
настоящие мультимедийные объекты 
дизайна. Приложение имеет общее 
рабочее пространство (‘Design Window’), 
но работать в этом пространстве можно в 
двух разных режимах: Art Canvas (для 
дизайнерской работы) и Embroidery 
Canvas (для вышивок). Третий режип, 
Hoop Layout, предназначен для работы с 
большими “много-пяльцевыми” 
образцамиe. См. также раздел Режимы 
просмотра.  

 
 
Запуск вышивального 
программного обеспечения 
BERNINA Embroidery Software  
Для запуска BERNINA 

Embroidery Software щелкните дважды 
мышью по этому ярлыку. 

 
Программа BERNINA Embroidery Software 
может быть открыта через ярлык на 
рабочем столе или меню кнопки Пуск.  
По умолчанию включается режим 
Embroidery Canvas. В этом режиме можно 
создавать и редактировать объекты 
вышивания, используя инструментарий 
оцифровывания вышивок 

 
Как запустить BERNINA Embroidery Software  
 
◄ Щелкните дважды мышью по ярлыку BERNINA 

Embroidery Software на рабочем столе Windows 
или  выберите в меню кнопки Пуск > Все 
программы > BERNINA Embroidery Software > 
BERNINA Embroidery Software. 

 
BERNINA Embroidery Software открывается в режиме 
Embroidery Canvas с новым, пустым проектом 
(Design1). На показанном внизу экране отображены 
в развернутом виде все панели инструментов 
приложения BERNINA DesignerPlus. В зависимости 
от уровня вашего программного продукта вы 
получите доступ к некоторым или всем этим опциям.
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Title bar – 
Menu bar – 

General toolbar –  
Stitch and Color Bar – 

Edit Toolbar –  
 

Строка заголовка  
Строка меню 
Общая панель инструментов 
Панель Стежок и Цвет 
Панель инструментов правки 
 

Edit Toolbar – 
Digitize Toolbar - 
Arrange Toolbar- 

Craft Stitch Toolbar– 
View  Mode Toolbar- 

Status bar - 

Панель инструментов правки 
Панель оцифровки  
Панель размещения 
Панель рукодельных стежков 
Панель режима просмотра   
Строка состояния 

 
Примечание: Панели являются 
плавающими, их можно размещать 
справа, слева, сверху или снизу и 
"перетаскивать" в любое место окна 
проекта. Панель Стежок и Цвет и может 
быть расположена вертикально, но в этом 
случае списки оконтуривающих и 
заполняющих стежков не открываются. 
Поэтому рекомендуется размещать эту 
панель только горизонтально. См. также 
Краткий справочник.  
. 

◄ Измените окно проекта по своему 
желанию, при этом можно отобразить или 
скрыть сетку, изменить размеры сетки, 
отобразить или скрыть панели 
инструментов. Подробнее см. в разделе 
Отображение сетки. 

 
Портативные закладки 
 
Программа BERNINA Embroidery Software 
использует портативные закладки (‘dockers’) 
для вызова основных функций. Режим 
Embroidery Canvas имеет следующие 
закладки: Color Film (цветной фильм), Carving 
Stamps (резьба и тиснение) , Morphing Effects 
(эффекты плавного преобразования) и 
Overview Window (обзорный диалог). Все 
закладки группируются в правой стороне 
рабочего экрана Design Window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Окно проекта 
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Закладки группируются для увеличения 
размера рабочей области экрана.  При этом 
они разворачиваются вертикально для 
компактности. Размер закладок можно 
зафиксировать или минимизировать. При 
установке курсора мыши на закладку, 
всплывает минимизированный по размерам 
«docker»,позволяющий обращаться к 
соответствующей функции. Если закладка 
не используется, она автоматически 
минимизируется. 
Панель закладок можно “перетащить” с 
помощью мышки в рабочую область ‘Design 
Window’ или двойным щелчком мыши при 
закреплении их на месте. 
 
Строка текущего состояния (Status bar) 
 
Строка текущего состояния в нижней части 
рабочей области экрана Embroidery Canvas 
отображает состояние текущего положения 

курсора и инструкции по использованию 
выбранных инструментов.  
 
Отображаемая информация включает: 

• Сообщения - подсказки: они помогают 
работать с выбранными функциями 

• Ширину и высоту образца 
• Координаты текущего положения 

иглы (X/Y), длину (L) и угол (A) 
текущего стежка. См. также раздел 
Измерение расстояний на экране  

• Счетчик стежков: общее количество 
стежков в образце 

• Степень увеличения / уменьшения 
(Zoom factor) 

• Тип файла: указывает тип файла ART 
образца. Собственные образцы в 
программе BERNINA Embroidery 
Software классифицируются по 
четырем типам, в зависимости от 
того, как был создан образец. См. 
раздел  Форматы образцов 
вышивки в руководстве 
пользователя. 

 
Работа с файлами проектов 
 
По умолчанию BERNINA Embroidery Software 
сохраняет проекты в собственном ["родном"] 
формате файла .ART. Этот формат содержит 
всю информацию, требуемую как для 
вышивания проекта, так и для последующих 
изменений. В приложениях BERNINA 
Embroidery Software открываются файлы в 
"родном" формате .ART, а также файлы других 
вышивальных форматов, хранящиеся на 
жестком диске компьютера, дискете или 
компакт-диске. Вы можете сохранять проекты в 
формате ART, как и файлы других форматов. 
Подробнее см. в разделе Считывание и 
запись файлов проектов в руководстве 
пользователя. 
. 
Внимание: Вы не сможете открыть файлы 
ART, созданные более поздней версией 
программного обеспечения, если у вас 
запущена предыдущая версия. Если вы 
попытаетесь это сделать, появится указание о 
необходимости обновить систему до текущей 
версии. 

 
  
Открытие проектов 
 

Нажмите кнопку Open (панель 
General), чтобы открыть 
существующий проект. 
 

BERNINA Embroidery Software открывает ряд 
вышивальных файлов не только в "родном" 
формате ART. "Родные" проекты формата ART 
классифицированы на четыре группы в 
зависимости от способа создания файла. См. 
также Запуск вышивального программного 
обеспечения BERNINA Embroidery Software.  
 
Примечание: По умолчанию проекты 
автоматически группируются при открытии или 
вставке в другой проект. Подробнее см. в 
разделе Настройка других общих опций в 
руководстве пользователя. 
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Как открыть проект 
1 Нажмите кнопку Open (Открыть). 
Откроется диалоговое окно Open. 

2 Выберите папку из списка Look In. 
 

Примечание: Вы можете считывать 
проекты, сохраняемые на дискете, 
компакт-диске или на жестком диске 
компьютера. 

3 Если проект не в формате ART, то 
выберите тип файла из списка Files of 
Type (Тип файлов). 

4 Выберите проект или проекты.  
◄ Для выбора нескольких идущих 

подряд проектов удерживайте 
нажатой клавишу Shift.  

◄ Для выбора нескольких файлов 
удерживайте нажатой клавишу Ctrl. 

5  Проставьте "галочку" в окошке Preview, 
чтобы просмотреть проект (для 
поддерживаемых форматов) вместе с 
данными о проекте. В эти данные входят 
количество стежков (S:) и цветов (C:), 
высота (H:) и ширина (W:) проекта и 
номер версии ПО (V:). 

6 Нажмите кнопку Open (Открыть). 
 

Примечание: Вы можете также 
считывать проекты из памяти вашей 
вышивальной машине или с карты памяти 
BERNINA. Если у вас имеется прибор 
Magic Box, вы можете записать проект 
также и на другие карты памяти. 
Подробнее см. в разделе Считывание и 
запись файлов проектов в руководстве 
пользователя. 

 
Запуск новых проектов 

 
Нажмите кнопку New (панель 
General) для создания нового 
проекта с шаблоном NORMAL  

 
При запуске BERNINA Embroidery Software 
автоматически создается новый файл - 
Design1, - готовый для начала 
оцифровывания. По умолчанию Design1 
создается на основе шаблона NORMAL. 
Шаблоны содержат предварительно 
установленные стили, настройки по умолчанию 
или объекты, что ускоряет и облегчает 
оцифровывание. Если вы создаете файл, 
основанный на одном из шаблонов, то 
параметры шаблона копируются в новый 
проект. Вы можете также выбрать шаблон 
пользователя в качестве основы нового 
проекта. См. также Свойства объекта и 
шаблоны  в Руководстве пользователя.  
 
Как запустить новый проект  
 
◄ Нажмите кнопку New (Создать). 

В окне проекта откроется новый пустой 
проект, основанный на шаблоне NORMAL.  

◄ Для использования шаблона пользователя 
выберите File > New. 
Откроется диалоговое окно New. 

    Если имеется еще другие шаблоны,  
    диалоговое окно New  появиться. 

 
    

Выберите шаблон из списка и щелкните по OK. 
См. также Свойства объекта и шаблоны  в 
Руководстве пользователя.  
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Сохранение проектов 
 
Нажмите кнопку Save (панель 
General), чтобы сохранить текущий 
проект. 

 
Проекты BERNINA Embroidery Software могут 
быть сохранены в чистом ART-формате, а 
также в ряде других "неродных" форматов. 
При сохранении проекта сохраняется имя 
файла, его расположение и формат и 
происходит его обновление в соответствии с 
выполненными изменениями.  Если вы 
сохраняете существующий проект под 
новым именем, в другом месте или в другом 
формате, вы создаете копию оригинального 
проекта. См. также раздел Считывание и 
запись файлов проектов в Руководстве 
пользователя.  
 
Совет: Сохраняйте свои проекты во время 
работы, как можно чаще. Не ждите полного 
завершения работы. Чтобы сохранить 
изменения в существующем файле, но 
оставить без изменений оригинал, 
воспользуйтесь командой Save As. Каждый 
раз, когда вы сохраняете проект кнопкой 
Save на общей панели инструментов, 
происходит обновление файла.  
 
Как сохранить проект 
 
1 Нажмите кнопку Save (Сохранить). 

Если вы сохраняете проект в первый раз, 
откроется диалоговое окно Save As 
(Сохранить как …). 

 

 
2 Из списка Save In выберите 

папку, в которой вы хотите сохранить 
проект. 

3 Введите имя проекта в поле File name. 
 

 

4 Выберите формат файла из списка Save as 
type.  См. также Поддерживаемые 
форматы вышивальных файлов в 
руководстве пользователя.  

5  Нажмите кнопку Save (Сохранить). 
 

Примечание: Вы можете также записывать 
проекты в память вашей вышивальной 
машине или на карту памяти BERNINA. 
Если у вас имеется прибор Magic Box, вы 
можете записать проект также и на другие 
карты памяти. Подробнее см. в разделе 
Считывание и запись файлов проектов 
в Руководстве пользователя.  

 
 
Готовые образцы вышивок  
 
Программа BERNINA Embroidery Software 
содержит сотни готовых для вышивания 
образцов, включая множество новых 
привлекательных орнаментов, изображений и 
фоновых рисунков. Файлы образцов (ART files) 
и изображений (BMP, JPG, и WMF файлы) 
можно найти в папке My Designs - Embroidery 
Software 6. См. также разделы Оцифровка с 
помощью фоновых рисунков  и Просмотр 
информации по образцам  в Руководстве 
пользователя.  
 
 
 
 
 
 
 
 
 

Функция BERNINA Portfolio отображает 
пиктограммы образцов вышивок с короткой 
информацией. Можно отфильтровать 
содержимое экрана так, чтобы отображались 
только файлы вышивок определенного типа. 
См. раздел Поиск образцов в папках  в 
Руководстве пользователя 

Папка,содержащая 
проект 

Имя проекта 

Список  
форматов 
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Программа CorelDRAW® Essentials 4 тоже 
содержит набор графических заготовок, 
которые можно использовать как фоновые 
рисунки или непосредственно 
конвертировать в образцы вышивки. См. 
также раздел Поиск графических 
заготовок  в Руководстве пользователя. 
 
ПРЕДУПРЕЖДЕНИЕ: Все имеющиеся в 
программах заготовки и образцы вышивок 
предназначены только для личного 
пользования. Их нельзя  ни в какой форме 
продавать или использовать в коммерческих 
целях. Изменение формата – например, 
графической заготовки в образец вышивки 
или наоборот – не отменяет защиты 
авторского права. 

 
Пяльцы и сетки 
 
Перед вышиванием на машине материал 
должен быть растянут в пяльцах. 
Программный пакет BERNINA Embroidery 
Software предлагает вам на выбор широкий 
диапазон стандартных пялец. Используйте 
линии сетки, чтобы точно совместить или 
установить требуемые размеры объекта 
вышивки. 
 
Отображение пялец 

Для отображения пялец нажмите 
кнопку Show Hoop (панель 
General). Щелчок правой кнопкой 
мыши позволяет изменить  

          настройки. 
 
Каждый раз, когда вы создаете новый проект, 
по умолчанию в окне проекта появляются одни 
из пялец из тех, которые вы можете установить 
на вышивальной машине. Когда вы 
позиционируете объекты, положение пялец 
подгоняется автоматически, так что объекты 
всегда находятся в центре пялец. См. также 
раздел Закрепление проектов в пяльцах в 
руководстве пользователя.  
 
Как показать пяльцы на экране 
 
◄ Нажмите кнопку Show Hoop (Показать 

пяльцы), чтобы отобразить пяльцы. 
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◄ Нажмите еще раз кнопку Show Hoop, 
чтобы скрыть пяльцы. 

 
Отображение сетки 
 

Нажимайте кнопку Show Grid 
(панель General) для 
отображения на экране или 
скрытия сетки. Щелчок правой  
кнопкой мыши позволяет 
изменить настройки сетки. 

 
Используйте линии сетки, чтобы точно 
совместить или установить требуемые 
размеры объекта вышивки. Вы можете 
показывать или скрывать сетку. 
 
Совет: Вы можете изменить интервал сетки, 
выбрать базисную точку и включить или 
выключить функцию Snap to Grid 
(Выровнять по сетке) в диалоговом окне 
Options. Подробнее см. в разделе 
Настройка опций сетки в Руководстве 
пользователя.  
 
Как показать сетку на экране 
◄ Нажмите кнопку Show Grid (Показать 

сетку), чтобы отобразить сетку 
  
  
  
  
 . 

◄ Нажмите кнопку Show Grid еще раз, 
чтобы скрыть сетку. 

 
Измерение расстояний на экране 
 
Используйте команду Measure (меню View), 
чтобы измерить расстояние на экране. 
 
Для измерения расстояния между двумя 
точками на экране используйте команду 
Measure (Измерить). Эта команда отображает 
координаты, расстояние и угол линии от 
указателя мыши до точки, соответствующей 
центру пялец в пустом проекте. Результаты 
измерения можно видеть в строке состояния 
или в подсказке. Подробнее см. в разделе 
Интерпретация положения указателя 
мыши в Руководстве пользователя.  
 
Совет: Для получения более точных 
результатов перед измерением увеличьте 
изображение на экране. Измеряется всегда 
действительный размер независимо от 
масштаба изображения. 
 
Как измерить расстояние на экране 
1 Выберите View > Measure или нажмите 
M. 
2 Щелкните мышью по начальной точке. 
3 Удерживая кнопку мыши нажатой, 
переместите указатель мыши в конечную 
точку. 

В строке состояния появится следующая 
информация: 
◄ Координаты положения конечной точки 

(X=, Y=). 
◄ Длина измеренной линии (L=). 
◄ Угол наклона линии по отношении к 

горизонтали (A=). 
Результаты измерений показываются в 
миллиметрах или дюймах, в зависимости ль 
выбранной системы измерения в Панели 
управления MS Windows®. Подробнее см. в 
документации по операционной системе MS 
Windows®. 
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Результаты изменения появляются как 
подсказка или в строке состояния 
 

Совет: Если активировано измерение 
длины и угла, результаты появляются 
также и в подсказке. Подробнее см. в 
разделе Настройка других общих 
опций в руководстве пользователя.  

4 Нажмите Esc для завершения. 
 
Использование команд и 
инструментов 
 
После запуска BERNINA Embroidery Software 
вы должны пользоваться командами или 
ярлыками и диалоговыми окнами, чтобы 
выполнять соответствующие задачи. 
Команды выбираются таким же образом, как 
и в других приложениях Windows®, – из меню 
или панелей инструментов. Для наиболее 
часто используемых команд имеются также 
клавишные комбинации быстрого вызова – 
клавиатурные команды. Подробнее см. в 
разделе Клавиатурные команды.  
 
Выбор команд с панелей 
инструментов 
 
Панели инструментов обеспечивают 
быстрый и простой доступ к командам 
BERNINA. Щелкните на кнопке инструмента, 
чтобы активировать команду, или, там, где 
это применимо, щелкните правой кнопкой 
мыши, чтобы изменить ее свойства. 

 
Как выбирать команды с панелей 
инструментов 
 
◄ Задержите указатель мыши на значке 

инструмента, чтобы увидеть его название 
во всплывающей подсказке.  

◄ Щелкните по значку, чтобы активировать 
команду. 

◄ Правой кнопкой, чтобы отрегулировать 
настройки или активировать вторичную 
команду. 
◄ Если для значка предусмотрены 

команды как от левой, так и от правой 
кнопки мыши, то ее название разделено 
косой чертой (/). Например, значок Scale 
by 20% Down/Up позволяет уменьшить 
размер объекта на 20 %, если щелкнуть 
левой кнопкой мыши, или увеличить 
размер на 20 %, если щелкнуть правой 
кнопкой. 

◄ Для многих инструментов щелчок правой 
кнопкой мыши дает возможность 
настроить текущую команду. Например, 
щелчок левой кнопкой по 
Lettering/Values (Текст/Значения) 
выбирает Lettering в качестве метода 
ввода, а щелчок правой дает доступ к 
диалоговому окну Object Properties 
(Свойства объекта).  

 
Примечание: Свойства объекта могут быть 
изменены с выбором или без выделения 
объекта. В первом случае изменения 
относятся только к выбранному объекту. Во 
втором случае изменяются текущие настройки. 
 
Отмена и повторение отмененных 
команд 

 
Используйте кнопку Undo (панель 
General) для отмены команды. 
 
Используйте кнопку Redo (панель 
General) для повторения команды, 
которая была отменена. 

 
Вы можете отменить действие большинства 
команд. Если вы передумали, то можно снова 
повторить выполнение отмененной команды. 
BERNINA Embroidery Software помнит 
несколько последних команд, которые вы 
назначали. 
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Как отменить команду и снова 
восстановить ее действие 
◄ Для отмены команды щелкните по значку 

Undo. Если BERNINA больше не помнит 
выполненных команд, кнопка Undo 
становится блеклой.  

◄ Щелкните по значку Redo, чтобы 
повторить выполнение отмеченной 
команды. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Перемещение и установка панелей 
инструментов 
 
Панели инструментов обеспечивают 
быстрый и простой доступ к командам 
BERNINA Embroidery Software. Панели 
инструментов являются "плавающими". Это 
означает, что их можно перемещать по 
всему окну проекта. 
 
Как перемещать панель инструментов 
◄ Для перемещения панели инструментов 

в более удобное место нужно 
перетащить ее мышью: 
◄ Панели инструментов можно 

перемещать влево, вправо, вверх и 
вниз. 

 
◄ Они могут "плавать" в любом месте 

окна. 
 

◄ Для помещения панели в нормальное 
положение дважды щелкните мышью 
по заголовку. 

Доступ к свойствам объекта 
 

Используйте кнопку Object Properties 
(Свойства объекта), чтобы 
настроить текущие  

                свойства или свойства  
                выделенных объектов. 
 
Образцы, представленные в программе 
BERNINA Embroidery Software, состоят из 
‘объектов вышивания”. Название “объекты” 
выбрано по тому, что это дискретные 
сущности, которыми можно оперировать, 
независимо один от другого. Каждый объект 
имеет свои характеристики или свойства, 
такие, как цвет, размер, положение и т.п. 
Самый главный диалог в программе BERNINA 
Embroidery Software  - это диалог свойств 
объекта (Object Properties). См. также раздел 
Применение свойств объекта и 
управление ими в руководстве пользователя. 
 
Как настраивать свойства объекта  
• Откройте диалоговое окно Object 

Properties (Свойства объекта) одним из 
следующих способов: 
◄ Щелкните по значку Object Properties 
◄ Выберите Settings  > Object Properties . 
◄ Двойной щелчок или щелчок правой 

кнопкой по любому объекту в окне 
проекта. 
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◄ Выберите закладку, чтобы открыть то 
свойство объекта, которое вы хотите 
настроить.  

◄ Используйте поля, выпадающие 
списки, кнопки переключения и 
ползунки, чтобы ввести с клавиатуры 
или изменить настройки. 

◄ Щелкните по кнопке Effects, чтобы 
получить доступ к отдельному набору 
специфичных настроек свойств 
объекта, таких как Underlay 
(Стабилизация ткани), Textured Edge 
(Текстурированный край), Gradient Fill 

(Заполнение с плавным тоновым 
переходом) и др. 
 

Примечание: В этом диалоговом окне, в 
свою очередь, имеется кнопка Properties, 
которой открывается диалоговое окно 
Object Properties. Вы можете выбрать 
автоматическое закрытия окна Object 
Properties при открытии диалогового окна 
Effects и наоборот. Подробнее см. в 
разделе Настройка других общих опций  
в руководстве пользователя. 
 

Совет: В диалоговое окно Object 
Properties встроены графические элементы 
для визуального слежения за изменением 
настроек.  Они появляются, когда вы 
наводите указатель мыши на элемент 
управления. Например, если указатель 
мыши наведен на опцию Stitch Spacing 
(Шаг стежка), сбоку появляется 
иллюстрация. 
• Для применения настроек нужно 

щелкнуть по кнопке Apply в нижней 
части диалогового окна или нажать 
клавишу Enter. 
◄ Если вы выделили один или 

несколько объектов, изменения будут 
применены ко всем выделенным 
объектам. 

◄ Если не выделен ни один объект, 
изменения будут отнесены к текущим 
настройкам – они будут использованы 
при создании новых объектов. 

◄ Если вы изменили настройки на 
нескольких вкладках диалогового 
окна, все изменения, которые могут 
быть применены, будут применены. 
 

• Щелкните по кнопке Save to Template 
(Сохранить в шаблоне), чтобы 
сохранить настройки в текущем 
шаблоне. Они будут приниматься по 
умолчанию при создании новых файлов, 
основанных на этом шаблоне.  
Подробнее см. в разделе Управление 
шаблонами проекта в руководстве 
пользователя 
 

• Щелкните по кнопке Discard 
(Отменить) или нажмите клавишу Esc, 
чтобы отказаться от изменений.  
 

• Щелкните по кнопке Close (Закрыть), 
чтобы закрыть диалоговое окно и 
отказаться от изменений. 

 
 



Глава 4: Просмотр проектов 

BERNINA Вышивальное программное обеспечение – Краткое справочное руководство 30

ГЛАВА 4 
 

ПРОСМОТР ПРОЕКТОВ 
------------------------------------------- 
 

BERNINA Embroidery Software предоставляет несколько возможностей 
просматривать проекты вышивки, чтобы облегчить работу с ними. Zoom in on an 
area to see more detail or view the design at actual size. Show or hide various 
design elements with the available display settings. Preview an existing design in 
different colors on different fabrics. 
 

 
 
При работе с проектами вышивки вам необходимо разобраться с 
последовательностью вышивания. Вы можете проверить последовательность 
вышивания проекта путем ‘обхода’ по стежкам. Вы можете также проверить 
последовательность медленным перерисовыванием проекта на экране. 
BERNINA Embroidery Software также предоставляет информацию о проектах 
разнообразными способами и в разных форматах. Еще перед открытием 
BERNINA Embroidery Software или своего проекта вы можете проверить 
некоторую информацию о файлах формата ART непосредственно из MS 
Windows® Explorer. Вы можете просмотреть детали вышивания проекта в 
диалоговом окне Design Properties (Свойства проекта). Важную информацию о 
проекте дает также функция Print Preview (Предварительный просмотр), 
включая просмотр проекта в целом, размеры проекта, последовательность 
цветов и специальные указания. 
В этом разделе разъясняются режимы просмотра проекта, предоставляемые 
BERNINA Embroidery Software, а также различные настройки просмотра 
проекта. Описываются функции изменения масштаба и панорамирования, а 
также просмотра последовательности вышивания. Объясняется, как 
отображать на экране оригиналы проектов и изменять фон. Также объясняется, 
как получать информацию о ваших проектах. 
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Режимы просмотра 
 
При оцифровке, для разных целях 
доступны разные режимы просмотра. В 
зависимости от версии вашей программы, 
BERNINA Embroidery Software 
предоставляет разное количество 
режимов просмотра, которые можно 
активизировать с помощью функций 
панели режимов просмотра (View Mode). 
 

 
Приложение имеет одно рабочее 
пространство ‘Design Window’, но 
работать с ним можно в разных режимах. 
 
Режим дизайна - Art Canvas 

Загружайте, 
редактируйте, 
сохраняйте в качестве 
фона для оцифровки 
вышивок любую графику. 
Это включает весь 
набор, предоставляемый 
программами 
CorelDRAW® Essentials 4. 
Дополнительно, 
предоставляется 
возможность 
конвертировать 
векторные рисунки и 

тексты непосредственно в объекты 
вышивания. 
В режиме Art Canvas, панель инструментов 
View Mode содержит кнопку Show Embroidery 
для включения/выключения дисплея вышивок. 
 
Ниже на рисунке показан вид рабочего 
экрана в режиме Art Canvas,  доступ к 
которому осуществляется через панель 
инструментов View Mode. Этот режим 
работы позволяет создавать и изменять 
векторную графику, используя 
инструментарий CorelDRAW® Essentials 
4,  позволяющий использовать различные 
продвинутые техники для создания 
набросков и рисунков прямо с экрана. 
 

 

Дополнительно к инструментарию 
CorelDRAW® Essentials 4, режим Art 
Canvas предоставляет возможность 
конвертировать векторную графику и 
тексты непосредственно в объекты 
вышивки. Векторная графика и тексты, 
созданные или импортированные в 
режиме Art Canvas можно 
непосредственно конвертировать в 
объекты вышивки. Можно использовать 
режим Art Canvas, чтобы вставлять 
векторную графику других 
производителей, например заготовочные 
рисунки для образцов вышивки. 
Дополнительно можно использовать 
растровые образцы для использования в 
качестве оцифровывающего фона. См. 
раздел Загрузка рисунков в Руководстве 
пользователя.  
 
ВНИМАНИЕ: Полное описание 
инструментария программы CorelDRAW® 
Essentials 4 приводится в электронном 
Руководстве пользователя, которое 
можно найти в разделе меню Windows 
Start > Programs. Можно использовать 
экранную систему помощи с помощью 
меню Help в режиме Graphics. 
 
Режим вышивания - Embroidery 
Canvas 

 
 
 
 
 

Режим позволяет оцифровывать и 
редактировать образцы вышивки. 
Показывает как образцы вышивки, так и 
графические заготовки. Дает 
возможность просматривать образцы 
реалистически в трехмерной графике 3D 
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Ниже на рисунке показан вид рабочего 
экрана в режиме Embroidery Canvas,  
доступ к которому осуществляется через 
панель инструментов View Mode. Этот 
режим работы позволяет создавать и 
изменять объекты вышивки, используя 
инструментарий оцифровки вышивок. См. 
также раздел Интерфейс программы 
BERNINA Embroidery Software. 

 
Используйте этот режим, если собираетесь 
разработать образец вышивки, начиная от 
оцифровывающего фона.  Разные типы 
файлов с изображениями можно загружать 
в программу BERNINA Embroidery Software. 
См. также Оцифровка с помощью 
фоновых рисунков в Руководстве 
пользователя. 
 
Режим Embroidery Canvas позволяет 
увидеть изображение того, каким рисунок 
получится в итоге. С помощью функции 
просмотра образцов (Show Artistic View), а 
также с учетом ткани подложки можно 
увидеть, как будет выглядеть ваша. См. 
также раздел Изменение фона. 

 

Режим Hoop Layout 
 
 
 
 
 

Позволяет просматривать и 
редактировать проекты, не помещающиеся 
в пяльцах. Если ваша вышивка слишком 
велика, или содержит много образцов, 
расположенных на пространстве, разбитом 
для вышивки на многих пяльцах. 
 
 
 
 

Ниже на рисунке показан вид рабочего 
экрана в режиме View Mode,  доступ к 
которому осуществляется через панель 
инструментов View Mode. Если ваша 
вышивка слишком велика, или содержит 
много образцов, можно разбить ее на 
несколько пяльцев. Это позволяет вам 
создавать и работать с образцами, размер 
которых превышает размер любых 
отдельных пялец. Режим Hoop Layout 
позволяет установить положение и 
последовательность использования каждых 
пялец. См. раздел Закрепление в пяльцах 
крупных проектов 

 
Настройки просмотра проекта 
 
Вы можете показывать или скрывать 
элементы проекта в режиме Embroidery 
Canvas разнообразными настройками 
отображения. Вы можете показывать 
графическое изображение вышивки в 
готовом виде , показывать точки прокола 
иглой, соединительные и обычные 
стежки, а также показывать или скрывать 
выбранные цвета. 
 
Просмотр вида вышивки 

 
С помощью кнопки просмотра 
вида вышивки (Show Artistic 
View) на общей панели 
инструментов (General toolbar) 

можно включать/выключать просмотр 
вида вышивки. 
 
 
С помощью функции Artistic View, можно 
просмотреть, как будет окончательно 
выглядеть  ваша вышивка. 
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Чтобы просмотреть вид вышивки: 

• Чтобы просмотреть вид вышивки 
(Artistic View), включите режим 
Show Artistic View , нажав на 
иконку. 
 

 
 
 
 
 
 
 
 
 

• Для просмотра вышиваемых 
стежков (Stitch View), отключите 
режим Show Artistic View , отжав 
иконку. 

 
 
 
 
 
 
 
 
 

 
 
Просмотр точек прокола иглы 
 
Выберите Needle Points в меню View, чтобы 
показать или скрыть точки прокола иглы. 
 
В режиме Embroidery Canvas вы можете 
отображать или скрывать точки прокола 
иглы. Например, вы можете захотеть 
просмотреть точки прокола иглы, чтобы 
выбрать стежки для редактирования. См. 
также раздел Редактирование стежков 
в Руководстве пользователя.  
 
Как просмотреть точки прокола 
иглы 
 
◄ Для просмотра точек прокола иглы 

выберите View (Вид) > Needle Points 
(Точки прокола иглы). 

 

 
                             Функция 
Needle Points включена 

 
 
Просмотр стежков и контуров 

 
Щелкните по Show Stitches (панель 
General), чтобы включить или 
отключить показ стежков. 

 
Вы можете отображать или скрывать стежки 
и контуры объекта при работе в любом 
режиме просмотра. Скройте стежки, чтобы 
более четко видеть контуры при изменении 
формы. Подробнее см. в разделе 
Изменение формы и правка объектов в 
Руководстве пользователя.  
 
Как просматривать стежки и 
контуры 
 
◄ Нажимайте кнопку Show Stitches 

(Показать стежки), чтобы показать 
или скрыть стежки. 
 

 
                    Стежки показаны     Стежки скрыты 

 
Просмотр объектов в цвете 
 
Выберите By Color (меню View), чтобы обособить 
элементы проекта по цвету. 
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Чтобы выделить индивидуальные 
элементы для контроля или манипуляций, 
функция View By Color (Просмотр по 
цвету) позволяет просматривать проект в 
цвете. Это, в частности, полезно, когда 
вы изменяете последовательность 
вышивания в цвете. См. также 
Изменение последовательности 
объектов по цвету в Руководстве 
пользователя.  
 
Примечание: Вам потребуется 
перегруппировать проект, прежде чем вы 
сможете просмотреть объект в цвете. 
 
 
Как просматривать объекты по 
цвету 
 
1 Создайте или откройте проект.  

 
 
 
 
 
 
2

 Выберите View > By Color. 
Откроется диалоговое окно Select By 
Color (Выбор по цвету). 

 

 
 
3 Выберите цвета, которые вы хотите 
просмотреть. 

◄ Для выбора нескольких идущих 
подряд цветов удерживайте 
нажатой клавишу Shift. 

◄ Для выбора нескольких цветов 
удерживайте нажатой клавишу Ctrl. 
 

4 Нажмите кнопку ОК. 
 
 
 
 

Проект появится только с теми 
цветами, которые вы выбрали для 
просмотра. 

 
 

Выбраны два цвета 
 
 
5 Для просмотра всех цветов выберите 
опять View > By Color и щелкните по All 
Colors. 
6 Нажмите кнопку OK. 
 

Совет: Функция Color Film 
предоставляет другой путь просмотра 
объектов.  Подробнее см. в разделе 
Просмотр и выделение цветных 
блоков. 

 
Изменение масштаба и 
панорамирование 
 
Используйте функции Overview Window и 
Zoom для быстрой проверки вашего 
проекта при разных ступенях увеличения. 
 
Совет: В строке состояния показывается 
текущий "коэффициент 
масштабирования". Подробнее см. 
Запуск вышивального программного 
обеспечения BERNINA Embroidery 
Software. 
 
Просмотр проектов в обзорном 
окне 
 
Используйте Overview Window (Обзорное 
окно) для просмотра проектов в виде 
свернутых в пиктограммы изображений. 
Это окно обновляется, как только вы 
проведете изменения и может быть 
использовано для увеличения масштаба 
или панорамирования в окне проекта. 
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Как просматривать проекты в 
обзорном окне   
 
1 Выберите View > Overview Window.  

Откроется Overview Window (Обзорное 
окно).. 

 
 
 
 
 
 
 
 
 

Щелкните, чтобы 
активировать функцию 
масштабирования 

 
2 Чтобы увеличить или уменьшить 

масштаб, щелкните по кнопке Zoom в 
обзорном окне и обведите вокруг 
увеличиваемой детали 
ограничивающий прямоугольник и 
перетащите его. 

 
Перетащите 
прямоугольник, 
ограничивающий 
увеличиваемую 
деталь 
изображения 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3 Для панорамирования по проекту 
переместите указатель мыши за 
пределы выделения – он примет вид 
четырех разнонаправленных стрелок – 
и перетащите.  

Перетащите квадратик для 
панорамирования 

 
 
 

Увеличение и уменьшение 
изображения 

Щелкните по Zoom Box (панель 
General) для увеличения и 
уменьшения изображения в окне 
проекта.  
Используйте этот инструмент также в 
оконтуренных областях экрана. 
Щелкните по Show All (панель 
General), чтобы показать весь проект. 
 
Щелкните по Show 1:1 (панель 
General), чтобы показать проект в 
натуральную величину. 

 
Увеличьте изображение проекта 
вышивки, чтобы рассматривать 
индивидуальные стежки или детали, или 
уменьшите его, чтобы отобразить в окне 
большее количество деталей проекта. 
Текущий масштабный коэффициент 
показывается в нижнем правом углу 
экрана. См. также Клавиатурные 
команды. 
 

 
Примечание: Чтобы быть уверенным в 
том, что проект отображается на экране в 
правильных размерах, необходимо 
калибровать монитор. Подробнее см. в 
разделе Калибровка монитора в 
Руководстве пользователя.  
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Как увеличить и уменьшить 
изображение на экране 
 
◄ Щелкните по значку Zoom Box или 

нажмите клавишу B.Указатель мыши 
примет вид лупы. 

◄ Щелкните правой кнопкой в окне 
проекта – изображение уменьшится 
наполовину от предыдущего размера, 
его центр будет находиться в точке 
щелчка.  

 
Щелчок правой кнопкой 
мыши 

 
Совет: В строке состояния 
показывается текущий "коэффициент 
масштабирования". Подробнее см. 
Запуск вышивального 
программного обеспечения 
BERNINA Embroidery Software в этом 

     руководстве. 
◄ Щелкните левой кнопкой в окне 

проекта – изображение увеличится 
вдовое по сравнению с предыдущим 
размером, его центр будет находиться 
в точке щелчка.  
 

 
◄ Щелкните левой или правой кнопкой и 

перетащите ограничивающий 
прямоугольник вокруг 
масштабированной зоны. Отпустите 
кнопку мыши, чтобы увидеть всю 
масштабированную зону на экране. 

                               
Выбрать и перетащить 

 
 

Примечание: Все растровые 
изображения, независимо от 
контекста, сохраняют тот же масштаб, 
что и вышивка. Растровые 
изображения используются в большом 
количестве контекстов:  
◄ В качестве оригинала или 

направляющего рисунка для 
оцифровки. Подробнее см. в 
разделе Оцифровывание с 
оригиналом в Руководстве 
пользователя.  
 

◄ В качестве фона для имитации 
материала, на котором выполняется 
вышивка. Подробнее см. в разделе 
Изменение фона в этом 
руководстве. 
 

◄ В качестве лоскута ткани для 
аппликации. Подробнее см. в 
разделе Оцифровывание для 
аппликаций в Руководстве 
пользователя.  
 

◄ Чтобы отобразить весь проект, 
нажмите кнопку Show All. 
 

◄ Альтернативно выберите View > Show 
All, или нажмите 0.  
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◄ Чтобы отобразить проект в 
натуральную величину, нажмите 
кнопку Zoom 1:1.  

 
◄ Для отображения стежков в частичном 

масштабе нажмите клавишу F на 
клавиатуре. Введите величину 
масштабирования в процентах и 
щелкните по OK. 

 
 

Введите масштаб 
 
◄ Нажмите клавишу Esc, Enter или 

Клавишу пробела, чтобы выйти из 
режима Zoom. 

 
Просмотр последовательности 
вышивания отдельных 
фрагментов 
 
При работе с проектами вышивки вам 
необходимо разобраться с 
последовательностью вышивания. Вы 
можете проверить последовательность 
вышивания проекта путем ‘обхода’ по 
стежкам, цветам или объектам. Вы можете 
также проверить последовательность 
медленным перерисовыванием проекта на 
экране. BERNINA имитирует вышивание 
при изменении стежков от черного до 
назначенного цвета нитки, как это 
происходит при вышивании. См. также 
раздел Просмотр и выделение цветных 
блоков  
 

 
Обход проекта по объектам и 
цветным блокам 
 
Используйте клавиатурные команды для 
обхода проекта по объектам или по 
цветным блокам. Этот технический прием 
полезен в том случае, если вам нужно 
найти конкретный объект, чтобы удалить 

его или вставить другой объект в этой точке 
последовательности вышивания.  См. также 
раздел Клавиатурные команды 
 
Как обходить проект по объектам 
или цветным блокам 
• Для перехода к конечной точке проекта 

нажмите клавишу End.  
Белый крест установится на конечном 
стежке, а весь проект отображается с 
выбранными цветами ниток. 
 

Start point = Начальная точка 
End point = Конечная точка 
White cross – current needle position marker = 
Белый крест – маркер текущего положения 
иглы 
 
 
• Для перехода к начальной точке 

проекта нажмите клавишу Home. 
Белый крест установится на первом 
стежке, а весь проект отображается 
темно-серым цветом.  
 

 
 

 
 
 
 
 
 

 
• Для перехода к следующему объекту, 

нажмите  
Ctrl + T. 
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• Для перехода к предыдущему объекту, 

нажмите Ctrl + T. 
• Для перехода к следующему цвету, нажмите 

клавишу Page Down.  
 

• Для перехода к предыдущему цвету, 
нажмите клавишу Page Up. 

 
 
Совет: Активированным инструментом 
Select Object (Выбор объекта) вы можете 
выбирать объекты при обходе 
последовательности вышивания. 
Подробнее см в разделе Выбор объектов 
клавишей Tab. 
 
 
Обход по стежкам 
Используйте соответствующие инструменты 
или клавиатурные команды для обхода 
проекта по одному или по нескольким 
стежкам. Текущее положение иглы 
отмечается большим белым крестом, или 
"маркером положения иглы". Вначале он 
располагается в конечной точке проекта. 
При обходе по стежкам, маркер положения 
иглы соответственно перемещается. 
Текущий номер стежка появляется в Строке 
состояния. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Как обойти проект по стежкам 
1 В режиме просмотра проекта выберите 
Edit > Stitch Edit или нажмите клавишу Esc. 
 
2 Убедитесь в том, что функция Select 

Object (Выбрать объект) не выбрана, 
затем нажимайте клавиши со стрелками, 
чтобы обходить проект по одному или по 
десять стежков. 
  
  
  
  

◄ Нажимайте левую или правую 
клавишу со стрелкой, чтобы обойти 
проект по одному стежку в обратном 
или прямом направлении. 

◄ Нажимайте верхнюю или нижнюю 
клавишу со стрелкой, чтобы обойти 
проект по десять стежков в обратном 
или прямом направлении. 
 

3 Нажимайте клавишу "+" или "-" на малой 
клавиатуре, чтобы обойти проект шагами 
по 100 стежков. Клавишей "+" маркер 
перемещается в прямом направлении, 
клавишей "-" в обратном направлении. 

                                Переход назад 
                                на один стежок 
 
Совет: Если вы вышли за пределы видимой 
области, нажмите клавишу C, чтобы 
текущий стежок оказался в центре экрана. 
 
Моделирование образцов 
вышивки 
 
Инструмент Slow Redraw (Медленное 
перерисовывание)   позволяет 
моделировать образцы вышивок прямо на 
экране. Этот инструмент можно 
исполдьзовать для просмотра хода 
вышивки образца и последовательности 
цветов ниток в замедленном темпе. 
Начиная с любого стежка вышивки можно 
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начать его перерисовывать. Ранее 
вышитые части образца можно скрыть, если 
требуется. Работая с большими образцами 
вышивок, можно использовать функцию 
автоматического перемещения по образцу, 
так что область, вышиваемая в данный 
момент, всегда будет на экране. 

 
 
Поскольку функция Slow Redraw имитирует 
движение вышивальной машины, вы 
имеете возможность оптимизировать свой 
проект, чтобы снизить нагрузку на машину. 
Это особенно важно, если вы намерены 
выполнить несколько вышивок в одном 
проекте. По этой причине рекомендуется 
использовать функцию Slow Redraw на 
завершенных проектах. 
 
Для моделирования образца 
вышивки 
 
1 Перейдите в режим просмотра стежков 
Stitch View. 
 
Примечание: Функция Slow Redraw не 
может быть использована в режиме  
просмотра Artistic View. 
 
2 Выберите View > Slow Redraw или 
нажмите Shift+R. 
 
   
 
 
 
 
 
 
 

  Откроется диалоговое окно Slow Redraw  

 
3 Чтобы перерисовать только часть 

образца,  укажите начальный и 
конечный стежок этой части в поле 
Stitch Range. 

 
4 Используйте ползунок для установки 

скорости перерисовывания. 
 
5 Нажмите кнопку Play. 
 Проект будет перерисован на экране в 

соответствии с последовательностью 
вышивания. 

 
6 Настройте управляющие кнопки: 
 
Кнопка Функция 
Скорость (Speed) 
 

Используйте ползунок 
для настройки скорости 
перерисовки в режиме 
“реального времени”. 

Пауза (Pause) 
 

Приостанавливает 
перерисовку, позволяя 
вам решить, где вы 
хотите остановиться. 
 

Остановка (Stop) 
 

Прекращает перерисовку 
и возвращает к началу 
образца. 
 

Начать с начала 
(Back to Start) 
 

Начинает перерисовку от 
начала образца. 
 
 

 
 
Отображение оригинала проекта и 
фона 
 
Во время оцифровывания вы можете 
отобразить оригинал проекта. Его 
изображение можно временно скрыть или 
сделать блеклым, чтобы лучше 
просматривались стежки. 
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Отображение или скрытие оригинала 
 
 Используйте функцию показа 

рисунка Show Picture (общая 
панель инструментов General), 
чтобы  включать/отключать 
показ оригинала рисунка. 
 

 Используйте функцию Dim 
Artwork (общая панель 
инструментов General) для того, 
чтобы сделать фон более 
блеклым, для более отчетливого 
просмотра стежков при 
оцифровке. 
 

 Используйте функцию Show 
Vectors (общая панель 
инструментов General) для того, 
чтобы включать/выключать 
функцию просмотра векторной 
графики. 
 

 

Используйте функцию Show 
AppliquéFabric (общая панель 
инструментов General), чтобы 
включать/отключать показ 
ткани/цвета аппликации. 
 

 
 
Можно отображать фон, растровую или 
векторную графику при оцифровке, а можно 
их временно скрыть. Если фон скрыт – он 
не удаляется из образца. Можно сделать 
фон более блеклым, чтобы отчетливее 
видеть стежки. См. также раздел  
Оцифровывание с оригиналом. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Как просматривать оригиналы 
 

• Чтобы включать/отключать растровую и 
векторную графику – используйте 
иконку показа рисунков Show Pictures. 
См. также раздел Импорт 
изображений в программу 
BERNINA Embroidery Software. 

 
Примечание: Изображение становится 
блеклым, если выбрана функция Dim 
Picture (Затенить рисунок). 
 
 
• Чтобы сделать фон блеклым, нажмите 

Dim Artwork. 

 
Внимание: Для возвращение к 
полноцветному изображению, нажмите Dim 
Picture еще раз. 
 
• Чтобы включать/отключать растровую и 

векторную графику – используйте 
иконку Show Vectors. 
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Щелкните по кнопке Show Appliqué Fabric 
(Показать ткань апплицкции), чтобы 
показать материал/цвет аппликации. См. 
также раздел  
Оцифровывание для аппликаций. 

 
 
● Чтобы скрыть материал/цвет 

аппликации, нажмите кнопку Show 
Appliqué Fabric еще раз.  

 
 
Изменение фона 
 
Для изменения цвета фона или ткани выберите 
функцию Fabric Display (меню Settings). 
 

Используйте функцию Show 
AppliquéFabric (панель General), чтобы 
включать/отключать показ ткани/цвета 
аппликации. 

 
BERNINA Embroidery Software дает 
возможность выбирать цвет фона в окне 
проекта, чтобы согласовать его с цветом 
вашей ткани. Или же можно выбрать фон 
ткани для более реалистичного вида и 
воспроизведения. Фон сохраняется 
вместе с проектом. 
 
Совет: Используйте переключатель Show 
Appliqué fabric (Показать ткань 
аппликации), чтобы включить или 
выключить отображение цвета ткани 
аппликации. См. раздел Размещение 
тканей в проекты Auto Applique в 
Руководстве пользователя.  
 
 
 
 
 
 
 
 

Как изменить цвет фона или ткань 
 
1 Выберите Settings (Настройки) > 
Fabric Display (Отображение ткани)..  

Откроется диалоговое окно Display 
(Отобразить). 

 
 
 

 
 

Выбор цвета фона или ткани  
 
Совет: Вы можете также получить доступ 
к этому окну, использовав Settings > 
Thread Colors, или щелкнув по ссылке 
диалогового окна ColorPalette. Дважды 
щелкните по BKG в таблице Thread 
Colors (Цвета ниток). Подробнее см. в 
разделе Цвета ниток и таблицы 
ниток в Руководстве пользователя.  

 
Щелкните для доступа    

Дважды щелкните,    
чтобы изменить фон 
к цветам ниток 

 
2 Выберите тип фона, который вам 
нужен: 

◄ Color (Цвет). Выбор цвета фона  
◄ Fabric (Ткань). Выбор ткани фона. 

 
3 Введите цвет ткани, который вы хотите 
использовать. 
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◄ Для выбора цвета фона, щелкните 
по Edit и выберите цвет из 
диалогового окна Color (Цвет). 

 
 
 
 
 
 
 
 
 

◄ Для выбора ткани щелкните по 
Browse и выберите ткань в 
диалоговом окне Load 
Picture(Загрузить рисунок). Ткани 
расположены в папке ..\Program 
Files\BERNINA\Embroidery Software 
6\fabrics. 

 
 
Совет: Если вы выбрали ткань, вы 
можете расположить изображение по 
центру окна проекта или образовать 
мозаичную структуру. Если растровый 
рисунок достаточно большой, чтобы 
заполнить все окно, выберите Center. В 
противном случае выберите Tile 
(Плиточная кладка). 
 

 
 

Выберите мозаику или центровку  

 
 
 
 
 
 
 
 
 

4 Нажмите кнопку ОК. 
 

 
 
 
 
 
 
 
 

желтый фон фон    джинсовой ткани 
 

Примечание: Фон сохраняется вместе с 
проектом. 
 
Просмотр информации о проекте 
 
BERNINA Embroidery Software 
предоставляет информацию о проектах 
разнообразными способами и в разных 
форматах. Еще перед открытием 
BERNINA или своего проекта вы можете 
проверить некоторую информацию о 
файлах формата ART непосредственно 
из MS Windows® Explorer. Вы можете 
просмотреть детали вышивания в 
диалоговом окне Design Properties 
(Свойства проекта). Важную 
информацию о проекте дает функция 
Print Preview (Предварительный 
просмотр), включая просмотр проекта в 
целом, размеры проекта, 
последовательность цветов и 
специальные указания. 
 
Просмотр свойств проекта 
 
Используйте функцию Design Properties (меню 
File), чтобы увидеть детали вышивания проекта. 
 
В диалоговом окне Design Properties 
(Свойства проекта) вы можете 
проверить номер версии программного 
обеспечения и другую информацию. 
Приводятся также детали вышивания. 
Большинство данных в этих полях не 
подлежат непосредственному изменению. 
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Как просмотреть свойства 
проекта 
 
1 Выберите File > Design Properties. 

Откроется вкладка Design диалогового 
окна Design Properties . 

 
На этой вкладке содержится 
информация о высоте и ширине 
проекта, количестве стежков и цветов. 
Эти данные извлечены из проекта и не 
могут быть изменены.  

 
 

2 Выберите закладку Summary, чтобы 
увидеть или ввести информацию о 
проекте. 

 

 
3 Щелкните на поле и введите любой 

текст, который поможет вам 
впоследствии идентифицировать 
проект. 

 
Примечание: Информация из этой 
вкладки включена в окно 
Предварительного просмотра, а также 
во вкладку Summary диалогового окна 
Windows Properties. Подробнее см. в 

разделах Просмотр информации о 
проекте в Проводнике Windows  и 
Предварительный просмотр 
проектов.  
 
4 Нажмите кнопку OK. 
 

Просмотр информации о проекте 
в Проводнике Windows  
 
Перед открытием файлов ART вы можете 
посмотреть пиктограмму проекта и его 
данные через Проводник Windows. 
Диалоговое окно Properties (Свойства) 
позволяет просмотреть проект совместно 
с информацией о проекте, такой как 
количество стежков и количество 
остановок для замены цветных ниток. 
Приводится также общая информация о 
файле – размерфайла и дата последнего 
изменения. Подробнее см. в разделе 
Управление проектом в Руководстве 
пользователя. “  
 
Примечание: Эти же данные появляются 
в диалоговом окне Open (Открыть) в ПО 
BERNINA. См. также раздел Открытие 
проектов. 
 
Как просмотреть информацию о 
проекте в Проводнике Windows  
 
1 Выберите файл в Проводнике 
     Windows. 
      Проекты показываются в  
      виде пиктограмм.  

2 Щелкните правой кнопкой мыши по 
файлу и выберите Properties (Свойства) 
из всплывающего меню. 
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Откроется диалоговое окно Properties 
(Свойства). 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
3 Проверьте информацию о проекте или 
нажмите другую закладку для 
ознакомления с общей информацией о 
файле. 
 

Совет: Закладка Summary позволяет 
получить ту же информацию, которая 
была введена в закладке Design 
Properties > Summary программы 
BERNINA Embroidery Software. 
Подробнее см. в главе Просмотр 
свойств проектов.  

4 Нажмите кнопку OK. 
 
Предварительный просмотр 
проектов 

Нажмите кнопку Print Preview (панель 
General), чтобы увидеть на экране 
проект в том виде, в котором он может  

                  быть распечатан. 
 

Функция Print Preview 
(Предварительный просмотр) 
позволяет получить важную 
информацию о проекте, включая 
просмотр проекта в целом, размеры 
проекта, последовательность цветов и 
специальные указания. См. также 
раздел Распечатка проектов в 
Руководстве пользователя.  

 
 
 

 
Как предварительно просмотреть 
проект 
1 Нажмите кнопку Print Preview 
(Предварительный просмотр). 

В окне предварительного просмотра 
появится изображение проекта. 

 
Щелкните, чтобы    Нажмите, чтобы  
распечатать проект              показать одну или  
                                              две страницы 
 

 
 

  
 

о 
 

Настройте требуемый вид изображения: 
 

◄ Для изменения ориентации на 
бумаге выберите Landscape 
(Альбомная) или Portrait 
(Портрет).  

◄ Для изменения отображаемой 
информации и установки требуемых 
опций печати выберите Options. 
См. также Настройка опций 
печати вышивальных файлов в 
Руководстве пользователя.  

◄ Нажмите Zoom In, чтобы прочитать 
информацию о проекте или более 
подробно просмотреть проект. 
Большие проекты могут быть 
отображены на нескольких 
страницах. 

◄ Чтобы распечатать проект, нажмите 
Print.  

◄ Чтобы закрыть окно 
предварительного просмотра, 
нажмите Close.

 

Щелкните, чтобы  
настроить опции печати 
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ГЛАВА 5 
 

ВЫБОР ОБЪЕКТОВ 
------------------------------------------- 
 

 
 

BERNINA Embroidery Software 
предоставляет различные меню для 
выбора объектов, из которых состоит 
вышивальный проект. В них входят такие 
средства, как указать и щелкнуть, выбор 
методом ограничивающего прямоугольника 
и многие способы выделения объекта. Вы 
можете выбрать все объекты в проекте или 
индивидуальный объект для прецизионной 
модификации. BERNINA Embroidery 
Software позволяет выбрать объект для 
оконтуривания или заполнения. 
 
Примечание: Перед выделением объектов 
проект должен быть разгруппирован. 
Подробнее см. в разделе Разгруппирование объектов экранного руководства. 
 
В этом разделе описывается, как выбирать объекты, используя инструменты 
выбора и клавиатуру. Также объясняется, как выбирать цветные блоки или 
индивидуальные объекты, используя функцию Color Film. 

 
 
 
 
Выбор объектов методом 
"указать и щелкнуть" 

 
Щелкните по Select Object (панель Edit), 
если необходимо (эта кнопка 
активирована по умолчанию) и 

щелкните по объектам для выделения. 
 
Наиболее просто можно выделить 
объект, если при активированном 
инструменте Select Object переместить на 
него указатель мыши и нажать левую 
кнопку. Удерживая нажатыми клавиши 
Shift и Ctrl, можно выбрать несколько 
объектов. Могут быть выбраны как 
оконтуренные, так и заполненные 
объекты. Щелчком по контуру объект 
выбирается даже в том случае, если над 
ним находится другой объект. Если вы  

 
 
 
выбираете смешанные или замкнутые 
объекты, вы можете выбрать контуры или 
заполняющие стежки. 
 
Примечание: При малой плотности 
стежков или при большом увеличении 
изображения может случиться, что 
указатель мыши установится между 
стежками, и объект не будет выделен.  
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Как выбирать объекты методом 
"указать и щелкнуть" 
◄ Щелкните по Select Object (Выбрать 

объект).  
◄ Щелкните мышью по контуру, чтобы 

выделить объект. 
 
 
 
 
 
 
 
 
 
 
◄ Щелкните по заполняющим стежкам, 

чтобы выделить заполненный объект. 
 
 
 
 
 
 
 
 

 
◄ Щелкните по заполнению, чтобы 

выделить объект даже в том случае, 
если он находится в контурах 
большого объекта. 

 
 
 
 
 
 
 
 
 

Совет: Чтобы выбрать объект, 
находящийся за другим объектом, 
увеличьте масштаб изображения и 
щелкните по контуру. Альтернативно 
расположите указатель мыши над 
объектом, удерживайте нажатой 
клавишу 2 и щелкайте мышью до тех 
пор, пока объект не будет выделен. С 
каждым щелчком будет выделяться 
следующий перекрывающий объект. 
 
 
 

◄ Для выбора нескольких цветов 
удерживайте нажатой клавишу Ctrl. 

 

 
Щелкните по объекту 
 Удерживая нажатой клавишу 
Ctrl, щелкните по другому объекту 

 
◄ Выделите несколько последовательно 

расположенных объектов, удерживая 
нажатой клавишу Shift и щелкая мышью 
по первому и последнему объектам 
выделяемого диапазона. 

Щелкните по первому объекту   Удерживая  
                                                            нажатой  
                                                            клавишу Shift, 
                                                            щелкните по  
                                                            последнему  
                                                            объекту 
 
Выбор объектов ограничивающим 
прямоугольником 
 

Выберите инструмент Select 
Object (меню Edit) и очертите  
указателем мыши  
ограничивающий прямоугольник   

   вокруг выделяемого объекта. 
 
При активированном инструменте Select 
Object (Выбрать объект) вы можете 
выделять объекты, очерчивая вокруг них 
указателем мыши ограничивающий 
прямоугольник. 
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Как выбирать объекты 
ограничивающим 
прямоугольником 
 
1 Щелкните по кнопке Select Object 

(Выбрать объект). 
2  Очертите указателем мыши 

ограничивающий прямоугольник вокруг 
выделяемых объектов. 
Объекты будут выделены, как только 
вы отпустите кнопку мыши. 

 
Очертите ограничивающий   Объекты выделены 
прямоугольник 
вокруг объектов  
 
 
Примечание: До тех пор, пока объекты 
не будут сгруппированы, после 
отпускания кнопки мыши выделяться 
будут только те объекты, которые 
полностью охватываются 
ограничивающим прямоугольником. См. 
также раздел Группировка объектов в 
Руководстве пользователя.  
 
Выбор объектов инструментом 
Polygon Select 

 
Используйте инструмент 
Polygon Select (панель Edit), 
чтобы выделить объекты 
ограничивающим  

                многоугольником. 
 
 
Используйте инструмент Polygon Select 
(Выбор многоугольником), чтобы 
выделить объекты ограничивающим 
многоугольником. 
 
Как выбирать объекты 
инструментом Polygon Select 
 
1 Щелкните по кнопке Polygon Select. 

2 Наметьте базисные точки вокруг 
объекта или объектов, которые нужно 
выделить. 
Выделяемые объекты должны 

полностью находиться внутри 
контурной линии. 

3 Нажмите Enter для выделения. 
 

Наметьте базисные точки вокруг 
выделяемых объектов для выбора  

 
Выбор объектов клавишей Tab  
 

Щелкните по кнопке Select Object 
(панель Edit) и нажимайте Tab или 
Shift + Tab для перехода между  

           объектами. 
 
При активированном инструменте Select 
Object вы можете выделить первый или 
последний объект в последовательности 
проекта, используя клавишу Tab. Если 
один из объектов выделен, вы можете 
выбрать предыдущий или следующий 
объект в последовательности вышивания. 
См. также раздел Изменение формы 
следующего или предыдущего 
объекта в Руководстве пользователя.  
 
Как выбирать объекты клавишей 
Tab  
 

◄ Щелкните по значку Select Object 
(Выбрать объект). 

◄ Если уже выбран один из объектов, 
выполните одну из следующих 
операций: 
◄ Нажмите клавишу Tab, чтобы 

выделить следующий объект в 
последовательности вышивания.  

◄ Нажмите Shift+Tab, чтобы 
выделить предыдущий объект. 
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◄ Если еще не выбран ни один из 

объектов, выполните одну из 
следующих операций:  
◄ Нажмите клавишу Tab, чтобы 

выделить первый объект в 
последовательности вышивания.  

◄ Нажмите Shift+Tab, чтобы 
выделить последний объект. 

 
Совет: Удерживайте нажатой клавишу 
Ctrl, чтобы выделить несколько 
объектов между уже выбранными. 

 
Выбор всех объектов в проекте 
 
Выберите все объекты для 
одновременных изменений во всем 
проекте. См. также Клавиатурные 
команды. 
 
Как выбрать все объекты в 
проекте 
 
◄ Выберите Edit > Select All (Выделить 

все) или нажмите Ctrl + A. 
Вокруг всего проекта появятся 
маркеры размера. 

 
 
 
 

Чтобы отменить выделение, выберите 
Edit > Deselect All (Отменить 
выделение всех объектов), или 
нажмите X или Esc.  
 
 
 

Отмена выделения и удаление 
объектов 
 
Отмена выделения и удаление являются 
основными операциями, которые быстро 
приобретают второе свойство. См. также 
раздел Комбинирование объектов в 
Руководстве пользователя.  
 
Отмена выделения объектов 
 
Вы можете отменять все выделения в 
проекте или удалять отдельные объекты 
из группы выделенных объектов. 
 
Как отменить выделение 
объектов 
 
◄ Отменяйте выделения одним из 

следующих способов: 
◄ Нажмите Esc. 
◄ Выделите другой объект. 
◄ Щелкните мышью на пустом месте 

фона. 
◄ Выберите Edit > Deselect All.  

◄ Удалите объект из выделения, 
удерживая нажатой клавишу Ctrl и 
щелкнув мышью по объекту, 
выделение которого нужно отменить. 

 
Удаление объектов 
 
Выберите команду Delete (меню Edit), чтобы 
удалить выделенные объекты. 
 
Удалять объекты можно различными 
методами. См. также Назначение 
последовательности объектов 
инструментом Color Film в 
Руководстве пользователя.  
 
Как удалять объекты 
 
◄ Выделите объект (или объекты) для 

удаления и выполните одну из 
следующих операций: 
◄ Нажмите Delete  
◄ Выберите Edit > Delete. 
◄ Щелкните правой кнопкой мыши по 

Color Film и выберите Delete  из 
всплывающего меню. Подробнее 
см. в следующем разделе 
Просмотр и выделение цветных 
блоков. 

 

Не выделен          Выделены все 
 ни один объект     объекты 
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Просмотр и выделение цветных 
блоков 

 
Щелкните по кнопке Color Film 
(панель General), чтобы  

              просмотреть все цветные блоки и  
              объекты в проекте. 

  
Щелкните по кнопке Show 
Individual Objects (панель Color 
Film), чтобы просмотреть  

             индивидуальные объекты в  
             порядке последовательности  
            вышивания.  
Функция Color Film выводит список 
последовательности вышивания 
объектов, сгруппированных по цвету. 
Используйте ее для выбора и обработки 
"цветных блоков" – непрерывно 
следующих друг за другом объектов 
одного и того же цвета. Кроме того, вы 
можете отображать, выделять, изменять 
и изменять последовательность 
индивидуальных объектов. Функция Color 
Film синхронизирована с окном проекта. 
Она динамически обновляется в то 
время, когда вы выбираете, изменяете 
или удаляете объекты или создаете 
новый объект. См. также Назначение 
последовательности объектов 
инструментом Color Film в 
Руководстве пользователя.  
 
Как просматривать и выделять 
цветные блоки 
 
◄ Щелкните по кнопке Color Film. 

Откроется панель Color Film, 
отображающая все цветные блоки в 
проекте в порядке последовательности 
вышивания. 

 
 
 
 

 

 
◄ Щелкните по переключающей кнопке 

Show Individual Objects (Показать 
индивидуальные объекты), чтобы 
просмотреть индивидуальные 
объекты. 
Все объекты в пределах цветного 
блока показываются в 
последовательности вышивания. 

◄ Щелкните по значку, чтобы выбрать 
цветной блок или объект.  
◄ Для выбора нескольких идущих 

подряд объектов удерживайте 
нажатой клавишу Shift.  

◄ Для выбора нескольких объектов 
удерживайте нажатой клавишу Ctrl. 

 
Выбор цветного блока или объекта 
в панели Color Film 

 
Манипулируйте цветными блоками при 
необходимости. См. также Назначение 
последовательности объектов 
инструментом Color Film в 
Руководстве пользователя.  

◄ Вы можете получить быстрый доступ к 
командам всплывающего меню для 
манипуляции цветными блоками и 
объектами, щелкнув правой кнопкой 
мыши по значку цветного блока. См. 
также раздел Комбинирование 
объектов в Руководстве 
пользователя.  

Все объекты, 
составляющие 
цветной блок, 
показываются в 
последователь-
ности 
вышивания. 

Непрерывно 
следующие друг за 
другом объекты 
одного и того же 
цвета образуют 
единый "цветной 
блок". 



Глава 5: Выбор объектов 

BERNINA Вышивальное программное обеспечение – Краткое справочное руководство 50

 
 

 
Подсказка: Чтобы увеличить изображения 
на пиктограмах, или чтобы выделить 
цветом блоки объектов, нажмите на кнопку 
мыши и “потяните” за край диалогового 
окна. 

 

 

Используйте 
всплывающее меню
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ЧАСТЬ II 

 

СРЕДСТВА ОБУЧЕНИЯ 

ПОЛЬЗОВАНИЮ 
ВЫШИВЛЬНЫМ ПО 

BERNINA 
------------------------------------------- 
 
 
 
Эта часть руководства содержит большое количество рабочих средств обучения, которые 
помогут вам начать работу с BERNINA Embroidery Software. В общем случае любой проект, 
который вы сможете выполнить с помощью нижнего уровня программного продукта, можно 
выполнить и на более высоком уровне. Но не наоборот. Средства обучения ознакомят вас 
с основными техническими приемами работы, такими как изменение масштаба 
изображения и отображение стежков.   
Перед началом работы прочитайте Часть I руководства. 
 
 
Вступительное учебное пособие 
 
Это вступительное учебное пособие включает в себя указания по добавлению 
декоративного бордюра к тексту на предметах одежды, столовых салфетках или других 
изделиях. В нем будет показано, насколько просто и интересно создавать проекты в 
BERNINA Embroidery Software. Подробнее см. во Вступительном учебном пособии. 
 
 
Учебное пособие по редактированию 
 
В этом пособии вы ознакомитесь, как проверять проект и  находить не только 
действительные, но и потенциальные ошибки, которые могут повлиять на качество и 
внешний вид вышивки. Вы можете узнать о методах обнаружения и корректировки ошибок, 
оптимизировать проекты и ознакомиться с мощными средствами BERNINA Embroidery 
Software, позволяющими выполнять эти задачи. Подробнее см. в разделе  
Учебное пособие по редактированию. 
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Учебное пособие по автоматическому оцифровыванию 
 
В этом пособии вы сможете узнать, не только как автоматически оцифровывать проект, но 
также как улучшать автоматически созданные вышивки. Вы узнаете также, как проверять и 
изменять последовательность вышивания для оптимизации процесса вышивания. 
Подробнее см. в разделе Учебное пособие по автоматическому оцифровыванию . 
 
 
Учебное пособие по оцифровыванию 
 
В этом учебном пособии вы узнаете, как использовать комбинацию техники ручного и 
автоматического оцифровывания для создания вышивальных проектов по эскизам. 
Подробнее см. в разделе Учебное пособие по оцифровыванию. 
 
 
Учебное пособие по созданию монограмм 
 
Используя BERNINA Embroidery Software, очень просто создавать монограммы для 
различных целей применения. Функции создания монограмм включают в себя три 
основных элемента монограммы – текст, орнаменты и бордюры. В этом учебном пособии 
вы узнаете, как пользоваться инструментом Monogramming и как украшать проекты 
созданием простых и элегантных монограмм путем ручного оцифровывания того же 
проекта. Подробнее см. в разделе Учебное пособие по созданию монограмм. 
 
 
Учебное пособие по аппликациям 
 
Расширьте свой творческий потенциал аппликациями. BERNINA Embroidery Software 
обладает широким выбором образцов тканей для использования в проектах аппликаций, 
чтобы помочь вам визуализировать проект на экране. В этом учебном пособии вы узнаете, 
как применить в открытом проекте технику аппликации, оцифровыванием графического 
оригинала, входящего в комплект поставки. Подробнее см. в разделе  
Учебное пособие по аппликациям. 
 
 
Учебное пособие по использованию мультимедийных возможностей  
(Multi-Medium Tutorial)  
 
 
В этом учебном пособии мы изучим мощные мультимедийные возможности для 
создания вышивок, которые предоставляет программа BERNINA Embroidery Software. 
Вы научитесь сочетать цифровую печать на ткани и вышивку, на примере рисунка, 
который будет одновременно отпечатан и вышит в середине белой майки. Подробнее 
см. в разделе Учебное пособие по использованию мультимедийных 
возможностей. 
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ГЛАВА 6 
 

 
ВСТУПИТЕЛЬНОЕ УЧЕБНОЕ ПОСОБИЕ 
------------------------------------------- 
 
 
 
 
 
 

Это вступительное учебное пособие включает 
в себя указания по добавлению 
декоративного бордюра к тексту на предметах 
одежды, столовых салфетках или других 
изделиях. В нем будет показано, насколько 
просто и интересно создавать проекты в 
BERNINA Embroidery Software. В этом 
пособии вы узнаете, как создавать простые 
элементы проекта и добавлять к нему тексты, 
используя алфавит и цветные нитки по 
своему выбору. Вы можете также проверить 
проект перед вышиванием. Учебное пособие 
предназначено для использования со всему 
уровнями BERNINA Embroidery Software. 
 
Примечание: Здесь описаны все шаги, требуемые для создания проекта. Однако 
для более полной информации требуется обратиться к руководству пользователя. 

 
 
 
Первые шаги 
 
Для создания этого проекта мы использовали образцы вышивки, входящие в коллекцию 
программы BERNINA Embroidery Software. В ваш программный пакет BERNINA Embroidery 
Software включена коллекция оригиналов и вышивок, которые вы можете использовать для 
создания первых собственных проектов. В дополнение к коллекции образцов проектов вы 
найдете выделенную папку "Tutorials", которая содержит все файлы дополнений к этому и 
другим учебным пособиям. Конечный результат этого и других проектов также находится в 
этой папке. Вы можете захотеть просмотреть файл завершенного проекта до и/или после 
ознакомления с учебным пособием. См. также раздел Работа с файлами проектов. 
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Открытие образца проекта 
 

Нажмите кнопку Open (панель General), чтобы открыть существующий 
проект. 
 
 

В ваш программный пакет BERNINA Embroidery Software включена коллекция проектов, 
которые вы можете использовать для создания первых собственных проектов.  Для этого 
проекта мы использовать образец бордюра, который образует основу вашего проекта 
монограммы. См. также раздел Работа с файлами проектов. 
 
Как открыть образец проекта 
 
1   Выберите режим Embroidery Canvas.  

 
2   Щелкните по кнопке Open (Открыть).  

Откроется диалоговое окно Open. 
 
 

 
 
 
 
Панель 
просмотра 
 
 
 
 
 
Сведения о 
проекте 
 
 
 
 
 
Просмотр 
вкл./выкл. 
 
 

 
3   Выберите папку ..\My Designs\Tutorials\L,ettering из списка Look In. 
4   Выберите Lettering_Start  и щелкните по Open.  
     Проект будет открыт в окне проекта. 
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Просмотр изменений  
 

Режим позволяет оцифровывать и редактировать образцы 
вышивки. Показывает как образцы вышивки, так и графические 
заготовки. Дает возможность просматривать образцы 
реалистически в трехмерной  
графике 3D. 
 
 
В режиме Art Canvas, панель инструментов View Mode содержит 
кнопку Show Embroidery для включения/выключения дисплея 
вышивок. 

 
 
BERNINA Embroidery Software позволяет открывать и редактировать все ваши проекты в 
режиме Embroidery Canvas. Режим Художественного Просмотра показывает ваш проект в 
том виде, в каком он будет выглядеть после вышивки. В режиме Artistic View также доступны 
все команды редактирования. Подробнее см. в разделе Режимы просмотра. 
 
Примечание: Чтобы обеспечить, что проект отображается в реальном размере, вам 
потребуется откалибровать свой монитор. Подробнее см. в разделе Калибровка 
монитора руководства пользователя.  
 
Как изменить режим просмотра 
 
1 Выберите режим Embroidery Canvas, а затем щелкните по значку Artistic View, чтобы 

просмотреть проект в реалистичном виде. 
Проект отображается более реалистично, чем в нормальном режиме просмотра, поэтому 
в общем случае в этом режиме редактировать проект более удобно.  

 
Нормальный просмотр 

 
 

Artistic View (Художественный просмотр) 
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2 Увеличьте изображение проекта вышивки, чтобы рассматривать индивидуальные стежки 

или детали, или уменьшите его, чтобы отобразить в окне большее количество деталей 
проекта. Подробнее см. в разделе Изменение масштаба и панорамирование. 

 

 
 
 
Совет: Текущий масштабный коэффициент показывается в нижнем правом углу экрана. 
 
Выбор пялец 
 

Щелкайте по кнопке Show Hoop (панель General), чтобы включить или 
отключить показ пялец. Щелчок правой кнопкой мыши позволяет изменить 
настройки пялец. 
 
 
Щелкайте по Zoom Box (панель General) для увеличения и уменьшения 
изображения в окне проекта. Используйте этот инструмент также в 
оконтуренных областях экрана. 
 
 

В окне проекта будут показаны те пяльцы, которые вы установили на вышивальной машине 
BERNINA. Пяльцы стабилизирует ткань и будут идеальны только тогда, когда они 
достаточно большие, чтобы соответствовать проекту и гарантировать наименьшее 
растяжение ткани и искажение вышивки. Из предоставляемого вам списка пялец с разными 
типами и размерами выберите наименьшие пяльцы, которые подходят к вашему проекту.  
См. также раздел Закрепление проектов в пяльцах руководства пользователя. 
 
Как выбрать пяльцы на экране 
 
1 Щелкните правой кнопкой мыши по значку Show Hoop (Показать пяльцы).  
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Появится диалоговое окно Options (Опции).  
 

 
 
 
 
 
 
Выберите artista 255 x 145 Oval 
 
 
 
 
 
 
 
 
 

2   Выберите из списка пяльцы "artista 255 x 145 Oval". 
3   Нажмите кнопку OK. 
 
 
 
 
 
 
 
 
 
 
 

Пяльцы artista 255x145 Oval 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4 Увеличьте изображение, чтобы лучше видеть пяльцы – выберите инструмент Zoom Box и 

щелкните по проекту правой кнопкой мыши.  
 

Совет: Если вы уже выбрали пяльцы, вы можете отображать или скрывать их, щелкая по 
кнопке Show Hoop. 
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Сохранение проекта 
 
Теперь самое время сохранить свою работу. Пусть у вас войдет в привычку время от 
времени сохранять работу, чтобы не потерять сделанные вами изменения. См. также 
раздел Сохранение проектов. 
 
Как сохранить проект 
 
1   Выберите File (Файл)> Save As (Сохранить как). 

Откроется диалоговое окно Save As. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Введите 
подходящее 
имя и 
сохраните 
 
 
 

Совет: Диалоговое окно Save As открывают то же место, в котором сохранен 
оригинальный файл. 
 

2    Введите подходящее имя — 'LetteringTutorial' — в поле File name. 
3    Нажмите кнопку Save (Сохранить). 
 

Совет: Впоследствии для сохранения любых изменений вам потребуется щелкнуть по 
кнопке Save или нажать Ctrl+S. 

 
Создание обрамления проекта 
 
Теперь мы создадим элементы проекта, которые будут открыты, и дублируем и 
трансформируем их в бордюр нашего проекта. 
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Изменение размера и поворот первого элемента обрамления 

 
Для выбора элемента проекта используйте инструмент Select Object (панель 
Edit). 
 
Щелкните по значку Scale by 20% Down/Up (панель Edit), чтобы уменьшить 
размеры выбранных объектов на 20 %. Щелчок правой кнопкой мыши увеличивает 
выбранные объекты на 20 %. 
 
 
Щелкните левой кнопкой по значку Rotate 45° CCW/CW (панель Edit), чтобы 
повернуть объект или проект на 45° против часовой стрелки. Щелчок правой 
кнопкой – поворот на 45° по часовой стрелке. 
 

 
Вначале нам нужно слегка уменьшить бордюр проекта. Вы можете изменять его размеры 
путем перетаскивания меток – манипуляторов выделения или назначением точных 
размеров. При изменении размеров объекта изменяется количество стежков для 
сохранения плотности стежков. Теперь мы повернем наш элемент обрамления на 45°. См. 
Расположение и трансформация объектов в руководстве пользователя. 
 
Изменение размера и поворот первого элемента обрамления 
 
1   Щелкните по значку Select Object и щелкните по объекту. 
 

 
 

Примечание: По умолчанию проекты автоматически группируются при открытии или 
вставке в другой проект. Подробнее см. в разделе Настройка других общих опций 
руководства пользователя. 
 

2 Щелкните один раз левой кнопкой мыши по значку Scale Down/Up.  
После этого размер объекта уменьшится на 20 %. 

3   Щелкните теперь правой кнопкой мыши по значку Rotate (Повернуть). 
После этого объект повернется по часовой стрелке на 45°. 

 
 
 
 
Поворот и уменьшение на 20 % 
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Создание второго элемента обрамления 

 
Щелкните по кнопке Mirror Vertical (панель Edit), чтобы перевернуть объект или 
проект по вертикальной оси. 
 

Теперь мы повернем бордюр и используем его для создания второго элемента обрамления. 
Вначале мы клонируем оригинал и затем перевернем его по вертикали. Затем переместим 
его в нужное положение. Подробнее см. в разделе Комбинирование объектов 
руководства пользователя.  См. также раздел Перевод объектов в зеркальное 
отображение руководства пользователя. 
 
Как создать второй элемент обрамления 
 
1   Нажмите Ctrl+D для дублирования выбранного  
     объекта. 

Дублированный объект размещается непосредственно 
над оригинальным объектом и выделяется. 

 
 
 

Дублированный объект зеркально  
перевернут и находится над оригинальным 
объектом 

 
 
 
 
 
 
2   Щелкните по значку Mirror Vertical (Перевернуть объект по вертикали).  

Дублированный объект переворачивается по вертикали. 



Глава 6: Вступительное учебное пособие 
 

BERNINA Вышивальное программное обеспечение – Краткое справочное руководство 61

 
3  Перетащите дублированный объект вниз, оставив небольшой пробел, как показано на 

рисунке. 
 
 
 
 
 
 
 
 
 

Второй объект  
перетащен вниз с оставлением 

 небольшого пробела 
 
 
 
 
 

Совет: Для точного позиционирования удерживайте 
нажатыми клавиши Ctrl и Shift для перетаскивании 
вдоль оси X или Y. 

 
 
 
 
 
 
 
 
Создание второй стороны обрамления 
 

 
Щелкните по кнопке Mirror Horizontal (панель Edit), чтобы перевернуть объект 
по горизонтальной оси. 
 
 

 
Теперь мы возьмем созданную нами первую сторону обрамления монограммы, 
продублируем ее и перевернем по горизонтали. Подробнее см. в разделе Комбинирование 
объектов руководства пользователя. См. также раздел Перевод объектов в зеркальное 
отображение руководства пользователя. 
 
Совет: Почаще сохраняйте свою работу, чтобы не потерять свои изменения при сбое по 
питанию или системном сбое. См. также раздел Сохранение проектов. 
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Как создать вторую сторону обрамления 
 
1   Выберите Edit > Select All (Выделить все) или нажмите Ctrl + A. 

Будут выделены оба объекта. 
 
 
 

 
 
 
 
 

Щелкните правой кнопкой и перетащите 
 
 
 
 
 
 
 
2  Щелкните правой кнопкой и перетащите объекты в новое положение и отпустите кнопку. 

В этой точке будет создан дубликат бордюра. Подробнее см. в разделе Клонирование 
объектов руководства пользователя. 

 
Совет: Для точного позиционирования удерживайте нажатой клавишу Ctrl для 
перетаскивании вдоль оси X или Y.  
 
3   Щелкните по значку Horizontal Mirror (Зеркальное отображение по горизонтали). 
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Выбранные объекты будут перевернуты по горизонтали. 
 
 
 

Перевод в зеркальное отображение 
дублированных объектов 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4 Используйте клавиши со стрелками влево или вправо для "подталкивания" 

дублированного объекта в требуемое положение. 
5 Отмените выделение объектов, нажав клавишу Esc.  
 
 
Добавление текста к проекту 
 
Мы можем теперь вставить в монограмму буквы. Вы можете добавлять текст в проект, 
набирая его непосредственно в окне проекта или вводя его в диалоговом окне Lettering. 
 
Совет: Почаще сохраняйте свою работу, чтобы не потерять свои изменения при сбое по 
питанию или системном сбое. См. также раздел Сохранение проектов. 
 
 
Добавление букв 
 

 
Используйте инструмент Lettering (панель Digitize) для добавления текста 
непосредственно на экране. 
 

 
Мы будем добавлять буквы, набирая их непосредственно в окне проекта. Вначале при 
создании текста он может быть слишком большим или слишком малым. Размер текстового 
объекта может быть изменен различными способами: См. также Добавление текста к 
проектам вышивки в руководстве пользователя. 
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Как добавлять буквы 
 
1   Щелкните по кнопке Lettering (Текст). 
2 Щелкните по приблизительному центру проекта. Это то место, где мы хотим поместить 

наш текст. 
3 Наберите букву 'B'. 

На экране появится контур буквы. 
 

 
 
 
 
 
 
 
Щелкните и вставьте букву 
 
 
 
 
 
 
 
 
 
 

4   Нажмите Enter. 
Будут сгенерированы стежки, и вокруг буквы появятся метки – манипуляторы выделения. 

 
 
Изменение алфавита 
 
BERNINA Embroidery Software предоставляет несколько алфавитов, подходящих для многих 
применений. Выбор алфавита зависит от контекста, в котором используется текст. Для 
вышивания на дамской ночной рубашке вы можете использовать элегантный рукописный 
шрифт, например Anniversary. Подробнее см. в разделе Примеры алфавитов руководства 
пользователя. 
 
Примечание: Соблюдайте минимальные/максимальные рекомендации руководства 
пользователя для каждого алфавита. Для получения наилучших результатов не выходите за 
пределы этих рекомендаций. 
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Как изменить алфавит 
 
1   Дважды щелкните правой кнопкой по выбранному текстовому объекту.  

Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
 

 
 
 
 
 
 
 
 
 
 
Выберите Anniversary  
Введите 40 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2 Выберите алфавит Anniversary и введите 40 мм (1.57") в поле Height (Высота). 
 
3   Щелкните по Apply (Применить) для подтверждения и щелкните по OK, чтобы закрыть  
     окно.  
 

 
 
 
 
 
 
 
 
Буква увеличена, шрифт изменен,  
объект перемещен в центр 
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4 Перетащите мышью текстовый объект в центр проекта и используйте клавиши со 

стрелками, чтобы "подтолкнуть" его в требуемое положение. 
 
Настройка цвета ниток 
 
В этом месте мы почти закончили работу с монограммой. Но нам еще нужно изменить цвет 
ниток на несколько более нейтральный. Мы можем также добавить цвет в палитру цветов 
(Color Palette). 
 
Совет: Почаще сохраняйте свою работу, чтобы не потерять свои изменения при сбое по 
питанию или системном сбое. См. также раздел Сохранение проектов. 
 
Назначение цвета ниток 
 

 
Используйте инструмент Color (панель Stitch and Color) для выбора 
цвета ниток. 
 

 
Имеется много фирменных марок цветных ниток и в каждой марке имеется своя таблица 
цветов. Вы можете использовать предустановленную таблицу ниток или создать 
собственную. Для нашего упражнения мы используем таблицу ниток  Isacord 40 wt-numerical. 
См. также Цвета ниток и таблицы ниток в руководстве пользователя. 
 
Примечание: Вследствие различий в характеристиках мониторов и видеокарт компьютера 
цвета, отображаемые на экране, следует считать приблизительными. Нитки должны быть 
всегда подобраны по соответствующей физической цветовой карте. 
 
Как назначать цвета ниток 
 
1   Щелкните по кнопке Color (Цвет).  

Откроется окно Color Palette (Палитра цветов). 
 

 
Щелкните, чтобы открыть Color Palette. 

 
 
2   Щелкните по ссылке Thread Colors (Цвета ниток). 
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Откроется диалоговое окно Design Properties (Свойства проекта) с открытой вкладкой 
Thread Colors. На панели Threads in Design отображаются цвета, использованные в 
проекте. 

 
 

 
 
 
 
 
Все цвета  
в текущем 
проекте  

 
 
 
 
 
 
 
 
 
3   Из списка Thread Chart выберите  'Isacord 40 wt-numerical'. 
4   Выберите первый цвет проекта в списке Threads in Design. 
5   Выберите опцию Code и введите в поле Search '0771'.  
     Система ищет нитку и высвечивает ее в списке 
 
 
 

 
 
Выбрать  
цвет  
 
 
 
 
 
Выбрать  
Isacord 40 
wt-numerical 
 
 
 
 
Искомый цвет 
выделен 
 
 
 
 
                                           Введите код   Выделите, чтобы найти "Код" 

 
6   Щелкните по Assign или дважды щелкните по нитке 
     Выбранный цвет в списке Threads in Design заменен выделенным цветом нитки. 

 
7   Назначение следующих трех цветов в следующем порядке: 

◄ Цвет 2:  1141  
◄ Цвет 3:  1161  
◄ Цвет 4:  1252 

Щелкните,  
чтобы  
назначить 
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8 Щелкните по Apply (Применить) для подтверждения и щелкните по OK, чтобы  

закрыть окно.  
 

 
 
 
Буква увеличена, шрифт изменен,  
объект перемещен в центр 

 
 
 
 
 
 
 
Добавление цвета к проекту 
 

 
Используйте инструмент Color (панель Stitch and Color) для выбора цвета 
ниток. 
 

 
Вы можете добавлять цвета в таблицы ниток из других таблиц или самостоятельно 
смешанных цветов,  Мы добавляем другой цвет к палитре цветов, который мы применим к 
нашему текстовому объекту. См. также Создание пользовательской таблицы ниток в 
руководстве пользователя. 
 
Как добавить цвет к проекту 
 
1   Щедкните по кнопке Color (Цвет).  

Откроется окно Color Palette (Палитра цветов). 
 

 
Щелкните, чтобы открыть Color Palette. 
 
 

2   Щелкните по ссылке Thread Colors (Цвета ниток). 



Глава 6: Вступительное учебное пособие 
 

BERNINA Вышивальное программное обеспечение – Краткое справочное руководство 69

 
Откроется диалоговое окно Design Properties (Свойства проекта) с открытой вкладкой 
Thread Colors. На верхней панели Threads in Design отображаются цвета, 
использованные в проекте. 

 
 
Введите "5" в 
качестве номера 
нитки  
 
 
 
 
 
Выберите цвет 5 
 

 
 
 
 
 
 
Искомый цвет 
выделен 

 
 
 
 

Введите код   Выделите, чтобы найти "Код" 
 
 
3 В поле Threads in Design введите "5" в качестве номера нитки, используемой в проекте, и 

щелкните по Apply. 
 

4 Выберите снова добавляемый цвет "5". 
 

5 В поле Search (Поиск) введите '1565'. 
 Система ищет нитку и высвечивает ее в списке 

 
6  Щелкните по Assign или дважды щелкните по нитке 

 
Выбранный цвет в списке Threads in Design заменен выделенным цветом нитки. 
 

7 Щелкните по Apply (Применить) для подтверждения и щелкните по OK, чтобы закрыть 
окно.  Вновь назначенный цвет теперь появится в палитре цветов. 
 

Щелкните,  
чтобы  
назначить 
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8 Выделите текстовый объект и выберите "С5" в палитре цветов. 
 

 
 
 
Выберите "С5" 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Совет: Используйте режим Artistic View совместно фоном материала, чтобы увидеть, как 
будет выглядеть вышивка на выбранном материале. Подробнее см. в разделе 
Изменение фона. 

 
 
 
 

 
 
Завершение проекта 
 
Мы теперь почти завершили работу над проектом. Но вначале нам потребуется провести 
окончательную проверку свойств проекта, чтобы узнать, как будет выглядеть готовая 
вышивка. 
 
Совет: Почаще сохраняйте свою работу, чтобы не потерять свои изменения при сбое по 
питанию или системном сбое. См. также раздел Сохранение проектов. 



Глава 6: Вступительное учебное пособие 
 

BERNINA Вышивальное программное обеспечение – Краткое справочное руководство 71

 
Выполнение окончательной проверки 
 
В заключение мы проведем окончательную проверку, чтобы увидеть, каким будет проект 
после вышивания.  
 
 
Как выполнить окончательную проверку 
 
1   Выберите File > Design Properties. 

Откроется диалоговое окно Design Properties (Свойства проекта). Вкладка Design 
содержит информацию о высоте и ширине проекта, количестве стежков и цветов. Эти 
данные извлечены из проекта и не могут быть изменены. 
 

 
 
 
2    Просмотрите следующие данные: 

◄ Stitch count (Количество стежков): прибл. 19 600 стежков  
◄ Color changes (Количество остановок машины для замены цветной нитки):  16  
◄ Colors (Цвета):  5 

 
Примечание: Здесь указывается большое количество изменений цвета для проекта со 
всего пятью цветами. Если вы используете приложения BERNINA EditorPlus или 
BERNINA DesignerPlus, вы сможете изменить последовательность объектов и 
объединить цветные блоки, чтобы уменьшить количество остановок для замены цветных 
ниток. Подробнее см. в разделе Оптимизация цвета ниток  руководства 
пользователя.  
 

3 В режиме просмотра Embroidery Canvas, выберите View > Slow Redraw или нажмите 
Shift+R. 
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Откроется диалоговое окно Slow Redraw (Медленное перерисовывание) 
 

 
 

Регулировка скорости 
Щелкните для медленного перерисовывания 

 
 

4   Щелкните по кнопке Go. 
Проект будет вышиваться на машине точно в такой же последовательности, как 
показывается на экране. Подробнее см. в разделе Вывод проектов руководства 
пользователя. 

 
Совет: Окончательный вариант этого проекта находится в папке "Tutorials". Вы можете 
захотеть сравнить его с собственноручно составленным проектом. Окончательный 
проект с изменой последовательностью вышивания также находится в этой папке. 
 

 
 
Вывод проекта 

 
 
Используйте инструмент Print Preview (панель General) для просмотра 
проекта перед печатью. 
 
Используйте инструмент Write to Machine (панель General) для 
непосредственной передачи проекта в готовую для работы вышивальную 
машину BERNINA.  
 
Мы теперь можем вывести проект. Мы можем сделать это разными 

способами, включая распечатку или передачу в машину. Используйте функцию Print Preview 
для просмотра информации о вышивании. Проверьте, если это вам нужно, 
последовательность вышивания. Вы можете создать бумажную копию ваших проектов, 
используя стандартные или пользовательские настройки принтера. См. также раздел  
Вывод проектов  руководства пользователя. 
 
Как вывести проект 
 
1   Нажмите кнопку Print Preview (Предварительный просмотр). 
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Проект откроется в том виде, в котором он будет отпечатан. См. также раздел  
Распечатка проектов руководства пользователя. 
 

 
 
 
2 Измените опции принтера, щелкнув по кнопке Options. Подробнее см. в разделе 

Настройка опций печати вышивальных файлов руководства пользователя. 
 

Примечание: Большие проекты могут изображаться на нескольких страницах в случае их 
распечатки в фактическом размере. Используйте команды Next Page (Следующая 
страница), Previous Page (Предыдущая страница) или Two Pages (Две страницы) для 
просмотра нескольких страниц. 

 
3 Щелкните по Close, чтобы выйти из окна предварительного просмотра.  
 
4 Используйте функцию Write to Machine (Передать в машину) для непосредственной 

передачи проекта в готовую для работы вышивальную машину BERNINA.  Подробнее см. 
в разделе Вышивание проектов  руководства пользователя. См. также подробные 
указания в документации вашей вышивальной машины. 

 
Совет: Прибор Magic Box ("Волшебная шкатулка") позволяет конвертировать файлы, 
сохраненные в различных "не родных" форматах. Вы можете считать и редактировать 
проект с любой поддерживаемой вышивальной карты в программу BERNINA Embroidery 
Software. Свяжитесь со своим дилером или с OESD для информации об использовании 
вашего специфического прибора Magic Box с программами BERNINA Embroidery Software. 
Подробнее см. в разделе Сохранение проектов прибором Magic Box руководства 
пользователя. 
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Что делать дальше? 
 
Современная компьютерная вышивальная машина способна возбуждать и стимулировать 
творческие способности. Огромное разнообразие высококачественных вышивок, которые 
раньше выполнялись только на промышленных вышивальных машинах, теперь доступны 
для вышивания в домашних условиях. Программный пакет BERNINA Embroidery Software 
может обеспечить результаты, сопоставимые по качеству с лучшими образцами фирменных 
вышивок. 
 
◄ Ознакомьтесь с Введением в оцифровывание проектов вышивки, чтобы получить 

полное представление о возможностях BERNINA Embroidery Software. Подробнее см. в 
главе Введение в оцифровывание проектов вышивки в руководстве пользователя.  
 

◄ Для идентификации источников информации, имеющих отношение к вашей конкретной 
модели см. Список функций вышивального программного обеспечения BERNINA.  
 

 
◄ Чтобы получить представление о других справочных пособиях, требующихся для вас в 

зависимости от вашего конкретного уровня программного продукта, см. раздел 
Средства обучения пользованию вышивальным программным обеспечением 
BERNINA.  
 

◄ Наконец, вам весьма полезно ознакомиться с Кратким справочником. Подробнее см. в 
Кратком справочнике. 

 
Не забывайте, что превосходные результаты достигаются при выборе хорошего проекта, 
умении правильно оцифровывать и достаточных навыках работы на вышивальной машине. 
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ГЛАВА 7 
 

 
УЧЕБНОЕ ПОСОБИЕ ПО 

РЕДАКТИРОВАНИЮ 
------------------------------------------ 
 
 
 
В этом пособии вы ознакомитесь, как проверять 

проект и  находить не только действительные, но 

и потенциальные ошибки, которые могут 

повлиять на качество и внешний вид вышивки. Вы 

узнаете о методах обнаружения и корректировки 

ошибок, оптимизации проектов и ознакомитесь с 

мощными программными средствами BERNINA 

Embroidery Software, позволяющими выполнять 

эти задачи. Учебное пособие может быть 

пополнено программой BERNINA Editor Plus или 

BERNINA Designer Plus. 

 

 

Перед началом редактирования вам потребуется узнать, как просматривать проект и 

выделять объекты внутри проекта.  При пуске программы мы будем проверять отдельные 

объекты в проекте и вносить соответствующие изменения. Затем мы просмотрим цвета 

ниток и последовательность вышивания, проверим и выберем возможность оптимизировать 

проект. К концу этой главы вы освоите некоторые из основных приемов редактирования 

проекта, которые позволят улучшить внешний вид вышивки повысить ее качество с 

использованием всех функций вашей машины. 

 
Примечание: Здесь описаны все шаги, требуемые для создания проекта. Однако для 

более полной информации требуется обратиться к руководству пользователя. 
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Первые шаги 
 

В этом учебном руководстве мы возьмем существующий проект и изменим его размеры для 

подгонки к нагрудному карману. Оригинальный проект был создан для вышивки на светлой 

ткани. Мы изменим его для вышивания на плотной джинсовой ткани. Для наших упражнений 

мы используем один из проектов, входящих в коллекцию программного обеспечения. 

 

Совет: В ваш программный пакет BERNINA Embroidery Software включена коллекция 

оригиналов и вышивок, которые вы можете использовать для создания первых собственных 

проектов. В дополнение к коллекции образцов проектов вы найдете папку "Tutorials", 

которая содержит все файлы дополнений к этому и другим учебным пособиям. Конечный 

результат этого и других проектов также находится в этой папке. Вы можете захотеть 

просмотреть файл завершенного проекта до и/или после ознакомления с учебным 

пособием. См. также раздел Работа с файлами проектов. 
 

Как начать работу 
 

1 Дважды щелкните мышью по ярлыку BERNINA Embroidery Software на рабочем столе MS 

Windows®. 

 Откроется окно BERNINA Embroidery Software с новым чистым проектом (Design 1) и 

выбранными по умолчанию пяльцами. 

2  Щелкните по кнопке Open (Открыть). Откроется диалоговое окно Open. 

 
 
 
Панель 
просмотра 
 
 
 
Сведения о 
проекте 
 
 
 
 
Просмотр 
вкл./выкл. 
 
 
 

 
3 Выберите папку ..\My Designs\Tutorials\Editing из списка Look In. 

4 Выберите файл 'Editing_Start.Art60' и щелкните по Open. Проект будет открыт в окне 

проекта. 
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5 Дважды щелкните по объекту (или щелкните правой кнопкой), чтобы открыть диалоговое 

окно Object Properties, и выберите закладку General. 
 

 
Введите размеры в виде абсолютных или процентных величин 

 

 

 

 Примечание: По умолчанию проекты автоматически группируются при открытии или 

вставке в другой проект. Подробнее см. в разделе Настройка других общих опций. 
6 Введите '65' в окошки процентных значений ширины (Width) и/или высоты (Height). 

Текущие размеры проекта изменятся до нужных нам примерно до 97 x 94 мм. 

7 Щелкните ОК.  
 Весь проект уменьшится до 65 % оригинальной величины.  

8 Щелкните правой кнопкой мыши по значку Show Hoop (Показать пяльцы).  
Появится диалоговое окно Options > Hoop.  

 
 

 

Выберите artista 130x100 
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9 Выберите из списка Hoop пяльцы 'artista 130 x 100' и щелкните по OK. 
 

 

 

 

 

 

 

 
Пяльцы artista 130x100 

 

 

 

 

 

 

 

 

 

10  Увеличьте изображение, чтобы лучше видеть пяльцы – выберите инструмент Zoom Box 

и щелкните по проекту правой кнопкой мыши.  

 

 Совет: Если вы уже выбрали пяльцы, вы можете отображать или скрывать их, щелкая 

по кнопке Show Hoop. 

11 Выберите File (Файл)> Save As (Сохранить как …).  
Откроется диалоговое окно Save As. 

 



Глава 7: Учебное пособие по редактированию 
 
 

 
 

BERNINA Вышивальное программное обеспечение – Краткое справочное руководство 79

Совет: В диалоговом окне Save As открывается та же папка, в которой сохраняется  

оригинальный файл. 

12 В поле File name введите подходящее имя, например 'EditingTutorial'. 

13 Щелкните по кнопке Save (Сохранить). 
 

 Совет: Впоследствии для сохранения любых изменений вам потребуется щелкнуть по 

кнопке Save или нажать клавиши Ctrl+S. 
 

Проверка проекта 
 
С помощью кнопки просмотра вида вышивки (Show Artistic View) на общей 
панели инструментов (General toolbar) можно включать/выключать просмотр 
вида вышивки. 
 

Вначале нам потребуется провести визуальную проверку и просмотреть свойства проекта. 

В ходе такой проверки можно устранить большинство ошибок. При оцифровывании или 

редактировании проекта нам нужно иметь в виду, что все вводимые вами команды должны 

выполняться вышивальной машиной. 

 

Как проверять проект 
 

1 Щелкните по значку Show Artistic View, чтобы просмотреть проект в реалистичном виде. 

 Проект отображается более реалистично, чем в режиме Stitch View, поэтому в общем 

случае в этом режиме редактировать проект более удобно. 

 
          в режиме Stitch View                                               в режиме Artistic View  
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2 Увеличьте изображение дельфина, особенно брюшко и спинной плавник, используя 

инструмент масштабирования или обзорное окно, чтобы детальнее рассмотреть 

контуры. Подробнее см. в разделе Изменение масштаба и панорамирование. 
 Обратите внимание, что контуры не совпадают с подстилающими стежками заполнения. 

 
                                                               Контуры не совпадают с заполнением 

 

 Совет: Текущий масштабный коэффициент показывается в нижнем правом углу экрана. 

3 Выберите File > Design Properties. 

 Откроется диалоговое окно Design Properties > Design. В нем содержатся сведения о 

проекте, таки как высота, ширина, количество стежков и цвета. Эти данные не могут 

быть изменены. 

 
В этом проекте не только слишком большое количество стежков, но и количество цветов и 

соответственно замен ниток представляется также слишком большим. Мы теперь 

рассмотрим способы уменьшения этих параметров, что, в свою очередь, улучшит 

производительность и качество вышивания. 

Щелкните, чтобы 
активировать 
функцию 
масштабирования 
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4 Щелкните по вкладке Thread Colors (Цвета ниток). 
 

Введите 13 для  

удаления  

неиспользуемых  

цветов  

из списка ниток                                                                                                                        

Щелкните,  

      чтобы                 

      расширить  

      список ниток 

 

 

 

 

5 Введите '13' в поле Threads In Design, чтобы удалить из списка неиспользуемые цвета, 

и щелкните по Apply.  
 Неиспользуемые цвета будут удалены из таблицы. Обратите внимание, что некоторые 

цвета мало отличаются друг от друга. Имеется возможность просмотреть, как будет 

выглядеть проект, если вы используете один и тот же цвет для нескольких объектов, 

чтобы уменьшить общее количество цветов и цветных ниток. 

6 Щелкните по OK, чтобы закрыть окно. 

7 В режиме просмотра Stitch View, выберите View > Slow Redraw или нажмите клавиши 

Shift+R. Подробнее см. в разделе  

Просмотр всей последовательности вышивания. 
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Откроется диалоговое окно Slow Redraw  

 
 

8 Используйте ползунок для установки скорости перерисовывания. 

9  Щелкните по кнопке Play. 

 Проект будет перерисоваться на экране в соответствии с последовательностью 

вышивания. Поскольку функция Slow Redraw имитирует движение вышивальной 

машины, вы имеете возможность оптимизировать свой проект, чтобы снизить нагрузку 

на машину. Обратите внимание на следующие проблемы: 

◄ Некоторые контуры дельфина могут не совпадать с соответствующими зонами 

заполнения. 

◄ Может потребоваться настроить интервал между буквами текста.  

◄ Тест расположен слишком далеко от остальных объектов проекта. 

Регулировка 
скорости 

Щелкните для 
медленного 
перерисовывания 
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10 Щелкните по кнопке Color Film. Подробнее см. в разделе  

Просмотр и выделение цветных блоков. 
           Щелкайте, чтобы переключаться  

между цветными блоками и объектами                                    Индивидуальные объекты 

 
            Цветные блоки 

 

Функция Color Film показывает изменения цвета и индивидуальные объекты в порядке 

вышивания. Количество цветов и операций по замене ниток можно в значительной мере 

сократить. Например, цвета 2 и 3 почти одинаковы, как и цвета 1 и 12. Если мы используем 

в обеих парах один цвет, то общее количество цветных ниток сократится.  

 

Оптимизация цветов ниток 
 

При проверке свойств проекта мы заметим, что в нашем проекте некоторые фрагменты 

должны быть вышиты нитками почти одинакового цвета. Имеется возможность ограничить 

количество цветов до приемлемого предела, не ухудшая качество вышивки. Но вначале мы 

должны определить, на какой ткани мы будем вышивать. 

 

Совет: Почаще сохраняйте свою работу, чтобы не потерять свои изменения при сбое по 

питанию или системном сбое. См. также раздел Сохранение проектов. 
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Как оптимизировать цвета ниток 
1 Выберите проект, если он еще не выбран. 

2  Выберите Settings (Настройки) > Fabric Settings(Настройки ткани).  
 Откроется диалоговое окно Fabric Settings. 

 
 

 

Выберите тип ткани 

 

Выберите для 

использования стандартных 

настроек 

 

 

 

3  Выберите 'Woven Heavy Weight' (Плотная ткань) из списка Fabric Type (Тип ткани). 
4 Примите стандартные настройки и щелкните по OK. 
 Настройки стежков подбираются согласно выбранному типу ткани. Мы выбрали 

джинсовую ткань. 

5 Выберите проект, если он еще не выбран. 

6 Щелкните по Arrange > Ungroup или нажмите клавиши Ctrl+U, чтобы разгруппировать 

проект. 

7  Щелкните по кнопке Color Film. 
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Откроется панель Color Film, отображающая все цветные блоки в проекте в порядке 

последовательности вышивания. 

 

 

 

 
В проекте  

имеется несколько  

почти одинаковых 

цветов 

 

 

 

 

 

 

 

 

 

8  Выберите цветной блок 3 на панели Color Film и, удерживания клавишу Ctrl, щелкните по 

цветному блоку 11, чтобы выделить оба блока. 

 Эти блоки относятся к брюшку дельфина и заполнению маленьких рыбок. 

9  Щелкните по значку Color на панели Stitch and Color и выберите С2 на цветовой 

палитре. 



Глава 7: Учебное пособие по редактированию 
 
 

 
 

BERNINA Вышивальное программное обеспечение – Краткое справочное руководство 86

 

 Цветные блоки 3 и 11 примут теперь тот же цвет, что и блок 2, благодаря чему 

количество цветных ниток уменьшится на 2. 
 

 

 

 

Цветной блок 3 

 

 

 

 

 

 

 

 

Цветной блок 11 

 

 

 

 

                                                                            Выберите С2 на цветовой палитре 
10  Таким же способом измените следующие цвета ниток:  

◄ Цветного блока 13 (текстовый объект) на С10.  

◄ Цветного блока 1 (светлые волны) на С12. 

 
Количество  

цветов все еще 

 остается слишком  

большим 

 

 

 

 

 

 

 

 

 

 

 

11 Щелкните по кнопке Color Film. 
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Откроется панель Color Film, отображающая все цветные блоки в проекте в порядке 

последовательности вышивания. 

 
                                                                                           Количество цветов уменьшено 

12  Перетащите мышью второй цветной блок 2 на верх первого. Подробнее см. в разделе 

Назначение последовательности объектов инструментом Color Film. 
 

 Совет: Вы можете также использовать инструменты Sequence to Start (Переместить в 
начало последовательности) и Sequence to End (Переместить в конец 
последовательности) в верхней части панели Color Film. 

13 Повторите эти шаги для блоков 8, 10 и 12. 

 Вы должны получить в итого короткий список цветов, как показано справа. Количество 

замен цветных ниток сокращено без заметного ухудшения качества вышивки. 

14 Откройте панель Color Film и щелкните по значку Show Individual Objects (Показать 
индивидуальные объекты). 

 Откроется панель Color Film, отображающая все индивидуальное объекты проекта в 

порядке последовательности вышивания. 
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15 Выберите "нижнюю волну" на экране или на панели Color Film. 

  
                                                                    Щелкните, чтобы переместить вверх 

 
16 Щелкните по значку Sequence to Start. 
 Выделенный волнистый объект переместится вверх. 

17 Выберите и последовательно перетащите вверх остальные объекты волн в правильной 

последовательности вышивания. 

  
18  Выберите Settings (Настройки) > Thread Colors (Цвета ниток). 
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 Откроется диалоговое окно Design Properties (Свойства проекта > Thread Colors 
(Цвета ниток). 

 
 

 

 

 

 

Выберите нитку  

для изменения 

 

Щелкните, 
чтобы подобрать 
 
Щелкните, 
чтобы назначить 
 

 

 

 

19  Выберите цвет 7 и щелкните по кнопке Match. 
 Наиболее подходящая нитка высветится в верхней части списка цветных ниток. 

Подробнее см. в разделе Подбор и выбор ниток. 
 

 Совет: Если вы знаете точное название или код нитки, найдите и выберите ее. 

Подробнее см. в разделе Поиск и выбор ниток. 
20 Выберите более темную нитку (попробуйте Apricot) и дважды щелкните или щелкните по 

кнопке Assign. 
 Выбранный цвет в списке Threads in Design заменен новым цветом. 

21  Щелкните по Apply для подтверждения и по OK, чтобы закрыть окно.  
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Редактирование объектов проекта 

 

После исправления "крупных" дефектов проекта мы можем приступить к просмотру и 

улучшению деталей. В частности, мы можем изменять типы стежков набольших объектов, 

чтобы они были лучше вышиты. В то же время можно скорректировать контуры объектов, 

если заметим, что они не совпадают со стежками заполнения. Благодаря этому будет 

улучшен внешний вид готовой вышивки. 

 

Совет: Почаще сохраняйте свою работу, чтобы не потерять свои изменения при сбое по 

питанию или системном сбое. См. также раздел Сохранение проектов. 
 

Как редактировать объекты проекта 
 

1 Выберите View > Measure или нажмите клавишу M. 

2  Измерьте высоту маленькой рыбки. Подробнее см. в разделе  

Измерение расстояний на экране. 
 Обратите внимание, что высота рыбки меньше 6 мм, что достаточно для гладьевого 

стежка. 

 

 

 
Указатель мыши изменится, появится всплывающая подсказка с 

результатом измерения 

 

 

 

3 Увеличьте изображение и выберите брюшко дельфина, затем, удерживая клавишу Ctrl, 
выделите: 

◄  белые полосы и плавники большой оранжевой рыбки, 

◄  заполнение маленьких рыбок и 
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◄  заполнение пузырьков. 

 
 

 

 

 

 

 

 

 

 

 

 

Выберите Satin 

 

4 На панели Stitch and Color Bar, щелкните по значку Fill и выберите Satin (гладьевый 

стежок). Гладьевый стежок будет применен к выделенным объектам с текущими 

настройками. 

 

 
 

 

 

 

Применен гладьевый стежок 

 

 

 

 

 

 

5 Отмените выделение объекта, нажав клавишу Esc.  
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6 Дважды щелкните по брюшку дельфина (или щелкните правой кнопкой), чтобы открыть 

диалоговое окно Object Properties, и выберите закладку General. 

 
Применение к брюшку дельфина специального гладьевого стежка 

7 Выберите Satin Special (Специальный гладьевый стежок) на панели Satin Type и 

щелкните по Apply. 
 В то время как стежок Satin Special используется главным образом для предотвращения 

формирования слишком длинных стежков в широких формах, он может также 

использоваться как альтернатива заполнения простегивающим стежком. Стежки Satin 

Special выглядят в большей мере "атласными" и хорошо подходят для образования 

мягких линий и меньшей глубины заполнения. Подробнее см. в разделе  

Разбивка длинных стежков гладьевого заполнения. 
8 Выберите контур правого плавника дельфина и щелкните по значку Reshape Object 

(Изменение формы объекта).  
 Измените расположение узлов, появившихся на контуре. 

 
 

Передвиньте к плавнику 

 

 

 

Измените в точки кривой и  

передвиньте 

 

 

Удалите ненужные узлы 

 изменения формы 

 

 

9 Отредактируйте узлы изменения формы, перетаскивая их мышью, удалением и/или 

изменением типа узлов и нажмите клавишу Enter для принятия изменений. Подробнее 

см. в разделе Изменение формы объектов с использованием узлов изменения формы. 
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 Совет: Перетаскивайте и изменяйте форму узлов, пока они слегка не перекроют 
заполнение, чтобы контур располагался перпендикулярно углу стежков заполнения – это 
рекомендуется в случае склонности ткани к растягиванию с отходом заполнения от 
контура. 

 
10 Переключитесь в режим Artistic View, чтобы было более удобно рассмотреть всю 

вышивку, сделайте это же для брюшка дельфина. Подробнее см. в разделе  

Режимы просмотра. 

 
Измените в точки кривой                 Передвиньте к плавнику 

и передвиньте 

 

 

 Совет: Для редактирования следующего в последовательности объекта нажмите 

клавишу Tab. Для редактирования предыдущего объекта нажимайте Shift+Tab. 
Подробнее см. в разделе Изменение формы следующего или предыдущего 

объекта. 
 

Подгонка интервала между буквами 
 
 Щелкните по значку Reshape Object (панель Design), чтобы изменить интервал между  

 буквами. 

 

Обратите внимание, что интервалы между буквами в слове 'Friends' нуждаются в 

корректировке – расстояние между ‘F’ и ‘R’ и ‘R’ и ‘I’ слишком большое. Даже при 

автоматической настройке (кернинге) может потребоваться изменять расстояние между 

буквами вручную. Подробнее см. в разделе Настройка интервалов. 
 

Как подгонять интервалы между буквами 
 

1 Щелчком выделите текстовый объект. 
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2 Щелкните по кнопке Reshape Object (Изменение формы объекта). 

 
3 Щелкните правой кнопкой по ромбовидной контрольной точке буквы  ‘r’ и перетащите ее 

к букве ‘F’, отпустите кнопку, когда интервал станет достаточно малым. Все буквы до 

конца строки перемещаются одновременно. Подробнее см. в разделе  

Подгонка на экране индивидуальных интервалов между буквами.  
 

 

 

 
Перетащите правой  

кнопкой ромбовидную  

контрольную точку 

 

 

 

4 Повторите эту же операцию для буквы ‘i’. 

5 Нажмите Esc для выхода из режима Reshape Object. 
6 Выделите текстовый объект и перетащите его ближе к другим объектам. 
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Завершение проекта 
 

Мы уже почти завершили работу над проектом, но еще остались отдельные детали, на 

которые следует обратить внимание. Во-первых, нужно проверить точки входа и выхода 

определенных объектов, чтобы убедиться, что они расположены правильно. Мы должны 

также провести окончательную проверку свойств проекта, как мы делали это в начале 

процесса, а также просмотреть, как будет выглядеть вышивка на фоне ткани, чтобы 

получить возможность улучшить проект. 

 

Совет: Почаще сохраняйте свою работу, чтобы не потерять свои изменения при сбое по 

питанию или системном сбое. См. также раздел Сохранение проектов. 

 

Как завершить работу над проектом 
 

1 Выберите первую (самую нижнюю) "волну" и щелкните по значку Reshape Object. 

 
   Точка выхода                                                     Точка входа 

 

2 Перетащите мышью точки входа (ромбики) и точки выхода (крестики) в соответствии с 

показанной выше компоновкой. 

3 Для перехода к следующему объекту, нажимайте клавишу Tab. Для изменения формы 

предыдущего объекта нажимайте Shift+Tab. 

4 Нажмите Enter, чтобы принять изменения и клавишу Esc для окончания.  

5 Повторите эти же операции для оставшихся волновых объектов. 

 

 Совет: Используйте команду Start and End (Начало и Конец), чтобы установить 

положение первого и конечного стежков всего проекта. Это облегчит позиционирование 

иглы перед вышиванием и предотвратит возможность выхода иглы за пределы пялец. 

Подробнее см. в разделе Автоматическая настройка начальных и конечных точек. 

6 Щелкните правой кнопкой по значку Auto Underlay (Автоматическая стабилизация 
ткани).  
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Откроется диалоговое окно Effects > Underlay. 

 

 

 
Выберите первый тип  

стабилизирующего стежка  

 

 

 

Выберите второй тип  

стабилизирующего стежка  

 

 
 

 Примечание: Тип стабилизации, который вы должны выбрать, определяется его 
назначением. Не все типы стабилизирующих стежков применимы для всех выбранных 
объектов. По умолчанию принимается  шаг стежка 3.00 мм. Поскольку размеры нашего 
проекта меньше средних, плотность стежков слишком большая. Мы скорректируем эту 
настройку. 

7 Выберите брюшко дельфина. 

8  Проставьте флажок в окошке Apply Underlay 1  и выберите из списка Edge Walk в 

качестве типа стабилизирующих стежков. 

 Как только вы выберете опцию Apply Underlay 1, становится активным окошко опции 

Apply Underlay 2.  Все типы стабилизирующих стежков, доступные для Underlay 1, 

доступны также и для Underlay 2.  

9 Проставьте флажок в окошке Apply Underlay 2  и выберите из списка Step в качестве 

типа стабилизирующих стежков. 

10 Примените Stitch Spacing (Шаг стежка) по умолчанию. 

11 Щелкните по Apply, чтобы принять изменения. 

12  Повторите эту операцию для остальных объектов проекта согласно установкам, 

показанным в таблице: 

 

Объект  Underlay 1  Underlay 2  Stitch Spacing 
(Шаг стежка) 

Брюшко дельфина Edge Walk  Step  3 мм 

Спинной плавник дельфина Edge Walk  Step  4 мм 

Передний корал Edge Walk  Step  4 мм  

Большой задний коралл Edge Walk  Step  4 мм 

Малый задний коралл Edge Walk  нет Нет выбора 

Тело рыбы Edge Walk  Step  4 мм 
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Объект  Underlay 1 Underlay 2  Stitch Spacing 
(Шаг стежка) 

Передние плавники рыбы Edge Walk Step  4 мм 

Белые атласные полосы рыбы Edge Walk  Zigzag *  По умолчанию 

Атласные спинной и брюшной 

плавники рыбы 

Edge Walk нет Нет выбора 

Маленькие рыбки и пузыри Edge Walk нет Нет выбора 

Текст Zigzag нет Нет выбора 

* Использование зигзага (Zigzag) вместо простегивающего стежка 

(Step) дает более рельефную структуру  

 

 

13 Выберите File > Design Properties. 

 Откроется диалоговое окно Design Properties > Design. Здесь содержится информация 

о высоте и ширине проекта, количестве стежков и цветов. Эти данные не могут быть 

изменены. 

 
 

14 Просмотрите следующие данные: 

◄ Stitch count (Количество стежков): прибл. 11.100 стежков.  

◄ Color changes (Количество остановок машины для замены цветной нитки):  8 замен. 

(Оригинальный проект содержит 13 замен.)  

◄ Colors (Цвета):  9 цветов. (Оригинальный проект содержит 13 цветов.) 

 

 Примечание: Благодаря этим сокращениям значительно сократилась 

продолжительность вышивания и улучшилось качество вышивки.  

15 Щелкните по кнопке OK, чтобы закрыть диалоговое окно. 

16 Выберите View > Slow Redraw или нажмите Shift+R в режиме Stitch View.   
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Откроется диалоговое окно Slow Redraw (Медленное перерисовывание). 

                                                                                                       Регулировка скорости 

 
                                                                                                         Щелкните для медленного  

                                                                                                                      перерисовывания 
17 Щелкните по кнопке Go. 

 Проект будет вышиваться на машине точно в такой же последовательности, как 

показывается на экране. Подробнее см. в разделе Вышивание проектов. 

 

 Совет: Окончательный вариант этого проекта находится в папке "Tutorials". Вы можете 

захотеть сравнить его с собственноручно составленным проектом. 

 Выберите Settings (Настройки) > Fabric Display (Отображение ткани). Откроется 

диалоговое окно Fabric Display. 
 
 

 

Выбор цвета фона  

или ткани  

Щелкните по  

кнопке Browse  

 

 

 

19 Выберите кнопку Fabric и щелкните по Browse (Обзор). 
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 Откроется диалоговое окно Load Picture (Загрузка рисунка). Все рисунки тканей 

находятся в папке .....\Program Files\BERNINA\Embroidery Software6\Fabrics. 

 

 
 

 

Выберите 

Denim 

 

 

 

 

 

 

 

 

20 Выберите 'Denim' (джинсовая ткань) из папки "fabrics" и щелкните по Open. 

21 Щелкните по OK, чтобы закрыть диалоговое окно Fabric Display и принять выбранный 

фон. 

 
 

22 Сохраните свой проект. См. также раздел Сохранение проектов. 

23 Щелкните по кнопке Print Preview (Предварительный просмотр). 
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Проект откроется в том виде, в котором он будет отпечатан. См. также Печать проектов. 

 
24  Измените опции принтера, щелкнув по кнопке Options. Подробнее см. в разделе 

Настройка опций печати вышивальных файлов. 
 

 Примечание: Большие проекты могут изображаться на нескольких страницах в случае 

их распечатки в фактическом размере. Используйте команды Next Page (Следующая 
страница), Previous Page (Предыдущая страница) или Two Pages (Две страницы) 
для просмотра нескольких страниц. 

25 Щелкните по Close, чтобы выйти из окна предварительного просмотра.  

26 Используйте функцию Write to Machine (Передать в машину) для непосредственной 

передачи проекта в готовую для работы вышивальную машину BERNINA.  Подробнее 

см. в разделе Вышивание проектов. См. также подробные указания в документации 

вашей вышивальной машины. 
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ГЛАВА 8 
 

 
УЧЕБНОЕ ПОСОБИЕ ПО 
АВТОМАТИЧЕСКОМУ 

ОЦИФРОВАНИЮ 
------------------------------------------ 
 
 
 
 
 
 
Программа BERNINA Embroidery Software позволяет легко 
и быстро создавать вышивки по различным видам 
оригиналов. Можно использовать сканированные 
изображения, графические файлы, растровые 
изображения. Программа Auto Digitizer распознает формы 
оригинала и самостоятельно принимает решения о 
применении наиболее подходящих типов стежков. Также 
определяется последовательность вышивания на основе 
соединения. 
В этом пособии вы сможете узнать, не только как 
автоматически оцифровывать проект, но также как 
улучшать автоматически созданные вышивки. Вы узнаете 
также, как проверять и изменять последовательность 
вышивания для оптимизации процесса вышивания. 
Учебное пособие может быть пополнено программой 
BERNINA Editor Plus или BERNINA Designer Plus. 
 
Примечание: Здесь описаны все шаги, требуемые для создания проекта. Однако для более 
полной информации требуется обратиться к экранному руководству. 
 
Первые шаги 
 
Для целей этого пособия мы используем проект, подходящий по размерам  120 x 120 мм для 
кармана на переднике. Вышивка должна быть выполнена на хлопко-полиэфирной ткани 
средней плотности. 
 

Для загрузки, редактирования и сохранения рисунков в качестве фона для 
вышивок, используйте режим Art Canvas.  
 

  
Используйте режим Art Canvas  для обработки рисунка для                                     
автоматического  оцифровывания. 
 

 
 Используйте функцию Load Picture (меню Picture) для загрузки изображения в качестве 
оцифровываемого  трафарета. 
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Если мы используем какой-то оригинал, нам нужно подогнать его размеры к размерам 
кармана, имея в виду, что со всех сторон должны оставаться поля шириной не меньше 10 мм. 
Затем нам нужно найти подходящие пяльцы. Для наших упражнений мы используем один из 
проектов, входящих в коллекцию программного обеспечения. 
 
Совет: В ваш программный пакет BERNINA Embroidery Software включена коллекция 
оригиналов и вышивок, которые вы можете использовать для создания первых собственных 
проектов. В дополнение к коллекции образцов проектов вы найдете папку "Tutorials", которая 
содержит все файлы дополнений к этому и другим учебным пособиям. Конечный результат 
этого и других проектов также находится в этой папке. Вы можете захотеть просмотреть файл 
завершенного проекта до и/или после ознакомления с учебным пособием. См. также раздел 
Работа с файлами проектов. 
 
Как начать работу 
 
1 Дважды щелкните мышью по ярлыку BERNINA Embroidery Software на рабочем столе MS 

Windows®. 
 Откроется окно BERNINA Embroidery Software с новым чистым проектом (Design 1) и 

выбранными по умолчанию пяльцами. 
 

2 В режиме Art Canvas щелкните по значку Load Picture (Загрузить изображение).  
 Откроется диалоговое окно Import. 
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Выбрать папку  
 

 
 

Выбрать нужный формат 
 

 
3  Выберите папку ..\My Designs\Tutorials\AutoDigitizing из списка Look In. 

 
4 В поле Files of type выберите All Picture Files, чтобы просмотреть все файлы с 

изображениями в этой папке.  
 

5 Выберите файл AutoDigitizing_Start.BMP. 
 
6   Щелкните по Import и нажмите на ENTER, чтобы размещать импортированное 

изображению по центру пялец.   
 Изображение откроется в окне Design Window. 

 
Введите размеры в виде абсолютных или процентных величин 
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7 Убедитесь в том, что функция Proportional Sizing включена. В поле Width (Ширина) (Х) 

введите 98 мм и нажмите на Enter.   
Ширина должна быть равной 98 мм, а высота 80.4 мм. 
 

8 Переключите в режим Embroidery Canvas и нажмите клавишу Esc для отмены выделения. 
 

9 Выберите Settings (Настройки) > Fabric Settings(Настройки ткани).  
Откроется диалоговое окно Fabric Settings. 

 
 
 
 
Выберите тип ткани 
 
Выберите для использования стандартных 
настроек 
 
 
 
 
 
 
 

10 В выпадающем списке Fabric Type (Тип ткани) выберите 'Woven Heavy Weight' (Плотная 
ткань).  
 

11 Примите стандартные настройки и щелкните по OK. 
 Эти настройки ткани будут применены ко всем вновь создаваемым объектам проекта. 

 
12 Щелкните правой кнопкой мыши по значку Show Hoop (Показать пяльцы).  

Появится диалоговое окно Options > Hoop.  
 

 
 
 
 
 
Выберите artista 130x100 
 
 
 
 
 
 
 
 
 

 
13 Выберите из списка Hoop пяльцы "artista 130 x 100". 
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14 Щелкните по ОК. 
 

 
 
 
 
 
 
 

Пяльцы artista 130x100  
 
 
 
 
 
 
 
 
 
15 Увеличьте изображение, чтобы лучше видеть пяльцы – выберите инструмент Zoom Box и 

щелкните по проекту правой кнопкой мыши.  
 

 Если Вы выбрали пяльцы, Вы можете показать или скрыть их нажатием по кнопке Show 
Hoop.  

 
 
16 Выберите File (Файл)> Save As (Сохранить как …).  

Откроется диалоговое окно Save As. 

 
 Совет: В диалоговом окне Save As открывается то же место, в котором сохранен 

оригинальный файл. 
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17  В поле File name введите подходящее имя, например 'AutoDigitizingTutorial'. 

 
18 Щелкните по кнопке Save (Сохранить). 
 
 Совет: Впоследствии для сохранения любых изменений вам потребуется щелкнуть по 

кнопке Save или нажать клавиши Ctrl+S. 
 
 
 
Обработка проекта 

 
Используйте инструмент Image Preparation (панель Edit), чтобы повысить четкость контуров и 
уменьшить шум в оконтуренном изображении. 

 
Используйте инструмент Auto Digitizer для создания проектов вышивки 
непосредственно по импортированному изображению. 
 

Теперь, когда у нас имеются измененное по размеру изображение и выбранные пяльцы, мы 
можем приступить к оцифровыванию проекта. Но вначале нам нужно подготовить проект к 
автоматическому оцифровыванию. 
 
Как подготовить проект 
 
1 В режиме Embroidery Canvas выберите изображение. 
2 Щелкните по значку Image Preparation (Подготовка изображения). 
 Откроется диалоговое окно Image Preparation с изображением в панели просмотра. 
 

Проверьте число цветов в  
изображении 

 

 
 

Введите "9" 
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3 Обратите внимание, что для изображения можно использовать 9 цветов, а программа 

рекомендует сократить их число до 6.  Поскольку мы не хотим сократить количество 
цветов, введем цифру "9" в поле Reduce to (Сократить до).   

 
4 Щелкните по ОК. 
 Изображение теперь готово для автоматического оцифровывания. 
 
5 Щелкните по значку Auto Digitizer и щелкните по изображению согласно подсказке. 
 Откроется диалоговое окно Auto Digitizer. В верхней части окна появляется информация 

об изображении, включая размеры по высоте и ширине и количество цветов в 
изображения. 

 
 
 
Размеры проекта 
 
Количество цветных 
ниток 
 
Выберите Auto для 
типа стежков 
заполнения 
 
 
Пропустить белый фон 
 

 
 
6 В выпадающем списке Fills (Заполнение) выберите Auto. 
 Это означает, что программа автоматически выберет типы стежков для заполнения. После 

обработки могут быть проведены изменения. 
 
7 Щелкните по кнопке  Omitted Colors (Пропустить цвета), 
 В диалоговом окне отображаются цвета изображения. Вы можете выбрать цвета, 

исключаемые из процесса обработки. 
 
8 Выберите для пропуска блок белого цвета и щелкните по OK.  
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Программа Auto Digitizer преобразует изображение в объекты вышивки и сгенерирует 
стежки. Программа попытается подобрать цвета из текущей (стандартной) палитры. На 
следующем этапе мы проведем изменения. 

 
 

 
 

Пропущен белый фон 
 
 
 
 
 
 
 
 
 
 
 
 
 
Окончательная правка проекта 
 
Проверка проекта 

 
С помощью кнопки просмотра вида вышивки (Show Artistic View) на общей 
панели инструментов (General toolbar) можно включать/выключать просмотр 
вида вышивки. 
 
Используйте функцию показа рисунка Show Picture (общая панель 
инструментов General), чтобы  включать/отключать показ оригинала рисунка. 
 
 
Щелкните по кнопке Color Film (панель General), чтобы просмотреть все 
цветные блоки и объекты в проекте. 
 
Используйте инструмент Magic Wand для оцифровывания форм                                    
изображения. 

 
Все объекты вышивки проекта, кроме шейного кольца и корпуса утки, уже автоматически 
сгенерированы. Мы проведем теперь правку проекта, чтобы улучшить внешний вид и 
оптимизировать процесс вышивания. 
 
Совет: Почаще сохраняйте свою работу, чтобы не потерять свои изменения при сбое по 
питанию или системном сбое. См. также раздел Сохранение проектов. 
 
Как провести окончательную правку проект 
 
1 Переключитесь в режим Artistic View и щелкните по проекту. 

 
2 Нажмите 0 (нуль) на цифровой клавиатуре, чтобы просмотреть проект на полном экране. 
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3  Щелкните по кнопке Show Pictures, чтобы скрыть оригинальное изображение и более 

четко видеть сгенерированные стежки. 
 
 

Небольшие объекты автоматически 
заполняются гладьевым стежком 

 
 
 

Крупные объекты автоматически 
заполняются простегивающим стежком 

 
Для белых объектов – корпуса и шеи – 
стежки не сгенерированы 

 
 
 
 
  

Примечание: Поскольку из операции автоматического оцифровывания мы исключили 
белый фон, для корпуса или шеи вышивальные объекты не сгенерированы. Для их 
создания мы используем инструмент Magic Wand (Волшебная палочка). 
 
4 Нажмите клавиши Shift-R для вызова функции Slow Redraw (Медленное 

перерисовывание) и щелкните по кнопке Go. Подробнее см. в разделе  
Просмотр всей последовательности вышивания. 

 
Регулировка скорости 

 
 

                                                                 
Щелкните для медленного перерисовывания 

 
 
 
 Хотя все вышивальные объекты уже полностью сформированы, возможны улучшения, 

относящиеся к последовательности вышивания. Объекты одного цвета должны 
вышиваться в ходе одной швейной операции, чтобы свести к минимуму число замен 
ниток. Смежные объекты должны вышиваться подряд, чтобы уменьшить число переходов, 
начальных и конечных закрепляющих стежков.   
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5 Щелкните по кнопке Color Film. 
 Откроется панель Color Film, отображающая все цветные блоки в проекте в порядке 

последовательности вышивания. Подробнее см. в разделе  
Просмотр и выделение цветных блоков. 

 
 

Щелкайте, чтобы переключаться между цветными блоками и объектами  

 
                                                                              Индивидуальные объекты 
Цветные блоки 

 
 Примечание: Последовательность вышивания направлена сверху вниз. Рекомендуется 

визуально проверять панель Color Film для обнаружения потенциальных проблем, 
например неоправданно разделенных двух блоков одного и того же цвета. Это должно 
означать, что вам придется лишний раз менять нитки при вышивании. 

 
6 Щелкните по кнопке Show Individual Objects (Показать индивидуальные объекты) и 

проверьте последовательно снизу вверх все объекты. 
 Обратите внимание, что объект, по которому вы щелкнули на панели сразу же выделяется 

в проекте. Щелкая по списку сверху вниз, проверяйте, примыкает ли текущий объект к 
предыдущему (или находится ли на близком расстоянии от него) 

 
7 Нажмите клавишу Esc, чтобы гарантировать, что ни один объект не остался выделенным.  
 

 
 Щелкните, чтобы открыть окошко Color Palette. 
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8 Щелкните по кнопке Color на панели Stitch and Color и выберите из Color Palette белую 

нитку. Подробнее см. в разделе Изменение цвета ниток. 
 
9   Щелкните по кнопке Fill (Заполнение) и выберите Step (Простегивающий стежок) из   

 списка типов стежков. Подробнее см. в разделе Выбор или изменение стежков. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Выберите стежок типа Step  
 
 
  

 
Примечание: Если не активирован инструмент Magic Wand (Волшебная палочка), 
убедитесь, что включена функция Show Pictures. 
 
10 Выберите инструмент Magic Wand, щелкните по телу утки и нажмите Enter.  

Подробнее см. в разделе Оцифровывание инструментом Magic Wand. 
Форма будет заполнена простегивающим стежком с текущими настройками. 

 
 
 

 
 
 
 
 
Щелкните инструментом  
Magic Wand  

 
 
 
 
 
 
 
 
11 Теперь выберите из списка заполняющих стежков Satin (Гладьевый стежок), щелкните 

по шее утки и нажмите Enter. 
 Форма будет заполнена гладьевым стежком с текущими настройками. 
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12 Нажмите 0 (нуль) на цифровой клавиатуре, чтобы просмотреть проект на полном экране и 

проверить свою работу в режиме Artistic View. 
 

 
 
 
 

Кольцо на шее заполнено гладьевым 
стежком.  

 
Корпус заполнен простегивающим 

стежком 
 
  
 
 
 
Примечание: Кольцо на шее теперь вышито белыми гладьевыми стежками, а контуры 
корпуса заполнены простегивающими стежками. Мы улучшим внешний вид этого заполнения 
оконтуриванием.  
 
 
13  Щелкните по кнопке Color Film. 
 Откроется диалоговое окно Color Film, отображающее все цветные блоки в проекте в 

порядке последовательности вышивания. Подробнее см. в разделе Просмотр и 
выделение цветных блоков. 

 
14 Перетащите мышью в окне Color Film цветной блок № 14 (белый) под цветной блок № 2. 
 Это означает, шея и корпус будут вышиваться раньше крыла и хвоста и находиться ниже 

контура. 

 
 
     Перетащите мышью цветной блок 
 
. 
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 Примечание: Функция Color Film синхронизирована с окном проекта. Она динамически 

обновляется в то время, когда вы выбираете, изменяете или удаляете объекты или 
создаете новый объект.  

 
15 Щелкните по кнопке Color (Цвет). Откроется окно Color Palette (Палитра цветов). 

 
 
 Щелкните, чтобы открыть окошко Color Palette. 
 
 
16  Щелкните по ссылке Thread Colors (Цвета ниток). 
 Откроется диалоговое окно Design Properties (Свойства проекта) с открытой вкладкой 

Thread Colors (Цвета ниток). На панели Threads in Design отображаются цвета, 
использованные в проекте. Подробнее см. в разделе Назначение цвета ниток. 

 
 
 

Выбор цвета, 
подходящий 

к проекту  
 
 

Выбрать Isacord 40  
wt-numerical 

 
Нитки в выбранной  

таблице ниток      
 

 
 
 
 
 
 
 
 
17 Выберите первый цвет проекта в списке Threads in Design. 

18 Из списка Thread Chart выберите  'Isacord 40 wt-numerical'. 
 Отобразятся все нитки выбранной таблицы, станет активной кнопка Match. 

19 Щелкните по кнопке Match. 
 В верхней части списка цветных ниток высветится наиболее подходящая нитка. 

20 Щелкните по кнопке Assign или дважды щелкните по нитке. 

Щелкните,  
чтобы подобрать  
 

Щелкните, 
чтобы назначить 
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 Выбранный цвет в списке Threads in Design заменен наиболее подходящим цветом 

нитки. 

21  Повторяйте эту операцию до тех пор, пока не будут назначены все цвета. 
 
 

 
 
 
Всем цветам 

проекта 
 подобраны 

 нитки из 
списка.  

 

 

 

 

 

 

 

 

 

Совет: Как вариант, просто щелкните по кнопке Match & Assign All. Наиболее подходящие 
нитки из выбранной таблицы для каждого цвета найдены и назначены автоматически. 

22 Щелкните по Apply для подтверждения и по OK, чтобы закрыть окно.  
 

Совет: Если после применения выбранных цветов вам не понравится отображаемое на 
экране цветное изображение, то вы можете выбрать и переназначить цвета по своему 
вкусу. 

23 Нажмите клавишу Esc, чтобы отменить выделение всех объектов. 
 
 
Редактирование настроек стежков 
 
 

Используйте инструмент Color Blending (панель Edit) для создания эффектов 
тени и перспективы.  
 

 
Принятые по умолчанию типы стежков могут иметь невзрачный вид. Мы можем улучшить 
внешний вид вышивки, используя различные орнаментные типы стежков и специальные 
эффекты. 
 
Как редактировать настройки стежков 
 
1 Выделите верхнюю часть клюва и голову утки и выберите Satin (Гладьевый стежок) из 

выпадающего списка заполняющих стежков.  
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Гладьевые заполняющие стежки будут применены с текущими настройками к объектам 
головы и клюва.  

 
 
   Применен гладьевый заполняющий стежок         Выберите Satin 
 

 
 
Примечание: Обратите внимание, что оба объекта – головка и клюв, – ранее 
заполненные плоскими простегивающими стежками, теперь стали более лоснящимися, 
глянцевитыми. Однако объект "голова" достаточно большой, так что гладьевые стежки при 
вышивке могут быть слишком редкими. 
 
Мы можем решить эту проблему применением специального гладьевого стежка (Satin 
Special) с разделением длинных стежков на короткие сегменты. См. также раздел 
Разбивка длинных стежков гладьевого заполнения. 

2  Нажмите клавишу Esc или щелкните еще раз, чтобы отменить выделение всех объектов. 
3  Дважды щелкните по головке утки (или щелкните правой кнопкой), чтобы открыть 

диалоговое окно Object Properties, и выберите закладку Fill Stitch (Заполняющий 
стежок). 

 
Применен специальный гладьевый стежок 

 
                                                   Выбор специального гладьевого стежка 
 
4 На панели Satin Type выберите Satin Special. 
5 Щелкните по Apply для подтверждения и по OK, чтобы закрыть окно.  



Глава 8: Учебное пособие по автоматическому оцифрованию 
 

 

BERNINA Вышивальное программное обеспечение – Краткое справочное руководство 116

 
6 Дважды щелкните по крылу утки (или щелкните правой кнопкой), чтобы открыть 

диалоговое окно Object Properties, и выберите закладку Fill Stitch. 
 
                                                  Применено орнаментное заполнение  
 

 
 
 
 
 
Выбрать заполнение 
орнаментными стежками 
 

Выбрать орнамент 
 
 
Настройка параметров: 
 
 
 
 
 
 
 

 
7 Выберите Fancy (Орнамент) в списке Stitch Type и выберите из списка узор, например  

030 Shell (90). 
 
8 Чтобы предотвратить образование длинных стежков, образующих петли, немного 

уменьшим следующим образом размеры узора: 
◄ Размер X: 6.00 мм 
◄ Размер Y: 3.00 мм 
◄ Уголь поворота: 90° 
◄ Интервал между колонками: 6.00 мм 
◄ Интервал между строками: 3.00 мм 
◄ Смещение строк: 3.00 мм 

9 Щелкните по Apply для подтверждения и по OK, чтобы закрыть окно.  
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10 Дважды щелкните по грудке утки (или щелкните правой кнопкой), чтобы открыть 
диалоговое окно Object Properties, и выберите закладку Fill Stitch. 

 

 
Применены узоры          Выбор узоров простегивающих стежков 
простегивающих стежков 
 
11 Выберите Step Pattern 25. 
 
12 Щелкните по Apply для подтверждения и по OK, чтобы закрыть окно.  
 
13 Дважды щелкните по корпусе утки (или щелкните правой кнопкой), чтобы открыть 

диалоговое окно Object Properties, и выберите закладку Fill Stitch. 
                                                                                Применены узоры простегивающих стежков 
 

 
Выбор узоров простегивающих стежков 
 
14 Выберите Step Pattern #21. 
15 Щелкните по Apply, чтобы принять стандартные настройки стежков.  
 

Примечание: Рассматриваемая ниже функция эффекта волнистости Wave Effect не 
включена в пакет BERNINA EditorPlus. Если вы используете этот продукт, обратитесь к 
следующему тематическому разделу. 
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16 Щелкните по кнопке Effects, чтобы открыть диалоговое окно Effects и выберите вкладку  
    Star & Wave Fill. См. также раздел Создание эффекта волнистости в руководстве  
    пользователя.  
 

Эффект волнистости применен 

 
                         Выберите Wave Effect 
 
17 Проставьте "галочку" в окошке Wave Effect и щелкните по Apply. 
 Угол эффекта волнистости может быть улучшен, чтобы следовать контуру тела утки. 
 
18 Закройте диалоговое окно, выберите объект и выберите инструмент Reshape Object  
      (Изменение формы объекта). Теперь будут видны узлы изменения формы, а также угла  
      волнистости. См. также раздел Изменение формы объектов  в руководстве  
      пользователя.  
 
 

 
                                                                               Щелкнуть и перетащить вниз 
 
 
 
19 Щелкните и перетащите вниз центральную точку угла волнистости, чтобы волны 

соответствовали контуру тела утки. 
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20 Нажмите Enter, чтобы принять изменения. 

 

 
                                                                              Изменена форма эффекта волнистости 

 

21 Выберите объект "вода" и щелкните по инструменту Color Blending (Смешивание  
     цветов). Откроется диалоговое окно Color Blending. См. также раздел Смешивание  
     цветов  в руководстве пользователя.  
 

 

 
 

Выберите эффект 
шага стежка  

 
Выберите нижний 

цветной слой  
 

Выберите верхний 
цветной слой  

 
Примените 

смешивание цветов 
 
 
 
22 На панели Profiles выберите профиль для верхнего и нижнего слоя, как показано выше. 

23 Выберите цвет C2 для нижнего слоя (Bottom Layer) and C14 для верхнего слоя (Top 
Layer). 

24 Щелкните по Apply, чтобы принять стандартные шаги стежков.  
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Объект "вода" дублирован и окрашен "смешанным" согласно выбранным вами 
настройкам. 

 
Завершение проекта 
 
 

Используйте инструмент Auto Underlay (панель General) для упрочнения и 
стабилизации проектов вышивки автоматически выполняемыми 
стабилизирующими стежками. 
 
Щелкните по Show Stitches (панель General), чтобы включить или отключить 
показ стежков. 
 
Используйте функцию показа рисунка Show Pictures (общая панель инструментов 
General), чтобы  включать/отключать показ оригинала рисунка. 

 
 
Мы уже почти завершили работу над проектом, но еще остались отдельные детали, на 
которые следует обратить внимание. Вначале мы добавим стабилизирующие стежки, чтобы 
стабилизировать ткань и компенсировать ее стягивание во избежание искажения вышивки.  
Нам потребуется также провести окончательную проверку свойств проекта, чтобы узнать, как 
будет выглядеть готовая вышивка. 
 
Как завершить проект 
 
1 Щелкните правой кнопкой по значку Auto Underlay (Автоматическая стабилизация 
ткани).  
Откроется диалоговое окно Effects > Underlay. См. также раздел Упрочнение и стабилизация 
ткани стабилизирующими стежками  в руководстве пользователя.  
 
 

 
 
 
 
 
Выберите первый тип 
стабилизирующего стежка  
 
 
 
 
 
Выберите второй тип 
стабилизирующего стежка  
 
Примите стандартные настройки 
 
 
 

Примечание: Тип стабилизации, который вы должны выбрать, определяется его 
назначением. Не все типы стабилизирующих стежков применимы для всех выбранных 
объектов. 

2 Выберите голову утки. 

3 Проставьте флажок в окошке Apply Underlay 1 (Применить стабилизацию 1) и выберите 
из списка Edge Walk - стабилизирующий стежок с обходом по краю. 
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 Как только вы выберете опцию Apply Underlay 1, становится активным окошко опции 

Apply Underlay 2.  Все типы стабилизирующих стежков, доступные для Underlay 1, 
доступны также и для Underlay 2.  

4 Проставьте флажок в окошке Apply Underlay 2  и выберите из списка Step - 
простегивающий стабилизирующий стежок. 

5 Щелкните по Apply, чтобы принять стандартные настройки длины стежков.  

6 Повторите эту операцию для остальных объектов проекта согласно установкам, 
показанным в таблице: 

 
Объект  Underlay 1  Underlay 2  

Трава Edge Walk    
Голова Edge Walk  Step  
Верхняя часть 
клюва 

Edge Walk    

Кольцо на шее Edge Walk    
Грудь Edge Walk  Step  
Корпус Edge Walk  Step  
Крыло Edge Walk  Step  
Хвост Edge Walk    
Вода + нет   
 
 

Примечание: + Если вы используете программу BERNINA EditorPlus для создания этого 
проекта, вам потребуется применить стабилизацию ткани для объекта "вода". 
Рекомендуемыми настройками являются Edge Walk и Step для Underlays 1 и 2 
соответственно. 
 

7  Закройте диалоговое окно и нажмите Esc для отмены выделения всех объектов. 
 

8  Выделите все объекты, нажав клавиши Ctrl+A. 
 

9  Удерживая нажатой клавишу Ctrl, щелкните по цветным блокам 2 и 7 на панели Color Film. 
Все объекты, исключая воду и траву, будут выделены. 
 

10 Щелкните по значку Object Properties Откроется диалоговое окно Object Properties. 
 

11 Щелкните по кнопке Effects (Эффекты).  
Откроется диалоговое окно Effects (Эффекты). 
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 Установите величину  
     перекрытия 0.4 мм 
 
 
 
 
 
 
 
 
 
 
 
 

12  Выберите вкладку Others (Другие) и в поле Pull Compensation (Компенсация 
стягивания) введите величину перекрытия 0.4 мм.  
 

13 Щелкните по Apply, чтобы принять изменения.  
Это приведет к улучшению внешнего вида оконтуривающих стежков, поскольку при 
слишком узком контуре будут заметны пробелы между контуром и заполнением объектов. 
 

14 Выключите функцию Show Stitches, включите функцию Show Pictures, выберите 
backdrop image (изображение оригинала) и нажмите клавишу Delete. 

 
 
 
 
 
 
 
Выберите backdrop image  
и нажмите клавишу Delete. 
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Примечание: Если вы откроете проект, сохраненный с изображением оригинала, вам 
потребуется разгруппировать проект после открытия, прежде чем вы сможете выделить и 
удалить изображение оригинала. 

 
15 Щелкните по Show Stitches еще раз и выберите File > Design Properties. 
 Откроется диалоговое окно Design Properties > Design. Вкладка Design содержит 

информацию о высоте и ширине проекта, количестве стежков и цветов. Эти данные 
извлечены из проекта и не могут быть изменены. 

 

 
 
 
16 Просмотрите следующие данные:  
 
Design Property  BERNINA EditorPlus  BERNINA DesignerPlus  

Stitch count 
(Количество 
стежков) 

прибл. 12 100 стежков. прибл. 10 500 стежков. 

Color changes 
(Количество 
остановок 
машины для 
замены цветной 
нитки):  

8  8  

Colors (Цвета)  9  9  
 
 

Примечание: Количество замен ниток на одну единицу меньше количества цветов. 
Благодаря этому сводится к минимуму количество обрезок ниток, начальных и конечных 
закрепляющих стежков. Каждый цвет вышивается только один раз. 

17  Выберите View > Slow Redraw или нажмите клавиши Shift+R.  
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Откроется диалоговое окно Slow Redraw  
 
                                                                                           Регулировка скорости 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
18  Щелкните по кнопке Go. 
 Проект будет вышиваться на машине точно в такой же последовательности, как 

показывается на экране. Подробнее см. в разделе Вышивание проектов в руководстве 
пользователя.  

 
Совет: Окончательный вариант этого проекта находится в папке "Tutorials". В 
действительности создается два окончательных файла формата .ART60 files – один для 
DesignerPlus и один для EditorPlus. Оба эти файла можно найти в папке. Вы можете 
захотеть сравнить его с собственноручно составленным проектом. 

 
19 Щелкните по кнопке Print Preview (Предварительный просмотр).  

Щелкните для 
медленного 
перерисовывания 
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Проект отобразится в том виде, в котором он будет отпечатан. Подробнее см. в разделе 
Печать проектов в руководстве пользователя.  

 

 
 
 
20 Измените опции принтера, щелкнув по кнопке Options. Подробнее см. в разделе 

Настройка печати вышивальных файлов в руководстве пользователя.  
 
 

Примечание: Большие проекты могут изображаться на нескольких страницах в случае их 
распечатки в фактическом размере. Используйте команды Next Page (Следующая 
страница), Previous Page (Предыдущая страница) или Two Pages (Две страницы) для 
просмотра нескольких страниц. 

21 Щелкните по Close, чтобы выйти из окна предварительного просмотра.  

22 Используйте функцию Write to Machine (Передать в машину) для непосредственной 
передачи проекта в готовую для работы вышивальную машину BERNINA.  Подробнее см. 
в разделе Вышивание проектов в руководстве пользователя.  
См. также подробные указания в документации вашей вышивальной машины. 
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ГЛАВА 9 
 

 
УЧЕБНОЕ ПОСОБИЕ ПО 

ОЦИФРОВАНИЮ 
----------------------------------------- 
 
 

В этом учебном пособии мы используем комбинацию 

техники ручного и автоматического  оцифровывания 

для создания вышивальных проектов по эскизам. Мы 

начнем с оригинального изображения и покажем, как 

правильно изменять его размеры. Потом мы выберем 

цветные нитки и тип ткани, с которыми будем 

работать. Затем начнем оцифровывать основные 

формы заполняющими и оконтуривающими стежками 

и выберем оптимальную технику работы. Мы 

рассмотрим некоторые специальные приемы, такие 

вырезка и заполнение отверстий в объектах. 

Наконец, мы рассмотрим, как применяются 

стабилизирующие стежки и как распечатывать проект. 

Учебное пособие может быть дополнено программой BERNINA DesignerPlus. 

 

 

Примечание: Здесь описаны все шаги, требуемые для создания проекта. Однако для 

более полной информации требуется обратиться к экранному руководству. 

 

Первые шаги 
 

Для загрузки, редактирования и сохранения рисунков в качестве фона для 
вышивок, используйте режим Art Canvas.  
 

  
Используйте режим Art Canvas  для обработки рисунка для                                     
автоматического  оцифровывания. 
 

 
 Используйте функцию Load Picture (меню Picture) для загрузки изображения в качестве 
оцифровываемого  трафарета. 
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Для целей настоящего пособия мы создадим проект вышивки на легкой трикотажной 

детской футболке размером приблизительно 80 x 90 мм. После выбора изображения 

измените его размеры по размеру футболки и выберите подходящие пяльцы. Для наших 

упражнений мы используем один из проектов, входящих в коллекцию программного 

обеспечения. 

 

Совет: В ваш программный пакет BERNINA Embroidery Software включена коллекция 

оригиналов и вышивок, которые вы можете использовать для создания первых 

собственных проектов. В дополнение к коллекции образцов проектов вы найдете папку 

"Tutorials", которая содержит все файлы дополнений к этому и другим учебным пособиям. 

Конечный результат этого и других проектов также находится в этой папке. Вы можете 

захотеть просмотреть файл завершенного проекта до и/или после ознакомления с 

учебным пособием. См. также раздел Работа с файлами проектов. 

 

Как начать работу 
 

1 Дважды щелкните мышью по ярлыку BERNINA Embroidery Software на рабочем столе 

MS Windows®. 

 Откроется окно BERNINA Embroidery Software с новым чистым проектом (Design 1) и 

выбранными по умолчанию пяльцами. 

2 В режиме Art Canvas щелкните по значку Load Picture (Загрузить изображение). 
Откроется диалоговое окно Import. 

Выбрать папку  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Выбрать нужный формат 
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3 Выберите папку ..\My Designs\Tutorials\Digitizing из списка Look In. 

4 В поле Files of type выберите All Picture Files, чтобы просмотреть все файлы с 

изображениями в этой папке.  

5 Выберите файл Digitizing_Start.PNG и щелкните по Import. 
Изображение откроется в окне Design Window по центру принятых по умолчанию 

пялец.               

 

 
 

6 Убедитесь в том, что функция Proportional Sizing включена. В поле Width (Ширина) 
(Х) введите 80 мм и нажмите на Enter.   
Ширина должна быть равной 80 мм, а высота прибл. 92.3 мм. 

 

7 Переключите в режим Embroidery Canvas и нажмите клавишу Esc для отмены 

выделения. 

 

8 Выберите Settings (Настройки) > Fabric Settings(Настройки ткани). Откроется 

диалоговое окно Fabric Settings. 

 

 
 Выберите тип ткани 

Выберите для  
использования  
стандартных настроек 
 

 

 

9 В выпадающем списке Fabric Type (Тип ткани) выберите 'Knit Light Weight' (Легкий 

трикотаж).  

10 Примите стандартные настройки и щелкните по OK. 
 Эти настройки ткани будут применены ко всем вновь создаваемым объектам проекта. 

11 Щелкните правой кнопкой мыши по значку Show Hoop (Показать пяльцы).  

 Введите размеры в виде абсолютных или  

 процентных величин 

Убедитесь, что функция Proportional 

Sizing включена.  
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Появится диалоговое окно Options > Hoop.  
 
  

 

 

Выберите artista 130x100 

 

 

 

 

 

12 Выберите из списка Hoop пяльцы "artista 130 x 100l". 

13 Щелкните по ОК. 

 
 

 

 

 

 

Пяльцы Artista 130 x 100 

 

 

 

 

 

 

 

 

 

14 Увеличьте изображение, чтобы лучше видеть пяльцы – выберите инструмент Zoom 
Box и щелкните по проекту правой кнопкой мыши.  

 

 Совет: Если вы уже выбрали пяльцы, вы можете отображать или скрывать их, щелкая 

по кнопке Show Hoop. 

15 Выберите File (Файл)> Save As (Сохранить как …).  
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Откроется диалоговое окно Save As. 

 
 

Совет: В диалоговом окне Save As открывается та же папка, в которой сохраняется 

оригинальный файл. 

16 В поле File name введите подходящее имя, например 'DigitizingTutorial'. 

17 Щелкните по кнопке Save (Сохранить). 
 

Совет: Впоследствии для сохранения любых изменений вам потребуется щелкнуть по 

кнопке Save или нажать клавиши Ctrl+S. 
 

Подготовка к оцифровыванию 
 
Используйте инструмент Image Preparation (панель Edit), чтобы повысить четкость 
контуров и уменьшить шум в оконтуренном изображении. 
 

Теперь, когда у нас имеются измененное по размеру изображение и выбранные пяльцы, 

мы можем приступить к оцифровыванию проекта. Но вначале нам нужно подготовить 

проект к автоматическому оцифровыванию и настроить палитру цветов. 

 

Как подготовить проект к оцифровыванию 
 

1 В режиме Embroidery Canvas выберите изображение. 

2 Щелкните по значку Image Preparation (Подготовка изображения). 
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 Откроется диалоговое окно Image Preparation с изображением в панели просмотра. 
 

Проверьте число цветов в изображении 

 

 
Введите "6" 

 

3 Обратите внимание, что для изображения можно использовать 6 цветов, а программа 

рекомендует сократить их число до 5.  Поскольку мы не хотим сократить количество 

цветов, введем цифру "6" в поле Reduce to (Сократить до).   
4 Щелкните по ОК.  

Изображение теперь готово для автоматического оцифровывания. 

5 Щелкните по кнопке Color (Цвет). Откроется окно Color Palette (Палитра цветов).  
       Щелкните, чтобы открыть окошко Color Palette. 

 

 
 

6 Щелкните по ссылке Thread Colors (Цвета ниток). 
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Откроется диалоговое окно Design Properties (Свойства проекта) с открытой 

вкладкой Thread Colors (Цвета ниток). На верхней панели Threads in Design 
отображаются цвета, использованные в проекте. 

 
Введите "6"  

в качестве  

количества ниток 

         

         

   Щелкните,  

чтобы  

расширить 

список ниток 

 

 

 

7 В поле Threads in Design введите "6" в качестве количества ниток, используемых в 

проекте, и щелкните по Apply. 

8 Из списка Thread Chart выберите  'Isacord 40 wt-numerical'. 

 

 Совет: На практике вы можете выбрать таблицу ниток определенной фирмы, если 

такие нитки есть у вас дома, или таблицу ниток с предпочитаемыми вами цветами, или 

самостоятельно составленную таблицу ниток. Вы можете также смешивать и 

подбирать нитки разных производителей. Подробнее см. в разделе  

Создание пользовательских таблиц ниток руководства пользователя. 

9 Выберите первый цвет проекта в списке Threads in Design. 

10 Выберите опцию Code и введите '0015' в поле Search.  
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Система найдет нитку и высветит ее в списке 

 

 
Выбор цвета 

 

 

 

Выбор таблицы  

ниток 

 

Искомый цвет 

выделен 

   

 

                                              

Введите код          Выделите, чтобы найти 'Code' 

    

11 Щелкните по Assign или дважды щелкните по нитке 

 Выбранный цвет в списке Threads in Design заменен выделенным цветом нитки. 

12 Назначьте остальные цвета нитками, показанными в таблице: 

 

Номер 

цвета 

Isacord 40 code  Описание 

1  0015  White (Белый) 

2  0020  Black (Черный) 

3  0101  Eggshell (Бледно-желтый) 

4  1800  Wildfire (Темно-красный) 

5  5722  Green Grass (Травянисто-зеленый) 

6  5374  Forest Green (Оливковый) 

 

Щелкните, 
чтобы 
назначить 
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13 Щелкните по Apply для подтверждения и по OK, чтобы закрыть окно.  

 

 

 
Все цвета  
подобрано  
согласно  
имеющимся 
 ниткам 
 

 

 

 

 
 
 
 
Примечание: Выбранные настройки цвета применяются только к текущему проекту и 

являются частью "свойств проекта". Они сохраняются с проектом. 

 

Оцифровывание проекта 
 
Щелкните по Show Stitches (панель General), чтобы включить или отключить 
показ стежков. 
 

Щелкните по Show Artistic View (просмотра вида вышивки) на общей панели 
инструментов (General toolbar), чтобы включать/выключать просмотр вида 
вышивки. 
 
Используйте инструмент Magic Wand для оцифровывания форм                                    
изображения. 
 

Используйте инструмент Closed Object (панель Digitize) для оцифровывания 
фигур неправильной формы. 
 
 

Мы можем теперь начать оцифровывание основных объектов проекта. Для нашего 

упражнения мы будем использовать комбинацию автоматической и ручной техники 

оцифровывания. Задний и передний фон объектов "трава" могут быть оцифрованы 

автоматически инструментом Magic Wand (Волшебная палочка). Для более 

прецизионной работы с ножкой и шапкой гриба, где имеет значение величина перекрытия 

во избежание пробелов, мы применим технику ручного оцифровывания. 

 

Совет: Перед тем как приступить к ручному оцифровыванию, убедитесь, что вы умеете 

обращаться с базисными точками и узлами изменения формы. Подробнее см. в разделе 

Инструментальные средства оцифровывания. 
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Как оцифровать проект 
 

1 В режиме Stitch View или Artistic View нажмите клавишу В и обведите 

прямоугольником панорамирования фон травы (темно-зеленый).  Подробнее см. в 

разделе Изменение масштаба и панорамирование. 
 

 
 

 

 

 

 

 

 

Выберите Satin 

 

Выберите 

        Forest Green

 

 

2 Выберите Satin (Гладьевый стежок) из списка Fill Stitch Type (Тип заполняющего 
стежка) Подробнее см. в разделе Выбор или изменение стежков. 

3 Щелкните по кнопке Color и выберите C6 (Forest Green) на панели Color Palette. 
Подробнее см. в разделе Выбор нового текущего цвета. 

4 Выберите инструмент Magic Wand (Волшебная палочка), щелкните по фону травы 

(темно-зеленый) и нажмите клавишу Enter для генерации объекта. Генерация стежков 

производится в соответствии с текущими настройками гладьевого стежка. 

 

 
 

 

 

 

 

Сгенерирован гладьевый стежок 

 

 

 

 

 

5 Повторите эту операцию для других темно-зеленых форм травы. 
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6 Нажмите 0 (нуль) на цифровой клавиатуре, чтобы просмотреть проект на полном 

экране и проверить свою работу в режиме Artistic View. 

 

 Примечание: Крупные темно-зеленые объекты травы слишком широки для гладьевого 

стежка. Позже мы объясним, как поступать в таких случаях. 

7 Выберите Satin (Гладьевый стежок) из списка Fill Stitch Type (Тип заполняющего 
стежка) Подробнее см. в разделе Выбор или изменение стежков. 

8 Щелкните по кнопке Color и выберите C3 (Eggshell) на панели Color Palette. 
Подробнее см. в разделе Выбор нового текущего цвета. 

 
 

Выберите Satin 

 

 

 

 

 

Выберите Eggshell 

 

 

9 Выберите инструмент Closed Object (Замкнутый объект) и оцифруйте правую ножку. 

 Очень высокой точности не требуется, поскольку позже мы внесем изменения узлами 

изменения формы. Убедитесь в том, что вышивка перекрывает красные шапочки и 

игнорируйте детали травы внизу. Подробнее см. в разделе  

Оцифровывание замкнутых контуров. 
 

 
Создайте перекрытие  

вышивки 

 

 

 

 

 

Игнорируйте детали  

травы при оцифровывании ножек 
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Совет: Следуйте указаниям в строке состояния, помогающим при оцифровывании. 

Если вы ошиблись, нажмите клавишу Backspace, чтобы удалить последнюю базисную 

точку, затем продолжайте добавлять базисные точки или нажмите Esc, чтобы удалить 

все точки и начать сначала. 

 

10  Нажмите Enter для завершения. 

 Стежки будут сгенерированы немедленно.  

11 Оцифруйте подобным же образом среднюю и левую ножки. 

 

 
 

 

 

 

 

 

Создано перекрытие 

вышивки 

 

 

 

 

Игнорированы  

детали травы 

 

 

 Совет: Нажмите 0 (нуль) на цифровой клавиатуре, чтобы просмотреть проект на 

полном экране и проверить свою работу в режиме Artistic View. Обратите внимание, 

что ножки слишком широки для гладьевого стежка. Позже мы объясним, как поступать 

в таких случаях. 
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12 В режиме Stitch View или Artistic View нажмите клавишу В и обведите 

прямоугольником панорамирования передний фон травы (светло-зеленый).  

Подробнее см. в разделе Изменение масштаба и панорамирование. 

 
 

Выберите Step 

 

13 Выберите Step (Простегивающий стежок) из списка Fill Stitch (Заполняющий 
стежок). Подробнее см. в разделе Выбор или изменение стежков. 

14 Щелкните по кнопке Color и выберите C5 (Green Grass) на панели Color Palette. 
Подробнее см. в разделе Выбор нового текущего цвета. 

15 Выберите инструмент Magic Wand (Волшебная палочка), щелкните по переднему 

фону травы (светло-зеленый) и нажмите клавишу Enter для генерации объекта. 

Генерация стежков производится в соответствии с текущими настройками 

простегивающего стежка. 

 
Сгенерирован простегивающий  

стежок 

16  Нажмите 0 (нуль) на цифровой клавиатуре, чтобы просмотреть проект на полном 

экране и проверить свою работу в режиме Artistic View. 

 

 Примечание: Передний фон травы не выглядит, как трава. Мы улучшим внешний вид 

позже. 
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17 Выберите Step (Простегивающий стежок) из списка Fill Stitch (Заполняющий 
стежок). Подробнее см. в разделе Выбор или изменение стежков. 

18 Щелкните по кнопке Color и выберите C4 (Wildfire) на панели Color Palette. Подробнее 

см. в разделе Выбор нового текущего цвета. 

 

 
 

19 Выберите инструмент Closed Object (Замкнутый объект) и оцифруйте шапочки 

грибов. 

Поскольку эти объекты являются округлыми, вы можете использовать точки кривой, 

устанавливаемые щелчками правой кнопки. 

 

 

 
Щелчками правой кнопки  

устанавливаются точки кривой 

 

 

 

 

 

 

 

20  Нажмите Enter для завершения. 
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Стежки будут сгенерированы немедленно. 

 

 

 
 

 

 

 

 

Сгенерирован простегивающий 

 стежок 

 

 

 

 

21 Нажмите 0 (нуль) на цифровой клавиатуре, чтобы просмотреть проект на полном 

экране и проверить свою работу в режиме Artistic View. 
 

Примечание: Если вы недостаточно точно провели оцифровку, контуры шапок грибов 

могут не совпадать с формами оригинала. Это можно легко исправить инструментом 

Reshape Object (Изменение формы). 

 
Правка объектов травы, ножек и шапок 

 

 Щелкните по значку Reshape Object (панель Design), чтобы изменить 

интервал между буквами. 

 

При проверке только что оцифрованных объектов в режиме Artistic View мы обнаружим в 

некоторых объектах незначительные огрехи. Мы проведем теперь правку объектов травы 

и ножек, которые слишком широки для обычного гладьевого стежка. Мы выправим также 

контуры шапок грибов. 

 

Совет: Почаще сохраняйте свою работу, чтобы не потерять свои изменения при сбое по 

питанию или системном сбое. См. также раздел Сохранение проектов. 
 

Правка травы и ножек грибов 
 

1  Выберите самый крупный объект фона травы и щелкните по значку Reshape Object. 
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2  Перетащите мышью одну точку угла наклона стежка, чтобы он составлял около 80°, и 

нажмите Enter для генерирования стежков. Подробнее см. в разделе  

Подгонка углов наклона стежков на экране. 

 

Установите угол наклона стежков на 80° 

 
 

3  Подобным же образом настройте угол наклона стежков остальных объектов фоновой 

травы, так чтобы они были более или менее перпендикулярными длине. 

4 Нажмите клавишу М и измерьте наиболее крупного фонового объекта травы. 

Подробнее см. в разделе Измерение расстояний на экране. 

 Обратите внимание, что его ширина не подходит для гладьевого стежка. Используйте 

стежок Satin Special (Специальный гладьевый стежок), если ширина объекта 

больше 10 мм. 

Объект слишком широк для гладьевого стежка 

 
 

5 Дважды щелкните по самому крупному объекту фоновой травы (или щелкните правой 

кнопкой), чтобы открыть диалоговое окно Object Properties, и выберите закладку Fill 
Stitch. 
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6 Выберите Satin Special и щелкните по Apply. 

 
Применен специальный гладьевый стежок 

 
Выбор специального гладьевого стежка 

7 Выберите светло-зеленый объект травы. 

 В окне Object Properties откроется вкладка Fill Stitch со списком простегивающих 

заполняющих стежков. 

 
               Применены узоры простегивающих стежков                   Выбор узоров простегивающих  

стежков 

 

 

8  Выберите узор простегивающих стежков № 14 для улучшения внешнего вида травы. 

См. также раздел Применение узоров простегивающих стежков. 

9  Щелкните по Apply для подтверждения и по OK, чтобы закрыть окно.  

10 Нажмите 0 (нуль) на цифровой клавиатуре, чтобы просмотреть проект на полном 

экране и проверить свою работу в режиме Artistic View. 

 Примечание: Объект травы на переднем плане стал более выразительным, но мы 

можем и далее улучшить его внешний вид дополнительным оконтуриванием формы. 

11 Выберите объект "ножка гриба" и, удерживая клавишу Ctrl, щелкните по другим 

ножкам. 
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12 Дважды щелкните по ножкам грибов (или щелкните правой кнопкой), чтобы открыть 

диалоговое окно Object Properties, и выберите закладку Fill Stitch. 

13 Выберите Satin Special (Специальный гладьевый стежок) 

  Применен специальный гладьевый стежок 

 
Выбор специального гладьевого стежка 

 

14  Щелкните по Apply для подтверждения и по OK, чтобы закрыть окно.  

15 Нажмите 0 (нуль) на цифровой клавиатуре, чтобы просмотреть проект на полном 

экране и проверить свою работу в режиме Stitch View. 

 

 Примечание: Внешний вид ножек грибов после применения стежка Satin Special 
улучшен, но мы можем еще добавить темный контур. Вскоре мы сделаем это.  

16 Выберите самую крупную шапку гриба. 

 

 Совет: Контуры вышивки и оригинала удобнее просматривать в режиме Design View. 

17 Щелкните по кнопке Reshape Object (Изменение формы объекта). 
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 Появятся узлы изменения формы и угла наклона стежков. 

 
Перетащить мышью              Контуры не совпадают с оригиналом 

узловые точки для подгонки к оригиналу 

 
 

18 При необходимости перетаскивайте мышью, добавляйте и удаляйте узлы изменения 

формы и нажимайте Enter для принятия изменений. Подробнее см. в разделе 

Изменение формы объектов с использованием узлов изменения формы. 

19 Нажмите Esc для завершения. 

 Контуры теперь 

совпадают  

с оригиналом. 

 

 

 

 

 

 

20 Повторите эту операцию для остальных шапок грибов. 

21 Нажмите 0 (нуль) на цифровой клавиатуре, чтобы просмотреть проект на полном 

экране и проверить свою работу в режиме Artistic View. 

 

 Примечание: Белые пятна на шапках грибов перекрыты красной вышивкой. Мы вскоре 

вырежем отверстия в шапочках и заполним их белой вышивкой. Мы также улучшим 

внешний вид шапок добавление темного контура. 
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Завершение подготовки шапок грибов 
 

Используйте инструмент Add Holes (панель Edit) для вырезания отверстий в 
объектах. 
 

 

Мы видим, что красная вышивка шапок полностью перекрывают белые пятна. Мы можем 

добавить белый объект окружности, клонировать его и затем вырезать нижний слой 

вышивки. 

Как вариант, мы можем вначале вырезать отверстия и применить к ним функцию 

автоматического заполнению объектов.  

 

Примечание: Мы показываем эту технику применительно к одной шапке гриба. 

Повторите эту же процедуру для остальных шапок грибов. Или попробуйте применить 

технику с добавлением окружностей. Подробнее см. в разделе  

Вырезание отверстий и удаление перекрывающих стежков. 
 

Как завершить подготовку шапок грибов 
 

1 Переключитесь в режим Stitch View и выберите самую крупную шапку гриба. 

2 Щелкните по значку Add Holes (Добавить отверстие). 

 Вокруг контура объекта появятся базисные точки. 

 

  

 

 

Оцифруйте окружности 

щелчками правой кнопкой  

по трем точкам 

 

 

3 Оцифруйте окружности, щелкая правой кнопкой по трем точкам на белых пятнах. 

 

 Совет: Следуйте указаниям, появляющимся в статусной строке. 

4 Нажмите Enter для закрытия окружности. 
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5 Повторите эту процедуру для других пятен и нажмите Enter для завершения операции. 

 

Вырезанные отверстия 

 

 

 

 

 

 

6 Нажмите 0 (нуль) на цифровой клавиатуре, чтобы просмотреть проект на полном 

экране и проверить свою работу в режиме Artistic View. 

 

 Примечание: Все отверстия, вырезанные по белым пятнам, нам нужно заполнить 

белой вышивкой. 

7 Выберите шапку гриба, с которой вы уже работали. 

8 Щелните по Arrange > Fill Holes (Расположение > Заполнить отверстия).  

 Откроется диалоговое окно Fill Holes. 

 

 
 

Выберите для заполнения 
с новыми объектами 
 
В поле Underlap введите 0.5  
 

 

9  Выберите Fill Holes with New Objects и введите 0.5 (мм) в поле Underlap. 

10 Щелкните по ОК. 
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Объекты сгенерированы для заполнения всех отверстий в шапках грибов. У них тот же 

цвет и тип стежка, что и у шапок грибов. 

 
Выберите Satin 

 

Новые объекты созданы с тем же цветом и типом стежка 

 

11 Выберите Satin (Гладьевый стежок) из списка Fill Stitch Type (Тип заполняющего 
стежка) Подробнее см. в разделе Выбор или изменение стежков. 

12 Щелкните по кнопке Color и выберите C1 (White) на панели Color Palette. Подробнее 

см. в разделе Выбор нового текущего цвета.  

Примечание: Обратите внимание, что вновь созданные белые объекты в 

последовательности вышивания находятся перед красным объектом шапки гриба. В 

последующем мы изменим последовательность вышивания. 

 

 

 
Новые белые  
объекты в  
последовательности  
вышивания находятся  
перед объектом шапки 
 

 

 

 

 

 

 

Измененные цвет и тип стежка новых объектов 

13 Нажмите 0 (нуль) на цифровой клавиатуре, чтобы просмотреть проект на полном 

экране и проверить свою работу в режиме Artistic View. 

14 Щелкните по кнопке Color Film. 

 Откроется панель Color Film, отображающая все цветные блоки в проекте в порядке 

последовательности вышивания. Подробнее см. в разделе  

Просмотр и выделение цветных блоков. 
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15 Щелкните по кнопке Show Individual Objects (Показать индивидуальные объекты). 

Щелкайте, чтобы  
переключаться между  
цветными блоками и  
объектами  
 
Переместите в  
последовательности  
вышивания красный  
объект шапки перед  
белыми объектами 
 

 

 

 

 

 

 

                     Изменены цвет и тип стежка новых объектов 

 

16 Перетащите мышью красный объект шапки, чтобы он находился выше новых белых 

объектов.  

 

Примечание: Описанная выше техника относится к одной шапке гриба. Повторите все 

эти процедуры к остальным шапкам грибов. После завершения работы сгруппируйте 

все белые пятна, используя функцию Color Film, как показано ниже. Это означает, что 

они будут вышиваться друг за другом, что сократит количество замен цветных ниток. 

 

 
Щелкайте, чтобы  
переключаться между  
цветными блоками и  
объектами  
 
 
 
 
 
 
Все белые пятна 
объединены в группу  
для сокращения числа  
замен цвета 
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Оцифровывание контуров 
Используйте инструмент Open Object (панель Digitize) для оцифровывания 
линий. 
 

 

Мы отмечали раньше, что вид травы на переднем плане, ножек и шапок грибов может 

быть улучшен добавлением темного контура. Теперь мы сделаем это. 

Совет: Почаще сохраняйте свою работу, чтобы не потерять свои изменения при сбое по 

питанию или системном сбое. См. также раздел Сохранение проектов. 
 

Как оцифровать контуры 
 

1 Щелкните правой кнопкой и перетащите объект травы переднего плана (светло-

зеленый), чтобы создать клонированную копию. Подробнее см. в разделе 

Клонирование объектов. 

 
 

2  Выберите Triple (Тройной стежок) из списка стежков Outline (Оконтуривающий 
стежок). Подробнее см. в разделе Выбор или изменение стежков. 
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3  Щелкните по кнопке Color и выберите 'C6' (Forest Green) на панели Color Palette. 
Подробнее см. в разделе Выбор нового текущего цвета. 

Выберите Triple 

 
                                                                                                                        Выберите цвет Forest Green 

 

4  При выделенном контуре объекта выберите объект травы переднего плана, 

удерживания клавишу Ctrl, чтобы выделить оба объекта. 

5  Щелкните по кнопке Align Centers (Выровнять центры). 

 Контур объекта будет совмещен с объектом травы. 

 

 
Темный контур создан  

путем клонирования и  

совмещения объекта травы 

 

 

 

 

6 Нажмите 0 (нуль) на цифровой клавиатуре, чтобы просмотреть проект на полном 

экране и проверить свою работу в режиме Artistic View. 
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7 Отмените все выделения объектов, щелкните по кнопке Object Properties (Свойства 
объекта) и выберите вкладку Outline Stitch (Оконтуривающий стежок). 

 

 

 

 

 

 

 
Установите ширину  

стежка Satin на 1.5 мм 

 

 

 

8  Выберите Satin (Гладьевый стежок) из списка типа стежков Outline и установите 1,5 

мм в поле Satin Width. Подробнее см. в разделе Выбор или изменение стежков. 

9  Щелкните по Apply для подтверждения и по OK, чтобы закрыть окно.  

 Новые настройки будут автоматически применены к любым новым объектам, 

создаваемым в текущем проекте. 

10 Щелкните по кнопке Color и выберите 'C2' (Black) на панели Color Palette. Подробнее 

см. в разделе Выбор нового текущего цвета. 

11 Щелкните по кнопке Open Object (Открыть объект). 
 

Выберите Satin 

Выберите Black 
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12 Оцифруйте все контуры ножек, вслед за шапками. Подробнее см. в разделе  

    Оцифровывание открытых контуров. 
 

 

 

 

Оконтуривание гладьевым  

стежком создано для шапок и ножек 

 

 

 

 

 

 

 Совет: Если вы ошиблись, ошибку легко исправить, используя инструмент Reshape 
Object (Изменение формы). Подробнее см. в разделе  

Изменение формы объектов. 

13 Нажмите 0 (нуль) на цифровой клавиатуре, чтобы просмотреть проект на полном 

экране и проверить свою работу в режиме Artistic View. 

 
Завершение проекта 
 

Мы уже почти завершили работу над проектом, но еще остались отдельные детали, на 

которые следует обратить внимание. Вначале мы добавим стабилизирующие стежки, 

чтобы стабилизировать ткань и компенсировать ее стягивание во избежание искажения 

вышивки.  Нам потребуется также провести окончательную проверку свойств проекта, 

чтобы узнать, как будет выглядеть готовая вышивка. 

 

Совет: Почаще сохраняйте свою работу, чтобы не потерять свои изменения при сбое по 

питанию или системном сбое. См. также раздел Сохранение проектов. 

 

Как завершить работу над проектом 
 

1  Щелкните правой кнопкой по значку Auto Underlay (Автоматическая стабилизация 
ткани).  
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 Откроется диалоговое окно Effects > Underlay. 
 
 
 
 
 
Выберите первый тип  
стабилизирующего стежка  
 
 
 
 
 
Выберите второй тип  
стабилизирующего стежка  
 
Примите стандартные  
настройки 
 

 

 
Примечание: Тип стабилизации, который вы должны выбрать, определяется его 

назначением. Не все типы стабилизирующих стежков применимы для всех выбранных 

объектов. 

2  Выберите самый крупный светло-зеленый объект травы. 

3  Проставьте флажок в окошке Apply Underlay 1 (Применить стабилизацию 1) и 

выберите из списка Edge Walk - стабилизирующий стежок с обходом по краю. 

 Как только вы выберете опцию Apply Underlay 1, становится активным окошко опции 

Apply Underlay 2.  Все типы стабилизирующих стежков, доступные для Underlay 1, 

доступны также и для Underlay 2.  

4 Проставьте флажок в окошке Apply Underlay 2  и выберите из списка Step - 
простегивающий стабилизирующий стежок. 

5 Щелкните по Apply, чтобы принять стандартные настройки длины стежков.  

 

 
Стабилизирующий стежок  

Edge Walk 

 

Стабилизирующий стежок Step  

 

 

 

 Совет: Проверьте стабилизирующие стежки, скрыв оригинал и увеличив изображение 

в режиме Design View. См. разделы Отображение или скрытие оригинала и 

Изменение масштаба и панорамирование. 



Глава 9: Учебное пособие по оцифровыванию 
 
 

 
 

BERNINA Вышивальное программное обеспечение – Краткое справочное руководство 154

6 Повторите эту операцию для остальных объектов проекта согласно установкам, 

показанным в таблице: 

Объект  Underlay 1  Underlay 2  

Крупная темно-зеленая 

трава 

Edge Walk  Step  

Темно-зеленые стебли 

травы 

Edge Walk    

Светло-зеленая трава Edge Walk  Step  

Ножки грибов Edge Walk  Step  

Шапки грибов Edge Walk  Step  

Пятна на шапках грибов Edge Walk    

 

7 Выберите все объекты травы первого плана. 

8 Щелкнитк по кнопке Object Properties, чтобы открыть диалоговое окно Object 
Properties. 

9 Щелкните по кнопке Effects (Эффекты) и выберите вкладку Others (Другие). 

Установите величину перекрытия 0.4 мм 

 
 

10 Введите величину перекрытия 0.4 мм в поле Pull Compensation (Компенсации 
стягивания) и щелкните по Apply. 

 Это приведет к улучшению внешнего вида оконтуривающих стежков, поскольку при 

слишком узком контуре будут заметны пробелы между контуром и заполнением 

объектов. 

11 Выберите File > Design Properties. 
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 Откроется диалоговое окно Design Properties > Design. Вкладка Design содержит 
информацию о высоте и ширине проекта, количестве стежков и цветов. Эти данные 

извлечены из проекта и не могут быть изменены. 

 
 

12 Просмотрите следующие данные: 

◄ Stitch count (Количество стежков): прибл. 13 900 стежков.  

◄ Color changes (Количество остановок машины для замены цветной нитки):  6  

◄ Colors (Цвета):  6. 

 

Примечание: Мы получили столько же остановок машины, сколько у нас цветов. 

Благодаря этому сводится к минимуму количество обрезок ниток, начальных и 

конечных закрепляющих стежков. Единственный цвет, который придется вышивать 

дважды, это цвет Forest Green (Оливковый) – вначале для фона травы и затем для 

контура травы на переднем плане. 

13  В режиме просмотра Design View, выберите View > Slow Redraw или нажмите 

клавиши Shift+R. 

 Откроется диалоговое окно Slow Redraw (Медленное перерисовывание). 

Регулировка скорости 

 

Щелкните для медленного перерисовывания 
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14  Щелкните по кнопке Go. 

 Проект будет вышиваться на машине точно в такой же последовательности, как 

показывается на экране. Подробнее см. в разделе Вывод проектов. 

 

 

 Совет: Окончательный вариант этого проекта находится в папке "Tutorials". Вы можете 

захотеть сравнить его с собственноручно составленным проектом.  

15 Щелкните по кнопке Print Preview (Предварительный просмотр). 

 Проект отобразится в том виде, в котором он будет отпечатан. Подробнее см. в 

разделе Печать проектов. 

 
 

 

16  Измените опции принтера, щелкнув по кнопке Options. Подробнее см. в разделе 

Настройка печати вышивальных файлов. 

 Примечание: Большие проекты могут изображаться на нескольких страницах в случае 

их распечатки в фактическом размере. Используйте команды Next Page (Следующая 
страница), Previous Page (Предыдущая страница) или Two Pages (Две страницы) 
для просмотра нескольких страниц. 

17 Щелкните по Close, чтобы выйти из окна предварительного просмотра.  

18 Используйте функцию Write to Machine (Передать в машину) для непосредственной 

передачи проекта в готовую для работы вышивальную машину BERNINA.  Подробнее 

см. в разделе Вышивание проектов. См. также подробные указания в документации 

вашей вышивальной машины. 
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ГЛАВА 10 
 

 
УЧЕБНОЕ ПОСОБИЕ ПО СОЗДАНИЮ 

МОНОГРАММ 
------------------------------------------ 

 
 
 
Используя BERNINA Embroidery Software, очень просто 
создавать монограммы для различных целей применения. 
Функции создания монограмм включают в себя три основных 
элемента монограммы – текст, орнаменты и бордюры 
(обрамление). В этом учебном пособии вы узнаете, как 
пользоваться инструментом Monogramming (Создание 
монограмм) и как быстро создавать простые и элегантные 
монограммы путем ручного оцифровывания. 
Проекты монограмм часто используются для вышивания на 
самых различных материалах, таких как махровая ткань, 
льняное полотно, сатин, бархат. Мы покажем, как настраивать 
тип ткани, чтобы получать вышивку высокого качества. В конце 
мы проверим последовательность вышивания, чтобы свести к 
минимуму количество замен цветных ниток. Учебное пособие 
может быть пополнено программой BERNINA EditorPlus или 
BERNINA DesignerPlus. 
 
 
Примечание: Здесь описаны все шаги, требуемые для создания проекта. Однако для более 
полной информации требуется обратиться к экранному руководству. 
 
Первые шаги 
 

Режим позволяет оцифровывать и редактировать образцы 
вышивки. Показывает как образцы вышивки, так и графические 
заготовки. Дает возможность просматривать образцы 
реалистически в трехмерной графике 3D. 
 

Для целей настоящего пособия мы используем проект, который должен быть вышит на конце 
льняной дорожки для стола шириной около 40 см. Размеры самой монограммы приблизительно 
140 x 140 мм, она должна быть вышита в середине, на одинаковом расстоянии от обеих краев 
дорожки. Нам потребуется подобрать подходящие пяльцы для проекта. 
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Примечание: Поскольку для начала оцифровывания этого проекта оригинал нам не 
потребуется, окончательный результат находится в папке Tutorials. Вы можете захотеть 
просмотреть файл завершенного проекта до и/или после ознакомления с учебным пособием. См. 
также раздел Работа с файлами проектов. 
 
Как начать работу 
1  Выберите режим Embroidery Canvas. 
2  Щелкните по кнопке New (Создать), если у вас уже открыт пустой проект в окне Design 

Window. 
3  Щелкните правой кнопкой мыши по значку Show Hoop (Показать пяльцы). Появится 

диалоговое окно Options > Hoop.  
 
 
 
 
 
Пяльцы artista 255x145 Oval 
 
 
 
 
 
 
 

4  Выберите из списка пяльцы "artista 255 x 145 Oval". 
5 Щелкните по ОК. 
 Совет: Если вы уже выбрали пяльцы, вы можете отображать или скрывать их, щелкая по 

кнопке Show Hoop. 
6  Выберите Settings (Настройки) > Fabric Settings(Настройки ткани). Откроется диалоговое 

окно Fabric Settings. 
 
 
Выберите тип ткани 
 

Выберите для использования стандартных настроек 
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7  Выберите 'Woven Heavy Weight' (Ткань средней плотности) из списка Fabric Type (Тип ткани). 
 

8  Примите стандартные настройки и щелкните по OK. 
 

Настройки стежков подбираются согласно выбранному типу ткани, в нашем случае льняной. 
 

Совет: При вышивании вам потребуется также подходящая подкладка, чтобы предотвратить 
образование пробелов при формировании. Для этого рекомендуется использовать два куска 
отрываемого стабилизатора. 

9  Выберите File (Файл)> Save As (Сохранить как …). Откроется диалоговое окно Save As. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Введите подходящее имя 
 
 

 
10  Выберите место для сохранения, например ..\MyDesigns\Tutorials\Monogramming 
 
11  В поле File name введите подходящее имя, например 'MonogrammingTutorial'. 

 
12 Щелкните по кнопке Save (Сохранить). 
  

Совет: Впоследствии для сохранения любых изменений вам потребуется щелкнуть по кнопке 
Save или нажать клавиши Ctrl+S. 
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Настройка палитры цветов 
При открытии нового проекта в вашем распоряжении стандартная палитра цветов. Однако эти 
цвета не соответствуют ниткам в таблице фирменных ниток. Лучше всего перед началом работы 
настроить собственную цветовую палитру и выбрать те нитки, которые у нас уже имеются. В 
нашем проекте монограммы мы будем использовать два цвета. Подробнее см. в разделе 
Назначение цвета ниток. 
 
Как настроить палитру цветов 
1  Выберите Settings > Thread Colors или щелкните по ссылке в диалоговом окне Color Palette. 

Откроется диалоговое окно Design Properties (Свойства проекта > Thread Colors (Цвета 
ниток). На панели Threads in Design (Нитки в проекте) отобразятся цвета, использованные 
в проекте. 

 
 
 

Введите '2'  
 
 

Цвета по умолчанию 
 
 
 

Выберите Isacord 40 
wt-numerical 

 
 
 
2  В поле Threads in Design (Нитки в проект) введите '2' и щелкните по Apply (Применить). 
 Теперь в списке Threads in Design будет только два цвета. 
3  Выберите первый цвет проекта в списке Threads in Design. 
4 Из списка Thread Chart выберите  'Isacord 40 wt-numerical'. 
 
 
 
 
 
Выбор цвета 
 
 
 
 
 
 
Выбранный цвет 
выделен 
 
 
 
 
                                    Введите описание      Выделите, чтобы найти 'Description' (Описание) 

Щелкните, 
чтобы 
назначить 
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5  Прокрутите вниз список Thread Chart, выберите нитки для использования в проекте.   
◄ Выберите 'Cream' (Кремовый цвет) для Color 1 и дважды щелкните по нему или или 

щелкните по Assign. 
◄ Выберите и назначьте 'Espresso' (Цвет кофе) для Color 2. Теперь ваша цветовая палитра 

готова для работы. 
6  Щелкните по Apply для подтверждения и по OK, чтобы закрыть окно.  
 
Создание текста монограммы 
 

Используйте инструмент Auto Underlay (панель General) для упрочнения и 
стабилизации проектов вышивки автоматически выполняемыми 
стабилизирующими стежками. 
 
Используйте кнопку Monogramming (панель Digitize) для создания монограмм с 
выбором заранее определенных стилей монограмм, форм обрамления и орнаментов. 
 
Щелкните по Reshape Object (панель Edit), чтобы появились узлы изменения формы 
выделенного объекта. 
 

 
В диалоговом окне Monogramming (Монограммы) имеется три закладки – Lettering (Текст), 
Ornaments (Орнаменты) и Borders (Бордюры).  В этом руководстве мы будем использовать 
все три элемента монограмм. Если вы создаете простую 2-буквенную или обычгую 3-буквеннную 
монограмму, вам потребуется выбрать подходящий алфавит и цвет. Для 2- или 3-буквенной 
монораммы вы можете также выбрать специальную компоновку, что сэкономит вам много 
времени. Подробнее см. в разделе Создание проектов монограмм в руководстве 
пользователя. 
 
Как создать текст монограммы 
 
1   Щелкните по Auto Underlay, чтобы активировать эту функцию для новых объектов.  
 
2 Щелкните по значку Monogramming.  
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Откроется диалоговое окно Monogramming с открытой закладкой Lettering. Опция Initials 
(Инициалы) открывается по умолчанию. 

  
 

 
Введите 'E', 'G' и 'B' 

 
Примите 
стандартную 
компоновку 

 
 
 

Выберите 'Erica' 
 

Введите '25' 
 

Выберите С2 
Щелкните для изменения настроек стежков 

 
 
 

Используйте кнопки масштабирования для 
увеличения или уменьшения изображения 

 
 
3  Выберите С2 в поле Color. 
4  Введите инициалы 'E', 'G' и 'B' в трех соответствующих полях. Буквы немедленно появятся в 

окне проекта. 
 

Совет: Используйте кнопки масштабирования, чтобы подробнее рассмотреть проект. 
Текущий коэффициент масштаба показан справа в статусной строке. Подробнее см. в 
разделе Изменение масштаба и панорамирование. 

5 В списке Alphabet выберите 'Erica'. 
 Если у вас нет шрифта 'Erica', выберите другой рукописный шрифт, например 'Empress' или 

даже Times Roman'. 
6  В поле Letter Height (Высота букв) введите 25 мм (1.0"). 
 Обратите внимание, что расстояние буквы 'E' от следующей буквы излишне велико. 
7  Щелкните по ОК. 
8  Щелкните по кнопке Reshape Object (Изменение формы объекта). Подробнее см. в разделе 

Настройка интервалов.  
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Вокруг текстового объекта появятся контрольные точки. 
 

 
Перетащите ромбовидную контрольную точку 

 
9  Перетащите мышью ромбовидную контрольную точку буквы 'E', чтобы уменьшить пробел. 
10  Нажмите Esc для завершения. 
 
Добавление орнамента 
Мы украсим нашу 3-буквенную монограмму добавлением орнамента. BERNINA Embroidery 
Software содержит коллекцию орнаментов, созданных специально для монограмм. См. также 
раздел Добавление орнаментов к монограммам. 
 
Как добавлять орнаменты 
1  Дважды щелкните правой кнопкой по проекту монограммы. 
 Откроется диалоговое окно Monogramming с открытой закладкой Lettering. 
2  Выберите закладку Ornaments. 
 

 
 
 
Щелкните для добавления орнамента 
 
 
 
 

 
 
3  Щелкните по кнопке Add (Добавить). 
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Появится диалоговое окно Select Source (Выбрать источник). 
 

 
Выберите 'From Patterns' 
 
 
 
 
 
 
 
 
 

4  Щелкните по кнопке From Patterns (Из образцов). Откроется диалоговое окно Select Pattern 
(Выбор образца). 

 
 
Выберите Monogram Ornaments 
 
 
 
 
 
 
Выберите M011b 
 
 
 
 
 
 

5  В списке Patterns (Образцы) выберите 'Monogram Ornaments' (Орнаменты монограмм). 
6  Выберите 'M011b' и щелкните по OK. Новый орнамент добавлен в поле списка.  

 
 
 
Новый орнамент  
добавлен  

 
 
 
 
 
7  Выберите позиции 8 и 2 в этой последовательности. 
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Будут доступны другие опции и проект обновится автоматически 
 
 
 
 
 
 
 
 

Поставьте галочку  
в Resize Proportionally 

Введите 60 
 
 
 
 

Выберите позиции 2 и 8 
 
 
 

Выберите "С2" 
 
 
 
8  Настройте орнамент следующим образом:  

◄ Width (Ширина): 60 мм (2.4") – в окошке Resize Proportionally (Сохранять пропорции) 
должна быть поставлена галочка. 

◄ Distance from Lettering (Расстояние от букв): 2,0 мм 
◄ Layout Style (Компоновка): Mirrors (Зеркальное отображение)  
 См. также раздел Компоновка элементов сложного орнамента 

 
Примечание: Поле Height (Высота) будет автоматически обновлено пропорцилнально 
изменению ширины. 

9  Щелкните по ОК. 
 

 
Введите 2 
 
 
 
Выберите 
Mirrors 



Глава 10: Учебное пособие по созданию монограмм 
 

BERNINA Вышивальное программное обеспечение – Краткое справочное руководство 166

Совет: Используйте кнопки масштабирования, чтобы подробнее рассмотреть проект. 
Текущий коэффициент масштаба показан справа в статусной строке. Подробнее см. в 
разделе Изменение масштаба и панорамирование. 

 
Добавление обрамления 
Мы захотим теперь украсить наш проект двумя элементами обрамления. Один из них будет 
заполнен стежками, другой будет оконтуривающим. См. также раздел  
Добавление обрамления к монограммам. 
 
Как добавить обрамление 
1  Дважды щелкните правой кнопкой по проекту монограммы. 
 Откроется диалоговое окно Monogramming с открытой закладкой Ornaments. 
2  Выберите закладку Borders. 

 
 
Щелкните для добавления  
обрамления 
 
 
 
 

 
3  Щелкните по кнопке Add (Добавить). 
 Появится диалоговое окно Select Border (Выбрать обрамление). 

 
 
Выберите Diamond Borders 
 
 
 
 
 
 
Выберите Diamond 14 
 
 
 
 
 

 
 
4  В списке Patterns (Образцы) выберите 'Diamond Borders' ('Ромбовидное обрамление'). 
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5  Выберите 'D0014' и щелкните по OK. 
 Новый комплект обрамления создан с использованием выбранных элементов и введенных в 

список настроек. 
 
 

Новый комплект обрамления  
добавлен 

 
 
 

Введите '3' 
 
 

Выберите образец заполнения 
 

Выберите С1 
 

Щелкните для изменения  
настроек заполняющих стежков 

 
 
 
6  Настройте обрамление следующим образом:   

◄ Offset (Со смещением): 3.0 мм (0.12") 
◄ Color (Цвет):  C1 

7  Щелкните по кнопке Fill (Заполнение) и выберите 'Pattern Fill' ('Образец заполнения') из 
выпадающего списка. 

8  Щелкните по кнопке View Properties (Показать свойства). 
 Откроется закладка Fill Stitch (Заполняющий стежок) диалогового окна Object Properties 

(Свойства объекта). 
 
 
 
 
 
Щелкните по Select. 
 
 
 

9  Щелкните по кнопке Select (Выбрать).  
  



Глава 10: Учебное пособие по созданию монограмм 
 

BERNINA Вышивальное программное обеспечение – Краткое справочное руководство 168

Откроется диалоговое окно Select Pattern (Выбор образца). 
 

 
 
Выберите Heirloom 
 
 
Выберите 710 
 
 
 
 
 
 
 
 
 

 
10  В списке Patterns (Образцы) выберите 'Heirloom'. 
11  Выберите '710' и щелкните по OK. 
12  В диалоговом окне Object Properties (Свойства объекта) подтвердите изменения. 
 
 

 
 
 
 

Размер X: 16  
Размер Y: 8 

 
Расстояния между  

колонками: 16  
 

Интервал между  
строками: 8 

 
 
 
 
 

Совет: Используйте кнопки масштабирования, чтобы подробнее рассмотреть проект. 
Текущий коэффициент масштаба показан справа в статусной строке. Подробнее см. в 
разделе Изменение масштаба и панорамирование. 

13  Щелкните по Add. 
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Создано новое обрамление гладьевым стежком с использованием текущих настроек. 
 

 
 

Новый комплект обрамления  
добавлен 

 

 
Введите '0' 

 
 
 
 

Щелкните для изменения  
настроек стежков обрамления 

 
 
 
 

Примечание: Новое обрамление гладьевыми стежками не полностью покрывает края 
существующего контура заполнения и, кроме того, выглядит слишком тонким. Нам 
потребуется заново настроить смещение и ширину контура обрамления. 

14  Измените значение смещения (offset) на 0 мм. 
 Обрамление гладьевыми стежками теперь будет перекрывать контур заполнения. 
 

 
Обрамление не совпадает                                           Обрамление перекрывает контур. 
с контуром заполнения 

 
Совет: Переключитесь в режим просмотра Stitch View и используйте инструменты 
масштабирования, чтобы рассмотреть места перекрытия контуров. Убедитесь в надлежащем 
совмещении контуров. См. также раздел Изменение масштаба и панорамирование. 

15  Щелкните по кнопке View Properties (Показать свойства). 
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Откроется закладка Fill Stitch (Заполняющий стежок) диалогового окна Object Properties 
(Свойства объекта). 

 
                      Введите '3.5' 
 
 
16  Введите '3.5' в поле Satin Width (Гладьевый стежок) и щелкните по OK. 
 Мы создали наш проект простой, но достаточно элегантной монограммы в несколькими 

довольно простыми шагами. 
 
Завершение проекта 
 
Мы уже почти готовы передать проект в вышивальную машину, но вначале нам нужно провести 
окончательную проверку свойств проекта, чтобы исследовать, как наш проект будет вышит. Мы 
сможем также увидеть, как будет выглядеть проект на фоне материала, чтобы решить, не нужны 
ли какие-либо изменения для улучшения внешнего вида. 
 
Совет: Почаще сохраняйте свою работу, чтобы не потерять свои изменения при сбое по питанию 
или системном сбое. См. также раздел Сохранение проектов. 
 
Как завершить проект? 
 
1  Выберите File > Design Properties. 
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Откроется диалоговое окно Design Properties с открытой вкладкой Design. Вкладка Design 
содержит информацию о высоте и ширине проекта, количестве стежков и цветов. Эти данные 
извлечены из проекта и не могут быть изменены. 

 

 
 
 
2  Просмотрите следующие данные: 

◄ Stitch count (Количество стежков): прибл. 9.200 стежков.  
◄ Color changes (Количество остановок машины для замены цветной нитки):  1  
◄ Colors (Цвета):  2. 

 
Примечание: У нас имеется два цвета и только одна остановка для замены нитки. Это означает, 
что последовательность вышивания оптимизирована автоматически для наиболее 
эффективного процесса вышивания./ 
 
3  Щелкните по ОК. 
4  В режиме просмотра Stitch View, выберите View (Вид) > Slow Redraw (Медленное 

перерисовывание) или нажмите клавиши Shift+R. 
 
 

           
 
5  Щелкните по кнопке Go. 
 Проект будет вышиваться на машине точно в такой же последовательности, как показывается 

на экране. Подробнее см. в разделе Вывод проектов. 

Настройки 
скорости 

Щелкните для медленного 
перерисовывания 



Глава 10: Учебное пособие по созданию монограмм 
 

BERNINA Вышивальное программное обеспечение – Краткое справочное руководство 172

 
 Примечание: Стабилизирующие стежки для букв назначаются автоматически. 

 
6  Выберите Settings (Настройки) > Fabric Display (Отображение ткани).  

       Откроется диалоговое окно Fabric Display. 
 
 
 
 
 
Выбор ткани фона    
  Щелкните для  

просмотра 
 
 
 
7  Выберите кнопку Fabric и щелкните по Browse (Обзор). 
 Откроется диалоговое окно Load Picture (Загрузить изображение). Изображения тканей 

расположены в папке C:..\Program Files\BERNINA\Embroidery Software 6\Fabrics. 
 

 
 
 
 

Обзор тканей 
 
 
 
 
 
 
 
 
 

 
8  Выберите 'Aida' из папки "fabrics" и щелкните по Open. 
 
 Примечание: Мы выбрали ткань 'Aida' только для того, чтобы имитировать на экране льняную 

ткань. 
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9  Щелкните по ОК. 
 
 

 
 
10  Сохраните свой проект. См. также раздел Сохранение проектов. 
 
 Совет: Окончательный вариант этого проекта находится в папке "Tutorials". Вы можете 

захотеть сравнить его с собственноручно составленным проектом. 
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11  Щелкните по кнопке Print Preview (Предварительный просмотр). 
 Проект отобразится в том виде, в котором он будет отпечатан. Подробнее см. в разделе 

Печать проектов. 
 

    
 
12  Измените опции принтера, щелкнув по кнопке Options. Подробнее см. в разделе Настройка 

печати вышивальных файлов. 
 
 Примечание: Большие проекты могут изображаться на нескольких страницах в случае их 

распечатки в фактическом размере. Используйте команды Next Page (Следующая страница), 
Previous Page (Предыдущая страница) или Two Pages (Две страницы) для просмотра 
нескольких страниц. 
 

13 Щелкните по Close, чтобы выйти из окна предварительного просмотра.  
 

14 Используйте функцию Write to Machine (Передать в машину) для непосредственной  
     передачи проекта в готовую для работы вышивальную машину BERNINA.  Подробнее см. в  
     разделе Вышивание проектов. 
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ГЛАВА 11 
 

 
УЧЕБНОЕ ПОСОБИЕ ПО 

АППЛИКАЦИЯМ 
------------------------------------------ 

 
 
  

Расширьте свой творческий потенциал 
аппликациями. BERNINA Embroidery Software 
обладает широким выбором образцов тканей для 
использования в проектах аппликаций, чтобы 
помочь вам визуализировать проект на экране. В 
этом учебном пособии вы узнаете, как применять 
в проекте технику открытого объекта аппликации 
оцифровыванием рисунка жирафа, входящего в 
комплект поставки. Содержащиеся здесь советы, 
подсказки и предложения помогут вам 
разобраться в технических приемах, 
используемых для создания имеющих вполне 
профессиональный вид аппликаций на домашней 
вышивальной машине BERNINA. 
Мы начнем со вставки и оцифровки рисунка 
оригинала. Затем мы оцифруем покрывающие 
стежки и проверим последовательность 
объектов. После этого мы используем 
инструмент Advanced Applique, чтобы 
сгенерировать требуемые вышивальные стежки. 
Нам потребуется также выбрать ткани из 
предложенного списка и применить их для 
проекта. Учебное пособие может быть дополнено программой BERNINA DesignerPlus. 
 
Примечание:  Здесь описаны все шаги, требуемые для создания проекта. Однако для 
более полной информации требуется обратиться к экранному руководству. 
 

Первые шаги 
 

Для загрузки, редактирования и сохранения рисунков в качестве фона для вышивок, 
используйте режим Art Canvas.  
 

  
Используйте режим Art Canvas  для обработки рисунка для                                     
автоматического  оцифровывания. 
 

 
 Используйте функцию Load Picture (меню Picture) для загрузки изображения в качестве 
оцифровываемого  трафарета. 
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Щелкайте по кнопке Show Hoop (панель General), чтобы включить или 
отключить показ пялец. Щелчок правой кнопкой мыши позволяет изменить 
настройки пялец. 
 

 
Для целей этого пособия мы используем проект, подходящий по размерам  190 x 200 мм для 
кармана на детском нагруднике. Вышивка должна быть выполнена на хлопчатобумажной ткани 
средней плотности. При использовании готового рисунка его нужно подогнать к этим размерам. 
Затем нам нужно найти подходящие для нашего проекта пяльцы. Для наших упражнений мы 
используем один из проектов, входящих в коллекцию программного обеспечения. 
 
Совет: В ваш программный пакет BERNINA Embroidery Software включена коллекция оригиналов 
и вышивок, которые вы можете использовать для создания первых собственных проектов. В 
дополнение к коллекции образцов проектов вы найдете папку "Tutorials", которая содержит все 
файлы дополнений к этому и другим учебным пособиям. Конечный результат этого и других 
проектов также находится в этой папке. Вы можете захотеть просмотреть файл завершенного 
проекта до и/или после ознакомления с учебным пособием. См. также раздел   
Работа с файлами проекта. 
 
Как начать работу 
 
1  Дважды щелкните мышью по ярлыку BERNINA Embroidery Software на рабочем столе MS 

Windows®. 
 Откроется окно BERNINA Embroidery Software с новым чистым проектом (Design1) и 

предложенными по умолчанию пяльцами. 
2  В режиме Art Canvas щелкните по значку Load Picture (Загрузить изображение). Откроется 

диалоговое окно Import. 
 
 

Выбрать папку  
Выбрать файл 

 
 
 
 
 
 
 
 

Выбрать все файлы  
с изображениями 
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3  Выберите папку ..\My Designs\Tutorials\Applique из списка Look In. 
4  В поле Files of type (Тип файла) выберите All Picture Files, чтобы просмотреть все файлы с 

изображениями в этой папке.  
5  Выберите файл 'Applique_Start.BMP' и щелкните по Open (Открыть). 
 Изображение откроется в окне Design Window.  
 Обратите внимание, что размеры изображения равны 205 x 280 мм. 

 
 
6 Введите '45' в окошке процентных значений ширины (Width) и убедитесь, что функция  

Proportional Sizing включена.  

 Изображение уменьшится до 45 % размера оригинала – приблизительно до размеров 92 x 126 
мм. 

7  Щелкните по Embroidery Canvas  и нажмите клавишу Esc для отмены выделения. 
8  Выберите Settings (Настройки) > Fabric Settings(Настройки ткани).  
 Откроется диалоговое окно Fabric Settings (Настройки ткани). 
  
 

 
Выберите Terry Medium Weight' 

 
 
 
 
 
 
 
 
9  В выпадающем списке Fabric Type (Тип ткани) выберите 'Terry Medium Weight' (Плюшевая 

ткань средней плотности).  
10  Примите стандартные настройки и щелкните по OK. 
 Эти настройки ткани будут применены ко всем вновь создаваемым объектам проекта. 
11  Щелкните правой кнопкой мыши по значку Show Hoop (Показать пяльцы).  

Введите размеры в процентах от размера 
оригинала. 

Убедитесь, что функция Proportional Sizing 

включена.  
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 Появится диалоговое окно Options (Опции) на закладке Hoop (Пяльцы).  
 

 
 
 
 
Выберите artista 130x100 
 
 
 
 
 
 
 

 
12 Выберите из списка Hoop пяльцы 'artista 130 x 100' и щелкните по OK. 
 

 
 

 
 
 
 
 
 

Пяльцы Artista 130 x 100 
 
 
 
 
 
 
 
 
 
 
 

13  Увеличьте изображение, чтобы лучше видеть пяльцы – выберите инструмент Zoom Box и 
щелкните по проекту правой кнопкой мыши.  

 
Совет: Если вы уже выбрали пяльцы, вы можете отображать или скрывать их, щелкая по 
кнопке Show Hoop. 

14  Выберите File (Файл)> Save As (Сохранить как …).  
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Откроется диалоговое окно Save As. 
 

   
 

Совет: В диалоговом окне Save As открывается та же папка, в которой сохраняется 
оригинальный файл. 

15  В поле File name введите подходящее имя, например 'AppliqueTutorial'. 
16 Щелкните по кнопке Save (Сохранить). 
 

Совет: Впоследствии для сохранения любых изменений вам потребуется щелкнуть по кнопке 
Save или нажать клавиши Ctrl+S. 

 
Оцифровка покрывающих стежков 

 
Используйте инструмент Open Object (панель Digitize) для оцифровывания линий. 
 

 
Используйте инструмент Closed Object (панель Digitize) для оцифровывания фигур 
неправильной формы. 
 

 
В этом руководстве мы используем импортированное изображение в качестве контуров при 
ручной оцифровке объектов аппликации, которые будут созданы с покрывающими стежками.  
Для нашего проекта мы используем специальный инструмент Advanced Applique, который 
позволит создавать "объект открытой аппликации" из одного или нескольких "первичных" 
объектов. Эти объекты формируют покрывающие стежки окончательной аппликации.  
Предусмотрен специфический порядок, в котором вы должны вышивать объекты, так чтобы 
пересекающиеся объекты образовывали друг с другом "допустимые контуры": 
◄  Уши и рога 
◄  Участок лба 
◄  Пятна на шее 
◄  Шея, мордочка и нос 
◄  Глаза и ноздри 
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Мы будем оцифровывать эти объекты, используя по умолчанию одинарные зеленые стежки, 
чтобы стежки отображались в окне Stitch View более четко. Эти стежки будут преобразованы в 
черные гладьевые стежки, как только будут завершены все объекты, содержащие покрытие 
вышивкой. Смотри также Методы оцифровывания. 
 
Совет: Перед тем как приступить к ручному оцифровыванию, весьма полезно ознакомиться с 
приемами обращения с базисными точками и узлами изменения формы в BERNINA Embroidery 
Software.  Подробнее см. в разделе Инструментальные средства оцифровывания. 
 
Как оцифровывать покрывающие стежки 
 
1  Щелкните по кнопке Color (Цвет).  
 Откроется окно Color Palette (Палитра цветов). 
 
 
 
 
 
 
 
 
 
2  Щелкните по ссылке Thread Colors (Цвета ниток). 

Щелкните, чтобы  
открыть окошко Color 
Palette. 
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 Откроется диалоговое окно Design Properties (Свойства проекта) с открытой вкладкой 

Thread Colors (Цвета ниток). На верхней панели Threads in Design отображаются цвета, 
использованные в проекте. 

 
 
 

Введите '2'  
 
 

Выбор цвета 
 
 
 

Выбор таблицы  
ниток 

 
Выберите Black 

 
 
 
 
 
 
 
3  Введите '2' в поле Threads in Design. 
4  Выберите C2 на панели Threads in Design. 
 

Примечание:  Мы оставим первый цвет– по умолчанию зеленый – для оцифровки рисунка. 
При черных контурах рисунка зеленый цвет помогает более отчетливо видеть результаты 
работы. 

5  Из списка Thread Chart выберите  'Isacord 40 wt-numerical'. 
6  В списке таблицы ниток выберите и дважды щелкните по 'Black' (Черный) или щелкните по 

Assign. 
7  Щелкните по Apply для подтверждения и по OK, чтобы закрыть окно.  

Щелкните, чтобы 
назначить 
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8  Нажмите клавишу В и обведите прямоугольником панорамирования левый глаз жирафа. 

Подробнее см. в разделе  
Изменение масштаба и панорамирование. 

 
 
 
 
 
 
 
 
Выберите зеленый 
цвет 
 

 
 
9  Выберите Single (Одинарный стежок) из списка стежков Outline (Оконтуривающий 

стежок). Подробнее см. в разделе Выбор или изменение стежков. 
10  Щелкните по кнопке Color и выберите C1 (по умолчанию зеленый) на панели Color Palette. 

Подробнее см. в разделе Выбор нового текущего цвета. 
11  Щелкните по инструменту Open Object (Открытый объект) и оцифруйте левый глаз – 

щелкайте левой кнопкой по угловым точкам и правой кнопкой по точкам кривой. Подробнее 
см. в разделе Оцифровывание открытых фигур. 

 
 

 
 

Совет: Используя рисунок в качестве трафарета, убедитесь в том, что входная и выходная 
точки фигуры глаза перекрывают контур головы, так как в противном случае целое не будет 
конвертировано в объект Advanced Applique. Подробнее см. в разделе  
Создание проекта  аппликации с открытыми объектами. 

Выберите Single 
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12  Оцифруйте таким же способом левый рожок, правый рожок и затем правый глаз. 
 

       
  

Entry = Вход                 Exit = Выход 
 
 

Совет: Во время оцифровки объектов в указанном выше порядке не имеет большого 
значения, оцифровываете ли вы входные и выходные точки в каком-либо определенном 
порядке, если активирована опция Apply Closest Join (по умолчанию). Функция Closest Join  
автоматически рассчитывает замкнутое соединение между объектами во время 
оцифровывания. Подробнее см. в разделе Настройка других общих опций. 

13 Щелкните по инструменту Open Object и оцифруйте участок лба, начиная с правой стороны. 
 
 

      
Entry = Вход       Exit = Выход 

 
Примечание:  Снова убедитесь в том, что входная и выходная точки заходят за контур 
головы. 
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14  Теперь оцифруйте участки шеи, как показано, сначала с левой стороны, затем с правой.  

 
Entry = Вход    Exit = Выход 

 
 
15 Следующий шаг: оцифруйте шею. 
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16 Теперь оцифруйте мордочку. 
 

 
Entry = Вход           Exit = Выход 

 
 
 
17 Щелкните по инструменту Closed Object (Закрытый объект) и оцифруйте, как показано, нос. 

Подробнее см. в разделе Оцифровывание замкнутых контуров. 
 
 

 
 

Entry = Вход           Exit = Выход 
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18  Нажмите клавишу 0 (нуль), чтобы увидеть оцифрованные переходные стежки. 
 
 

 
 
19  Нажмите клавишу В, чтобы обвести указателем мыши вокруг глаз рамку масштабирования. 

Подробнее см. в разделе Изменение масштаба и панорамирование. 
 
 
 
 
 
 
 
Выберите Black 
 
 
 

 
20  Выберите Satin (Гладьевый стежок) из списка Fill Stitch Type (Тип заполняющего стежка) 

Подробнее см. в разделе Выбор или изменение стежков. 
21 Щелкните по кнопке Color и выберите C2 (Black) на панели Color Palette. Подробнее см. в 

разделе Выбор нового текущего цвета. 

Выберите Satin 
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22 Выберите инструмент Block Digitizing (Оцифровывание блока). 
 

 
 
23 Оцифруйте левый глаз, отметив контрольные точки с обеих сторон. Подробнее см. в разделе 

Оцифровывание колонок с изменяющейся шириной. 
24 Нажмите клавишу Esc, чтобы деактивировать инструмент и выделить объект глаза. 
25 Щелкните по значку Mirror-Merge Horizontal (Зеркальное отображение по горизонтали - 

Многократное дублирование). Подробнее см. в разделе  
Зеркальное переворачивание с дублированием объектов. 

 
Переместите указатель мыши вправо     Зеркальное отображение 
 
26 Перемещайте указатель мыши вправо до тех пор, пока дубликат не расположится над правым 

глазом изображения и щелкните для завершения. 
27 Увеличьте масштаб зоны носа, выберите Satin из списка стежков Outline. 

 
 
Выберите Satin 
 
 
 
 
 
 

 
28 Используя инструмент Open Object, оцифруйте правую ноздрю. Подробнее см. в разделе 

Создание контуров гладьевым стежком. 
29 Нажмите клавишу Esc, чтобы деактивировать инструмент и выделить объект ноздри. 
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30 Используйте инструмент Mirror-Merge Horizontal для создания второй ноздри.  
 

 
 
Зеркальное отображение 
 
 
 
 
 
 
 
 

 
Примечание: Ноздря получилась несколько толще, чем требуется, мы позже изменим ее 
толщину. 

31 Перемещайте указатель мыши влево до тех пор, пока дубликат не расположится над левой 
ноздрей изображения и щелкните для завершения. 

32 Нажмите клавишу 0 (нуль), чтобы увидеть оцифрованные объекты. 

      
 
Правка результатов 
 

 
Щелкните по Reshape Object (панель Edit), чтобы появились узлы изменения формы 
выделенного объекта. 

 
Перед тем, как мы сможем применить функцию Advanced Applique к нашим покрывающим 
стежкам, нам потребуется тщательно проверить объекты, чтобы убедиться, что все контуры 
совмещены друг с другом. Мы также изменим цвет стежков на черный и тип стежка на гладьевый 
стежок для окончательной покрывающей вышивки. 
 
Как править результаты 
 
1  Выберите левый глаз и щелкните по значку Reshape Object (Изменение формы объекта). 
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 Вокруг объекта появятся узлы изменения формы. Подробнее см. в разделе  

Изменение формы объектов с использованием узлов изменения формы. 
 
 
 
 
 
 
Проверьте, пересекают ли первый и  
последний узлы изменения формы контур головы.  
 
 
 
 

 
2  Щелкните по значку Zoom Box или нажмите клавишу В и обведите прямоугольником 

панорамирования левый глаз жирафа. 
 

 
 
3  Проверьте, пересекают ли первый и последний узлы изменения формы контур головы.   

◄ Перетащите мышью красный крестик входной точки за пределы контура. 
◄ Перетащите узлы изменения формы для пересечения, если необходимо.  
◄ Перетащите точку входа обратно в первоначальное положение. 
◄ Повторите эту же процедура для всех остальных точек. 

 
Примечание:  Вы можете найти файл проекта в папке Tutorial, созданной к этому времени.  
Вы можете открыть его, чтобы сравнить со своей работой. Имя файла 'DigitizedRunStitches'. 

Настройте для 
пересечения 

Нет пересечения 
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5 Щелкните по значку Color Film и щелкните по переключающей кнопке Show Individual 

Objects (Показать индивидуальные объекты). Подробнее см. в разделе  
Просмотр и выделение цветных блоков. 

 

 
 
 
 

Совет: Для получения более четкого изображения отключите функцию Show Pictures 
(Показать рисунок).  

Щелкайте, чтобы 
переключаться 
между цветными 
блоками и 
объектам 

Выберите все 
объекты с 
покрывающими 
стежками 
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6  Щелкните по первому объекту в списке и, удерживая клавишу  Shift щелкните по последнему 

зеленому объекту. 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
7  Выберите Satin (Гладьевый стежок) из списка типов стежков Outline (Оконтуривающие 

стежки). Подробнее см. в разделе Выбор или изменение стежков. 
8  Щелкните по кнопке Color и выберите C2 (черный) на панели Color Palette. Подробнее см. в 

разделе Выбор нового текущего цвета. 
 Все покрывающие стежки для аппликации теперь являются черными гладьевыми стежками. 

Однако объекты рожков и ноздрей слишком толстые. 
9  Нажмите клавишу Esc для отмены всех выделений.  
10  Выберите рожки и ноздри и дважды щелкните левой кнопкой или щелкните правой кнопкой.  

Выберите Satin 

Выберите 
Черный цвет 
(C2)

Все покрывающие стежки 
преобразованы в черные гладьевые 
стежки 
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Откроется закладка Outline Stitch (Оконтуривающий стежок) диалогового окна Object 
Properties (Свойства объекта). 

 
   
 
 
 
 
 
 
 
 
 
 
Введите '2' 
 
 

 
 
11  Введите 2 мм в поле Satin Width (Ширина гладьевого стежка) и щелкните по Apply 

(Применить). 
 

Совет: Вы можете найти файл проекта в папке Tutorial. Вы можете открыть его, чтобы 
сравнить со своей работой. Имя файла 'ReadyForApplique'. 

 
Создание открытого объекта аппликации 
 

 
Используйте кнопку Advanced Applique (панель Digitize) для создания открытого 
объекта аппликации из одного или нескольких источников объектов. 
 
 

Объект открытой аппликации создается из одного или нескольких источников "первичных" 
объектов. Можно использовать различные типы первичных объектов, включая любой тип 
оконтуривающего стежка – одинарный, оконтуривающий гладьевый стежок и др. – любой 
замкнутый или оцифрованный блочный объект. При создании объекта открытой аппликации 
генерируются "вторичные объекты" для удержания лоскутов ткани. Они могут включать 
некоторые или все из следующих линий: 
◄ Линии размещения: Эти линии используются опционально для вышивания первого слоя 

аппликации. Линии размещения применяются для позиционирования предварительно 
вырезанных лоскутов аппликации на материале заднего плана.  

◄ Линии обрезки: И в этом случае опционально линии обреза образуют направляющие при 
обрезании лоскута ткани на месте.  

◄ Закрепление: Это строчка зигзаг, прокладываемая после разметки линий размещения и 
обрезки, которая используется для закрепления элементов аппликации к материалу фона 
перед покрывающим вышиванием. 
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Каждый "граничный сегмент" генерирует линию размещения, линию обрезки и/или 
закрепляющую строчку в зависимости от текущих настроек. 

 
 
 
 
 
 
 
 
 

 
 
Как создать открытый объект аппликации 
 
1  Выделите все объекты на панели Color Film за исключением глаз и ноздрей.  Подробнее см. в 

разделе Просмотр и выделение цветных блоков. 
 

Внимание: Если вы сохраните свой проект и затем снова откроете сохраненный файл, то ваш 
проект будет по умолчанию сгруппирован. Перед дальнейшей обработкой вам потребуется 
разгруппировать объекты проекта. Подробнее см. в разделе  
Группировка и разгруппировка объектов. 

2   Щелкните по значку Advanced Applique. 

 
Линия размещения, линия 
обрезки и закрепляющие стежки 
вторичных объектов 
генерируются для каждого 
"граничного сегмента" 
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Откроется диалоговое окно Applique Properties (Свойства аппликации). Зоны, входящие в 
область маркировки, заштрихованы белым. 

 
 
 
 
Щелкните, чтобы назначить 
ткань и цвет элементам 
 
 
 
 
 
 
 
 
 
 
 

3   Активируйте опцию Place Fabric and Color in Patches. 
Диалоговое окно изменится, будет показана панель Place Fabric in Patches (Размещение 
тканей в лоскутах).  

 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
4  Щелкните по узлу BENARTEX – расширится список тканей – и откройте 'Nancy Kirk's Civil War 

Collection 2'. 
5  Наведите указатель мыши на образцы – всплывающая подсказка покажет номер – и выберите 

'322-7'. 

Зоны, 
входящие в 
область 
маркировки, 
заштрихованы 
белым 

Щелкните для 
расширения 
узла 

Указатель 
мыши на 
образце 

Появится 
белый 
контур 
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6  Наведите указатель мыши на голову жирафа – появится белый контур – и щелкните. 

Голова заполнится выбранной тканью, и образец будет добавлен в поле Used Fabrics 
(Используемые ткани). 

 
  
 
 
 
 
 

Примечание:  Обратите внимание, что глаза появятся над тканью.  
 
7   Повторите эту же процедура для всех остальных зон светлого цвета. 
8 Из этой же коллекции выберите ткань '320-70' и примените ее для всех темных зон жирафа. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Совет: Перетащите мышью образец ткани из дерева тканей в поле Used Fabrics для замены.  
 

Используемая ткань 

Добавлен 
образец ткани 

Наведите 
указатель 
мыши на 
голову 
жирафа 

Наведите 
указатель 
мыши 
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9   После завершения щелкните по Back. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Совет: Объекты Advanced Applique можно выделять и обрабатывать тем же способом, что и с 
группированными объектами, т.е. их можно перемещать, изменять размеры, перекашивать 
или поворачивать, используя тот же метод перетаскивания мышью, применимый для всех 
объектов.  Однако изменять форму объектов Advanced Applique невозможно. И при этом нет 
какого-либо способа, чтобы выбрать первичные или вторичные индивидуальные объекты , в 
пределах открытого объекта аппликации, если объект не будет вначале обособлен 
Подробнее см. в разделе Разбивка объектов на компоненты. 

 
10  В главном меню диалогового окна Applique Properties щелкните по опции Merge Patches 

Together (Соединение лоскутов).  
 Откроется панель Merge Patches Together. 

 
11 Щелкните по левому глазу и мордочке - эти элементы будут соединены. 
 

Примечание:  Вы можете за один раз соединять только два элемента.  

Все фрагменты 
заполнены 
тканями 

 
Открытие панели 
Merge Patches 
Together 

Выделены левый 
глаз и мордочка 
для соединения 
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12  Повторите эту же процедуру для правого глаза и шеи. 

 
13  Темные фрагменты аппликации, лоб и правый рожок, можно объединить таким же образом.  

 
14 После завершения щелкните по Back. 
 
Завершение проекта 
 

 
Используйте функцию Show Appliqué Fabric (панель General), чтобы 
включать/отключать показ ткани/цвета аппликации. 
 

 
Мы теперь почти завершили работу над проектом. Но вначале нам потребуется провести 
окончательную проверку последовательности вышивания, чтобы узнать, как будет выглядеть 
готовая вышивка. 
 
Совет: Почаще сохраняйте свою работу, чтобы не потерять свои изменения при сбое по питанию 
или системном сбое. См. также раздел Сохранение проектов. 
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Как завершить работу над проектом 
1  Щелкните по значкам Show Pictures (Показать рисунок) и Show Appliqué Fabric (Показать 

ткань), чтобы скрыть отображение рисунка и ткани. 
2  Нажмите клавишу End, чтобы перейти к концу проекта, или клавишу Home, чтобы перейти к 

его началу. 
При нажатии клавиши End белый крестик (маркер текущего положения иглы) переместится к 
последнему стежку (красный крестик). При нажатии клавиши Home белый крестик 
переместится на первый стежок (зеленый кружок). 

 

 
 
3  Нажмите клавишу Page Down, чтобы перейти к первому стежку линии размещения (розовый 

цвет). Нажмите клавишу еще раз, чтобы перейти к первому стежку линии обрезки (голубой 
цвет). 

 

Белый крестик – маркер 
текущего положения иглы на 
последнем стежке

Конечная точка: 
 
 
Начальная точка: 

Белый крестик – 
маркер текущего 
положения иглы на 
первом стежке 

Первый стежок 'stop' 
линии размещения – 
когда вы используете 
первый фрагмент 

Первый стежок 
'stop' линии 
обрезки – когда вы 
обрезаете ткань 
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4  Нажмите клавишу Page Down, опять чтобы перейти ко второй строчке линии размещения 

(розовый цвет). 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Совет: Нажмите клавишу Page Up, чтобы перейти к предыдущему изменению цвета.  

5 Продолжайте переходить по изменениям цвета и проверяйте, где, по вашему мнению, 
должны быть точно помещены фрагменты ткани и где они должны быть обрезаны. 

Стежок второй 
линии обрезки 

Второй стежок 'stop' 
линии размещения – 
когда вы используете 
первый фрагмент 
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6 Как только все фрагменты будут размещены и обрезаны, вы увидите использованные 

закрепляющие стежки. Нажмите клавишу Page Down еще раз, чтобы увидеть покрывающие 
стежки. 

 
 

 
Совет: Окончательный вариант этого проекта находится в папке "Tutorials". Вы можете 
захотеть сравнить его с собственноручно составленным проектом. 
 

7   Щелкните по кнопке Print Preview (Предварительный просмотр). 
  

Покрывающие 
стежки 
применены в 
последнюю 
очередь 

Закрепляющие 
стежки 
применены 
сверху линии 
размещения и 
обрезки 
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Проект отобразится в том виде, в котором он будет отпечатан. Подробнее см. в разделе 
Печать проектов. 

 

 
8  Дважды щелкните по Color Sequence (Последовательность цветов) – вы увидите, где 
машина будет останавливаться, чтобы можно было собрать аппликацию. 
 
9  Измените опции принтера, щелкнув по кнопке Options. Подробнее см. в разделе  

Настройка печати вышивальных файлов. 
 
 
Примечание:  Большие проекты могут изображаться на нескольких страницах в случае их 
распечатки в фактическом размере. Используйте команды Next Page (Следующая 
страница), Previous Page (Предыдущая страница) или Two Pages (Две страницы) для 
просмотра нескольких страниц. 
 
10  Щелкните по Close, чтобы выйти из окна предварительного просмотра.  
 
11  Используйте функцию Write to Machine (Передать в машину) для непосредственной 
передачи проекта в готовую для работы вышивальную машину BERNINA.  Подробнее см. в 
разделе Вышивание проектов. См. также подробные указания в документации вашей 
вышивальной машины. 
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ГЛАВА 12 

 

 
УЧЕБНОЕ ПОСОБИЕ ПО 

ИСПОЛЬЗОВАНИЮ МУЛЬТИМЕДИЙНЫХ 
ВОЗМОЖНОСТЕЙ 

(MULTI-MEDIUM TUTORIAL) 
------------------------------------------- 

 
 

 
 

В этом учебном пособии мы изучим мощные мультимедийные возможности для создания 
вышивок, которые предоставляет программа BERNINA Embroidery Software. Вы научитесь 
сочетать цифровую печать на ткани и вышивку, на примере рисунка, который будет 
одновременно отпечатан и вышит в середине белой майки. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

В учебных целях мы предлагаем использовать как переводную бумагу, так и обычный цветной 
принтер. На переводной бумаге рисунки при печати отображаются зеркально, после чего 
рисунок переводится на швейное изделие с помощью утюга.  Если в вашем печатающем 
устройстве есть опция выбора бумаги для печати  «T-shirt transfer paper» (переводная бумага 
для нанесения рисунков на майки), то печатное устройство автоматически отпечатает рисунок 
в зеркальном отображении. Если такой опции нет, функция зеркального отображения обычно 
задается драйвером. Проверьте имеющиеся опции и используйте ту, что позволяет получить 
зеркальный рисунок. Все необходимые для данного проекта шаги перечислены ниже. 
Дополнительную информацию можно найти в системе экранной помощи (Onscreen Manual). 



Глава 12: Учебное пособие по использованию мультимедийных возможностей 
 
 

BERNINA Вышивальное программное обеспечение – Краткое справочное руководство 
 

203

 
Начинаем работать 

 
 

Для запуска BERNINA Embroidery Software щелкните дважды мышью по 
этому ярлыку. 

 
 
 
Выберем рисунок для нанесения на переднюю часть майки, который должен занимать площадь 
примерно 148 мм x 105 мм (5.83" x 4.13"). Когда мы будем вставлять рисунок,  мы его 
перемасштабируем так, чтобы он вписался в указанные размеры. Для начала возьмем один из 
рисунков, предоставляемых в пакете программного обеспечения. См. также раздел Основные 
процедуры  этого руководства.  
 
Совет: Вместе с программным обеспечением BERNINA Embroidery Software поставляется 
набор рисунков и образцов вышивки, которые вы можете использовать как основу для 
собственных проектов. Кроме прилагаемых образцов, имеется папка ‘Tutorials’ , где хранятся 
файлы с материалами для обучения, которые нужны для выполнения учебных проектов 
данного учебного пособия, а также и других учебных пособий. В той же папке хранятся файлы с 
ожидаемыми конечными результатами учебных проектов. Вы можете посмотреть на эти 
результаты как до начала выполнения учебного проекта, так и по его  
завершении. См. также раздел  
Работа с файлами образцов  этого руководства.  
 
Начало работы 
 
1 Нажмите иконку New (новое) или выберите эту позицию в меню File > New в режиме 
вышивания 
 
2 Перейдите в режим Art Canvas. Дополнительная информация содержится в разделе Режиме 
просмотра .  

 
По щелчку мыши надо перейти в графический режим. 
 
3 Выберите формат A6 для размера холста из выпадающего списка, выберите ориентацию 
рисунка Landscape (альбомная). 

 
 

Выберите альбомную ориентацию рисунка, формат A6 
 

4 Вернитесь в Embroidery Canvas и выберите пункт меню File > Save As (сохранить как..).  
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Откроется диалог сохранения Save As. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5 Введите желаемое название проекта – например ‘MyMultiMediumProject’ 
– в поле File name (имя файла) и нажмите Save (сохранить). 
 
Впоследствии, для сохранения изменений в вашем проекте вам достаточно будет нажимать 
кнопку Save (сохранить) или клавиши Ctrl+S . 
 
Внимание: Если вы в ходе данного обучающего проекта закрываете и снова открываете свой 
файл, проверьте, что после повторного открытия проекта все объекты вышивки должны быть 
разгрупированы.  

 
Импорт и размещение графических фрагментов 

 
С помощью кнопки Load Picture (загрузка рисунка) на панели инструментов 
Image загрузите рисунок, который будет использоваться в качестве 
оцифровывающего фона (задника). 

 
В режиме Art Canvas мы можем начать конструировать рисунок, импортируя графические 
фрагменты. 
 
Импортирование и размещение графических фрагментов 
 
1 Сперва нажмите кнопку Load Picture (загрузка рисунка) на панели инструментов Image. См. 
также раздел Импорт изображений в ПО BERNINA Embroidery Software в руководстве 
пользователя 
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Откроется диалог импорта (Import). 
 
 
 
 
 
Выберите рисунок  
для импортирования 
 
 
 
Найдите папку  
Tutorials > 
MultiMedium 
 
 
 
 
 
 
 
 
 
 

2 Найдите папку Tutorials > MultiMedium, используя путь навигации My Designs – Embroidery 
Software . 
 
3 Выберите файл ‘Grand Piano.CDR’ и нажмите Import. 
4 Нажмите Enter (Ввод), чтобы отцентрировать рисунок на странице. 
 

                                                        
Обратите внимание на размеры рисунка 

 
Внимание: проверьте размеры рисунка с пианино, указанные в поле Object(s) Size на панели 
свойств Property Bar – размеры должны соответствовать примерно 190 x 193 мм. 
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Перемасштабируйте  
с помощью мыши 

 
5 Этот графический фрагмент слишком велик для нашей конструкции. Используя активные 
точки по краям рисунка, с помощью мыши отмасштабируйте рисунок так, чтобы он оказался в 
границах страницы, как показано. См. также раздел Изменение размеров объектов в 
руководстве пользователя. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Преобразование рисунка в вышивку 

 
Для рисования овалов используйте функцию Art Toolbox >. 

 
Для преобразования выбранных векторов, чтобы очертить или заполнить 
стежки, используйте функцию Art Toolbox > Convert Vectors to Embroidery. 

 
Нажмите кнопку Show Hoop (показать пяльцы) на общей панели 
инструментов, чтобы  

                   просмотреть пяльцы.  
                     С помощью правой клавиши  
                   мыши можно менять настройки. 
 
 
Теперь мы создадим рамку для нашей фотографии и преобразуем ее в вышивку. 
 
Как преобразовать рисунок в вышивку 
 
1 Используйте функцию Ellipse (овал) на панели инструментов Art Toolbox. 

Для позиционорования  
рисунка используйте  
активную точку в его центре 
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Овалу и его копии в 
Object Manager 
соответствуют две 
кривые 

 
Мы будем использовать этот овал как рамку для нашей фотографии. 

 

 
Подсказка: Размеры можно уточнить, введя их явно в поле на панели свойств  
(Property Bar). 
 
 
2 Сделайте копию овала с помощью функций Edit >Copy/Paste (редактировать > 
копировать/вставить) 
Копия объекта отобразится поверх самого объекта. Мф используем ее позже как рамку 
‘PowerClip’ , разместить нашу фотографию точно в рамках вышиваемого рисунка. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Подсказка: С помощью функции Object Manager проверьте, что овал действительно  
             откопирован.  

Для позиционирования 
рисунка используйте активную 
точку в его центре 
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3 Перед тем, как преобразовать рисунок в вышивку, выберите цвет рамки и ее размер, с 
помощью функции «свойства объектов» (object properties). 
 

 
 
Подсказка: Цвет двойной окантовки должен быть выбран таким же, как и цвет рамки рисунка. 
При печати рисунка, цвет отпечатка окантовки будет таким жеЮ как и цвет вышивальной 
нитки. 
 
4 Для преобразования  в вышивку, выделите рамку рисунка и нажмите Convert Vectors to 
Embroidery на панели инструментов Art Toolbox. 
Программа BERNINA Embroidery Software перейдет в режим Embroidery Canvas и 
автоматически преобразует выделенный объект в вышивку. См. также раздел 
Оцифровка векторной графики в руководстве пользователя. 
 

 
                         Укажите тип стежка      Укажите цвет 

 
 

5 Выберите желаемые типы стежков и цвет ниток с помощью панели Stitch and Color Bar. См. также 
раздел Цвета ниток и таблицы ниток в руководстве пользователя 
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Подсказка: Можно найти желаемую нитку по ее коду или описанию и приписать ее к набору 
цветов для выбранного образца.  
См. также раздел Поиск типов ниток в руководстве пользователя. 
 
6 Используя пункт меню Settings > Fabric Display (настройки > изображения тканей), 
выберите подходящий цвет фона, чтобы он соответствовал ткани, на которую наносится 
рисунок. См. также раздел Изменение фона в руководстве пользователя 
 
 
 
 
Выберите цвет  
фона или ткань 
 
 
 
 
 
 
7 Правой клавишей мыши нажмите на иконку Show Hoop , чтобы выбрать подходящие 
пяльцы. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
В нашем случае мы используем предлагаемые по умолчанию пяльцы ‘artista 255 x 
145 Oval’ . См. также раздел Выбор пялец в руководстве пользователя . 
 
8 Для отключения функции просмотра пялец, нажмите Show Hoop. См. также раздел  
Пяльцы и сетки в руководстве пользователя. 
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Добавление текста  
 

 
С помощью функции Lettering (панель оцифровки (Digitize toolbar)) добавьте 
текст прямо на экране. 

 
Чтобы изменить форматирование текста, используйте функцию Reshape 
Object (панель редактирования (Edit toolbar)). 

 
 
 
Мы теперь уже готовы к тому, чтобы добавить в нашу конструкцию текст. 

 
Как добавить текст: 
 
1  В режиме  Embroidery Canvas с помощью правой клавиши мыши найдите инструмент 
Lettering. Откроется диалог свойств объекта Object Properties. 

 
 
 
 

 
Введите  

текст  
 

Выберите  
шрифт 

 
 
 
 
 

Выберите  
базовую линию 

 
 
 
 
 
 
 
 

2  Введите текст – в нашем примере это -  ‘I want to be a musician!’ – и выберите шрифт из 
выпадающего списка Alphabet. . См. также раздел Добавление текста к проектам 
вышивки в руководстве пользователя. 
 
3 Для подготовки базовой линии, выберите функцию Any Shape (любой образец) и нажмите 
Apply (применить). 
См. также раздел Применение базовых линий текста в руководстве пользователя. 
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4 Начинается оцифровка  базовой линии. Для завершения процесса нажмите Enter. 
 
 
 

 
 
 
 
 
5 Используйте функцию Reshape Object , чтобы изменить настройки базовой линии. 
См. также раздел Изменение базовых линий текста в руководстве пользователя 
 
 
 
 
 
 
 
 
 
 
 
Подсказка: С помощью клавиш – стрелок вы можете поместить текст в нужном месте. 
См. также раздел Позиционирование объектов  в руководстве пользователя. 
 

 
 
Вставка образца 
 
 
 

Щелкните по кнопке Color Film (панель General), чтобы можете 
изменить последовательность объектов путем изменения их 
положения в окне Color   Film. Перетаскивайте значки объектов  для 
изменения последовательности.  

 
Щелкните по кнопке Show Individual  Objects (панель Color Film), 
чтобы просмотреть индивидуальные объекты в порядке 
последовательности  

   вышивания.  Перетаскивайте значки    объектов для изменения  
   последовательности.  

 

Оцифруйте  
основную  
линию и нажмите  
ввод (Enter) 

С помощью инструмента  
форматирования объекта  
(Reshape Object), настройте 
 параметры базовой линии 
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Нажмите Ctrl + U для 
разгруппировки 
объектов 

Теперь мы попробуем вставить предварительно подготовленные образцы вышивки в наш 
проект. 
 
Чтобы вставить образец: 
 
1 Оставаясь в режиме  Embroidery Canvas, перейдите в раздел меню File и выберите 
Insert Design (вставить образец). 
Откроется диалог  Open (открыть). 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2 Вернитесь в папку Tutorials > MultiMedium и найдите файл с вышивкой  ‘Music Notes’. 
 
3 Нажмите «открыть» (Open). 
Образец откроется в текущем окне редактирования (Design Window). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4 Нажмите Ctrl + U для разгруппировки объектов. 

Выберите тип файла 
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Используйте активные точки для  
изменения размеров, положения 
и ориентации фрагментов. 

 
5 Перетащите их мышью в те положения, что показаны на рисунке. Используйте 
активные точки для изменения размеров, положения и ориентации фрагментов. См. 
также раздел Расположение и трансформация объектов в руководстве 
пользователя. 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6 Поменяйте цвета на те, что хотите. 
 

 
 

7 В завершение проверьте последовательность объектов проекта с помощью 
инструмента Color Film (цветная анимация) и поменяйте последовательность как 
показано на рисунке. См. также раздел Изменение последовательности объектов 
инструментом Color Film 
в руководстве пользователя. 
 

Используйте 
функцию Color 
Film для 
изменения 
последовательнос
ти объектов, как 
показано на 
рисунке 
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Вставка фотографии 
 

 
 
Для загрузки графики – точечной или векторной - следуйте пути Image > 
Load Picture – в программе BERNINA Embroidery Software. 
      
 
В режиме Art Canvas, на панели инструментов View Mode имеется кнопка  
Show Embroidery (показать вышивку), которая включает и отключает 
дисплей отображения   вышивки. 
 
 
 

Теперь мы готовы вставить фотографию и расположить ее где надо в рамках нашей 
картинки вышивки. 
 
Для вставки фотографии 
 
1 Переключаемся в режим Art Canvas. 
 
2 Нажимаем Load Picture (загрузка картинки) на панели инструментов Image. 
Открывается диалог Import. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3 Вернемся в папку Tutorials > MultiMedium и выберем фотографию молодого 
музыканта (‘Young Musician’). 
 
4 Нажмите Import.  
Рисунок отображается в окне редактирования (Design Window). 

Выбрать фотографию 
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5 Используйте активные точки для изменения размеров фотографии или задайте ее 
точные размеры с помощью панели свойств (Property Bar). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Как разместить фотографию в общем рисунке. 
 
1 Отключите экран отображения вышивки с помощью кнопки Show Embroidery на 
панели инструментов View Mode. 
 
2 С выбранной фотографией, перейдите в меню Effects и выберите раздел PowerClip > 
Place Inside Container. 
 

 
3 Поставьте курсор на рамку картинки и нажмите клавишу мыши. 

Введите точные или 
относительные 
размеры  

С помощью активных 
точек вы можете изменить 
ее размер.  

Выберите 
размещение 
фотографии 
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Фотография будет автоматически вставлена и отцентрована. 

 
 

 
 
4 Если вам кажется, что фотография поместилась не слишком удачно, вернитесь в 
меню Effects > PowerClip > Edit Contents и поменяйте ии размеры и расположение так, 
как считаете нужным.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
5 Если результат вас удовлетворяет, пройдите в раздел меню Effects > PowerClip > 
Finish Editing This Level. 

Перетяните рисунок  

Поставьте курсор на 
рамку рисунка и нажмите 
клавишу мыши
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6 Включите снова отображение вышивки с помощью кнопки Show Embroidery и 
проверьте результат. 

 
 

 
Подсказка: С помощью функции Object Manager вы можете переместить фотографию 
на передний план над рисунком, изображающим пианино. 
 
 
 

Выравнивание вышивки и цифровой печати 
 

С помощью функции просмотра рисунков перед печатью Print Preview 
(главная панель инструментов) можно просмотреть рисунок.  

 
С помощью кнопки Print («Печать») на главной панели инструментов 
запустите печать рисунка. 

 
 
 
Чтобы обеспечить точное выравнивание цифрового рисунка и вышивки, нужно указать в 
программе BERNINA Embroidery Software с какой точки начать вышивать эту часть 
общей конструкции. Для этого надо распечатать пробную копию и выровнять  ткань с 
рисунком на пяльцах по центру общего образца. См. также раздел Распечатка 
проектов  в руководстве пользователя. 
 
Для выравнивания вышивки и цифровой печати 

 
1 Вернитесь в режим Embroidery Canvas. 
 
Внимание:  При отображении на экране векторного графического рисунка, фотографии 
в рамке ‘PowerClip’ не отображаются. 

Перетащите фотографию  
на передний план над 
 рисунком 
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2 Отключите функцию Artistic View и проверьте начальную и конечную точки 
с помощью функции Travel или инструмента Slow Redraw. Подробности описаны в 
разделе Просмотр последовательности вышивания отдельных фрагментов  в  
руководстве пользователя. 
 

   

 
 

3 Нажмите кнопку предварительного просмотра перед печатью Print Preview. 
На экране отобразится соответствующий диалог. 
 

           
 

4 Выберите ориентацию рисунка Landscape (альбомная) и нажмите кнопку Options. 

Выберите 
ориентацию 
рисунка 
Landscape 
(альбомная) 
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Откроется диалоговый экран «Параметры печати» (Print Options). 
 
 
 
 
 

Отпечатайте  
весь рисунок  

или отдельные  
объекты 

 
 
 
 

Выберите  
элементы  

вышивки для  
печати 

 
 
 
 
 
 
 
 
 
 
 
5 Укажите желаемые свойства и нажмите OK. Подробности описаны в разделе 
Настройка опций печати для вышивания в руководстве пользователя в 
руководстве. 
 
6 Нажмите кнопку запуска печати Print Now и распечатайте пробную копию (worksheet). 
Используйте ее для того, чтобы выровнять ткань с рисунком по центру общего образца 
на пяльцах. 
 

 
 
Начало изготовления образца 

 
Теперь мы подошли к тому, чтобы запустить изготовление нашего образца.  Это дело 
приятное, но тут есть некоторые тонкости. Сначала нужно отпечатать графическую 
часть образца.  В учебных целях будем считать, что мы используем  переводную бумагу 
и обычный цветной принтер. На переводной бумаге рисунки при печати отображаются 
зеркально, после чего рисунок переводится на швейное изделие с помощью утюга. 
После этого, ткань с рисунком должна быть правильно выровнена и отцентрована на 
пяльцах для вышивки. Немного попрактиковавшись, вы быстро научитесь это делать. 
 
Подсказка: Для получения более профессиональных результатов, вы можете 
воспользоваться услугами мастерской цифровой печати, где рисунок нанесут 
непосредственно на швейное изделие (direct-to-garment (DTG) printing) с помощью 
специального принтера. 
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Печать графической части образца 
 

Используйте функцию Art Canvas > View Mode > Show Embroidery 
 

Используйте функцию Standard > Print для печати образца в режиме Art 
Canvas. 

 
Используйте функцию General > Show Vectors для включения/отключения 
отображения векторной графики. 

 
Используйте функцию General > Show Hoop Vectors для включения/ 
отключения отображения пялец. 

 
 
 
Для изготовления образца сначала требуется отпечатать фоновый рисунок. Для этого 
следует спрятать изображение вышивки, если вы не хотите все время включать-
отключать ее отображение. При использовании переводной бумаги изображение 
необходимо сначала отобразить зеркально. Проверьте, какие опции существуют для 
этого в вашем принтере и используйте одну из них для зеркальной печати.  
 
Подсказка: Если у вас нет своего цифрового принтера, вы можете воспользоваться 
услугами профессиональной мастерской, сохранив предварительно готовый к печати 
рисунок в качестве файла с помощью функций File > Export > Save As Type > ... . 
 
 
Чтобы распечатать графическую часть образца 
1 Вернитесь в режим Art Canvas и отключите функцию отображения вышивки кнопкой 
Show Embroidery. В окне редактирования будет отображаться только графическая 
часть конструкции. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Отпечатайте 
только 
отображаемую 
часть образца 

Переключите 
кнопку 
отображения 
вышивки Show 
Embroidery 
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2 Нажмите кнопку «Печать» (Print) на стандартной панели инструментов. Откроется 
диалоговое окно печати. 
 

 
 
Нажмите для предварительного 
просмотра части рисунка, выводимой на  
печать 
 
3 Для предварительного просмотра рисунка воспользуйтесь кнопкой Preview. 

 
4 Используя стандартные функции печати программы CorelDRAW®, вы можете 
отпечатать рисунок на переводную бумагу или прямо на ткань, если у вас есть доступ к 
специальному принтеру для печати прямо на ткани. 
 
Подсказка: если вы используете переводную бумагу, воспользуйтесь функцией 
«Свойства» (Properties) , чтобы просмотреть возможности драйвера принтера. Если 
среди них есть функция выбора переводной бумаги для нанесения рисунка на майку, 
рисунок автоматически отобразится зеркально.  
Если нет – включите опцию зеркального отображения при печати. 
 

Изготовление вышиваемой части образца 
 

 
Отображение векторной графики можно включать/отключать с 
помощью кнопки Show Vectors на главной панели инструментов. 
 
 
С помощью функции General > Write to Machine отправьте образец в 
машину.  
 
 

Нажмите чтобы просмотреть  
возможности драйвера принтера 
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Теперь остается самая волнующая часть работы – нанесение вышивки поверх рисунка.  
Для начала необходимо убедиться, что графический рисунок отцентрован в точности по 
центру пялец, как на пробном образце (worksheet). 
 

 
 
 
Чтобы выполнить вышивку 
1 Перейдите в режим Embroidery Canvas и отключите функцию отображения векторной 
графики Show Vectors. 
На экране будет отображаться только вышиваемая часть образца. 
 

     

 

На экране отображается 
только вышиваемая часть 
образца 
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2 Поместите ткань с рисунком в выбранные пяльцы и отцентруйте с помощью 
наложения пробного рисунка (worksheet). 
 
Отцентруйте рисунок по центру пялец 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
3 Для запуска вышивки нажмите кнопку Write to Machine на главной панели 
инструментов. Если подсоединение к машине работает, откроется диалоговое окно 
записи в систему вышивки Write to Embroidery System. Имя и пиктограмма вашего 
образца будут отображены. Подробности описаны в разделе «Вышивание образцов» 
в Руководстве пользователя.  
 
4 Нажмите кнопку вышивания выбранного образца Stitch out Selected Design. 
Откроется диалоговое окно записи файлов на устройство Writing file(s) to device, а 
также подтверждающее сообщение. Образец отправлен на швейную машину и готов к 
вышивке.  
Внимание:  Если вы выровняли положение иглы точно по центру образца, вышивка 
должна идеально совпасть на ткани с нанесенным цифровым рисунком.  
 
 

Наложите сверху пробный 
рисунок, чтобы 
удостовериться, что 
 графическая часть образца  
отцентрована точно по 
середине пялец.  

Вышивка должна 
идеально 
совпасть с 
нанесенным 
цифровым 
рисунком. 
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ГЛАВА 13 
 

УЧЕБНОЕ ПОСОБИЕ ПО 
ЗАКРЕПЛЕНИЮ ПРОЕКТОВ В 

ПЯЛЬЦАХ 
------------------------------------------- 
 

Перед вышиванием на 
машине материал 
должен быть растянут в 
пяльцах. Программный 
пакет BERNINA 
Embroidery Software 
предлагает вам на 
выбор широкий 
диапазон стандартных 
пялец. Если в ваш 
проект входит крупный 
объект или большое 
количество небольших 
объектов, вам может 
потребоваться 
использовать технику 
перезаправки пялец.   
 
 
 

С помощью этого 
пособия вы узнаете, какую огромную помощь может оказать вам программа 
BERNINA Embroidery Software при использовании техники перезаправки пялец. 
Программа имеет специальный режим Hoop Layout , с помощью которого можно 
создавать проекты, вышиваемые с использованием многократной перезаправки 
пялец. То есть – вы сможете создавать крупные вышивки, не помещающиеся в 
рамки одних пялец. Их надо просто разделить на компоненты, каждый из которых 
помещается в пяльцы, и вышивать последовательно один за другим. Компоненты 
можно непосредственно отправить на машину или сохранить в файл. Все шаги, 
которые потребуется выполнить для изготовления проекта, описаны в данном 
учебном пособии. Тем не менее, вы можете дополнительно воспользоваться 
экранной системой помощи.  

 
Первые шаги 

 

Используйте режим Art Canvas  для обработки рисунка для                                     
автоматического  оцифровывания. 

 
 
Нажмите кнопку Open (панель General), чтобы открыть существующий 
проект. 
 
Для отображения пялец нажмите кнопку Show Hoop (панель General). 
Щелчок правой кнопкой мыши позволяет изменить  настройки. 
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Для целей нашего учебного пособия мы будем вышивать проект на пяльцах ‘artista 130 x 
100 Normal’ . Эти пяльцы несколько маловаты для нашего проекта, который имеет размер 
примерно 156 x 197 мм. Так что нам неизбежно придется прибегнуть к технике 
перезаправки пялец. 
 
Для создания этого проекта мы использовали образцы вышивки, входящие в коллекцию 
программы BERNINA Embroidery Software. В ваш программный пакет BERNINA Embroidery 
Software включена коллекция оригиналов и вышивок, которые вы можете использовать для 
создания первых собственных проектов. В дополнение к коллекции образцов проектов вы 
найдете выделенную папку "Tutorials", которая содержит все файлы дополнений к этому и 
другим учебным пособиям. Конечный результат этого и других проектов также находится в 
этой папке. Вы можете захотеть просмотреть файл завершенного проекта до и/или после 
ознакомления с учебным пособием. См. также раздел Работа с файлами проектов. 
 
 
Как начать работу 
 

1 Дважды щелкните мышью по ярлыку BERNINA Embroidery Software на рабочем столе MS 

Windows®. 

2  В режиме Embroidery Canvas щелкните по кнопке Open (Открыть)  (General Toolbar).  
Откроется диалоговое окно Open. 

 
 
Выберите 
папку 
 
Выберите 
файл 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3  Выберите папку ..\My Designs\Tutorials\MultiHooping из списка Look In. 
4  В поле Files of type (Тип файла) выберите Art Files, чтобы просмотреть все файлы с 

изображениями в этой папке.  
5  Выберите файл 'MultiHoopDesign_Start' и щелкните по Open (Открыть). 
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6  Щелкните правой кнопкой мыши по значку Show Hoop (Показать пяльцы).  

Появится диалоговое окно Options > Hoop.  
 
Совет: В каждом проекте можно использовать пяльцы только одного размера, так что нужно 
выбирать такие пяльцы, в которых разместится самый крупный объект проекта. 
 

 
7  Проверьте, что «artista 130 x 100 Normal“ было выбрано.  
 
8  Увеличьте изображение, чтобы лучше видеть пяльцы – выберите инструмент Zoom Box и  
    щелкните по проекту правой кнопкой мыши.  
 

Совет: Если вы уже выбрали пяльцы, вы можете отображать или скрывать их, щелкая по 
кнопке Show Hoop. 
 

9  Выберите File (Файл)> Save As (Сохранить как …).  

Выберите  
artista 130 x 100 
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Откроется диалоговое окно Save As. 
 

 

 
 
 

Совет: В диалоговом окне Save As открывается та же папка, в которой сохраняется 
оригинальный файл. 

15  В поле File name введите подходящее имя, например 'MultiHoopTutorial“ и щелкните по 
кнопке Save (Сохранить). 

 
Совет: Впоследствии для сохранения любых изменений вам потребуется щелкнуть по 
кнопке Save или нажать клавиши Ctrl+S. 

 
Вышивание с перезаправкой пялец 
 
Прежде чем начать практически рассчитывать положения пялец, давайте займемся немного 
теорией. После того, как вы закончите проект, вам, возможно, захочется еще раз вернуться к 
этому разделу и перечитать его с учетом накопленного практического опыта. Итак… 
 
 
Когда программа BERNINA Embroidery Software просчитывает последовательность вышивки, 
она старается разбить все объекты на ряд последовательных стадий с перезаправкой пялец. 
Если один объект вышивки перекрывает другой, то объект заднего плана должен вышиваться 
раньше, чем объект переднего плана.   
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Держа это в уме, постарайтесь добиться того, чтобы: 
• Каждая следующая позиция пялец перекрывала вышивку, прошитую при 

предшествующем положении пялец. 
• Положения пялец максимально соответствовали последовательности расположения 

объектов вышивки. Это сократит  число возможных перезаправок. 
 
Отметим: Перезаправка (‘Hooping’) – это не то же самое, что «позиция пялец». Может 
оказаться, что перезаправок будет больше, чем позиций пялец.  Однако, никогда их не 
может быть меньше. Другими словами, для обеспечения нужной последовательности 
вышивки, одной позиции пялец может соответствовать более чем одна перезаправка 
пялец ( hoping). 
 
 
Последовательность заправки пялец 
 
Если крупный проект требует использования техники перезаправки пялец, важно 
установить такую последовательность вышивания, чтобы объекты переднего плана 
вышивались после объектов заднего плана. Программы BERNINA Embroidery Software 
позволяет настраивать положение и последовательность пялец.  

Проверьте  
последовательность  
вышивки объектов  
перед расчетом  
последовательности  
перезаправки пялец. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Заметьте:  
при трех  
позициях пялец  
будет 5  
перезаправок. 
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Пяльцы кодируются цветом в соответствии с положением в последовательности 
вышивания: 
 
Пяльц
ы 

Цвет 

1 Темно-зеленый 
2 Синий 
3 Красный 
4 Коричневый 
5 Оранжевый 
6 Фиолетовый 
7 Бирюзовый 
8 Голубой 

 
В маловероятном случае, когда потребуется более восьми перезаправок пялец, эта 
последовательность повторяется, как только будут удалены предыдущие позиции пялец.   
 
 
Проверка последовательности вышивки образца 
 
Знание последовательности объектов образца  поможет вам сконструировать 
оптимальную последовательность перезаправки и положений пялец.  Удобно 
воспользоваться инструментом Color Film в объектном режиме, как показано на рисунке 
выше.  По мере выбора объектов из списка, они выделяются на экране с изображением 
образца. Это помогает понять порядок вышивания объектов, а следовательно и 
последовательность перезаправки пялец.  См. также раздел Просмотр и выделение 
цветных блоков. 

 
 
 
 
 
 
 
 
 
 
 
Проверьте 
последовательность 
вышивания объектов с 
перекрывающимися 
положениями пялец. 
 
 
 

 
 
Другой полезный инструмент -  Slow Redraw. Запуская программу Slow Redraw, вы 
можете проверить, каким образом начальные и конечные точки определенных объектов 
влияют на число перезаправок пялец. Например, если вы разделите большой объект на 
две части так, что его первая часть попадает на вторую позицию пялец, это может 
привести к необходимости дополнительной перезаправки пялец.  
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С помощью функции Slow Redraw, вы можете добиться того, чтобы разделяемые объекты 
разделялись между соседними положениями пялец (как в смысле позиции пялец, так и в 
смысле последовательности вышивания). Объект начинает вышиваться при более ранним 
положении пялец. См. также раздел Моделирование образцов вышивки. 
 
Настройка последовательности объектов образца 
 
Правильно выбранные позиции пялец уменьшают число необходимых перезаправок пялец. 
Иногда последовательность объектов образца может оказаться неоптимальной для 
вышивки с перезаправкой пялец.  В таком случае для уменьшения числа перезаправок 
пялец может потребоваться изменить саму последовательность объектов образца. Общие 
рекомендации  таковы: 
 
• Промышленные образцы, разработанные под одну позицию пялец, обычно 

вышиваются в порядке цветов ниток, чтобы сократить число замен катушек разных 
цветов. Это важно для машин с одной иглой. 

• Увеличение промышленного образца до размеров, требующих перезаправки пялец 
может потребовать изменения последовательности объектов с целью уменьшения 
числа перезаправок. 

• Поскольку все части вышивки должны изготавливаться на пяльцах одного размера, 
выберите такие пяльцы, которые вмещают самый большой из объектов вашего 
образца. 

• Всегда старайтесь максимально согласовать последовательность позиций пялец и 
последовательность объектов вышивки.   

 
Расчет числа перезаправок пялец 
 
Поскольку программа BERNINA Embroidery Software всегда сохраняет исходную 
последовательность вышивания, для уменьшения числа перезаправок пялец нужно, чтобы 
последовательность позиций пялец соответствовала последовательности объектов 
образца. 
 
Время, необходимое для расчета последовательности перезаправок пялец, зависит 
больше от числа объектов вышивки и числа позиций пялец, чем от количества стежков.  
Образцы, преобразованные из форматов EXP, PES, HUS, и т.п., в общем случае 
разбиваются на большее число объектов, чем «родные» образцы программы BERNINA 
Embroidery Software. 
Поэтому время расчета для таких объектов больше. Но даже и для образцов формата 
ART, если образец сложен, велик и требует применения большого числа разных позиций 
пялец, расчет последовательности перезаправок может потребовать заметного времени.  
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Создание проектов, не помещающихся в одних пяльцах 
 

 

Выберите режим Hoop Layout (панель View 
Mode) чтобы переключить на режим Hoop 
Layout.  

 

Используйте кнопку Selection Onp (панель Multi-Hooping), 
чтобы выбрать пяльцы в окне проекта. 

 

Используйте кнопку Add Hoop (панель Multi-Hooping), 
чтобы центровать новые пяльцы в окне проекта в 
вертикальной ориентации.  

 

Используйте кнопку Add Hoop Right (панель Multi-Hooping), 
чтобы поместить новые пяльцы непосредственно 
справа от выбранных пялец с 10-мм перекрытием полей 
вышивания.  

 

Используйте кнопку Add Hoop Up (панель Multi-Hooping), 
чтобы поместить новые пяльцы непосредственно над 
выбранными пяльцами.  

 

Щелкните по кнопке Rotate Hoop (панель Multi-Hooping) 
левой или правой кнопкой мыши, чтобы повернуть 
выбранные пяльцы на 45° по или против часовой 
стрелки.   

 
Программа BERNINA Embroidery Software имеет специальный режим Hoop Layout, 
который позволяет работать с перезаправкой пялец. Вы сможете делать большие 
вышивки, не помещающиеся в одни пяльцы Режим Hoop Layout позволяет определить 
последовательность смены позиций и перезаправки пялец. Цель состоит в том, чтобы 
разработать последовательность вышивки образцов, при которой число перезаправок 
пялец будет минимальным. См. также раздел  Вывод проектов, не помещающихся в 
пяльцах. 
 
 
 
Как определить последовательность смены позиций 
 
 
1 Переключитесь на Hoop Layout. Подробнее см. в разделе  Режимы просмотра. 
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 Если вы введете в окно Hoop Layout объекты, которые полностью помещаются в 

пяльцах, они окрашиваются зеленым цветом. Объекты, которые вышли за контуры 
пялец, окрашиваются черным. 

 

     
 
Примечание: В окне Hoop Layout нельзя выбирать вышивальные объекты или 
манипулировать ими. 
 
 
2 Щелкните Selection On, щелкните по контуру пялец и перетащите их, чтобы в контуры 

пялец поместился самый крупный объект проекта. 
 

 
 
 
 
 
 
 
 
 
Проект не помещается в контурах 
пялец, требуются еще одни пяльцы 
 
 
 
 
 
 
 
 
 

 
3  Используйте инструмент Add Hoop, чтобы добавить дополнительные позиции пялец. 

Файл будет разделен на несколько файлов по числу добавленных пялец. 
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◄ Щелкните по значку Add Hoop, чтобы добавить новые пяльцы в окне Design в 
вертикальной ориентации. 

◄  Используйте кнопку Add Hoop Right, чтобы поместить новые пяльцы 
непосредственно справа от выбранных пялец с 10-мм перекрытием полей 
вышивания.  

◄ Подобным же образом используйте кнопку Add Hoop Up, чтобы поместить новые 
пяльцы непосредственно над выбранными пяльцами. 

 

 
 

 
4 Измените положение дополнительных пялец и, если необходимо, поверните их,  
       чтобы в них вошли все объекты проекта. 
◄  Щелкните по кнопке Rotate Hoop левой или правой кнопкой мыши, чтобы повернуть 

выбранные пяльцы на 45° по или против часовой стрелки.  
◄  Как вариант, щелкните по пяльцам опять и поверните пяльцы с помощью маркеров 

вращения и поворота центральной точки. 
 

5 Перемещайте выбранные пяльцы малыми шагами, используя клавиши со 
стрелками. В данном случае весь проект должен быть вышит 3-мя перезаправками  

6  
 
 
 
 
 

Проект помещается  
в контурах пялец 

Изменение положения  
центральной точки 

 
 
 
 
 
 
Маркер вращения  
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Примечание: Отметим, что хотя наш проект полностью накрывается выбранными 
положениями пялец, некоторые объекты все еще не накрыты правильно, что обозначается на 
экране черными стежками. Если на этом этапе подготовки проекта вы попытаетесь его 
закончить (выполнить output) – программа выдаст сообщение о том, что не все объекты пока 
перекрыты.  На следующих шагах мы увидим, как с этой проблемой справиться. 

 
 

Разбиение объектов по разным позициям пялец 
 
 Используйте кнопку Splitting Guide (панель Multi-Hooping) для оцифровки 
разделительных линий большого образца перед тем, как передать 
информацию в файл, на машину или на карту памяти. 
 
 
Используйте функцию Reshape Splitting Guide (панель Multi-Hooping) для 
перерисовки разделительных  линий в окне проекта Design Window. 
 

 
 Используйте кнопку Calculate Hoopings (панель Multi-Hooping), чтобы 
определить количество перезаправок пялец на основе текущей компоновки 
пялец. 
 
 

 
Инструмент Splitting Guide позволяет разделять отдельные объекты, которые иначе не 
влезают в пяльцы. Фактически, вы можете нарисовать и оцифровать на вашем большом 
проекте одну или несколько разделительных линий перед тем, как вывести проект в файл, 
в машину или на карту памяти. Хотя разделительные линии отображаются на экране 
только в режиме Hoop Layout, в других режимах они тоже учитываются. Разделительные 
линии не нарушают целостности объектов и вы по-прежнему можете их преобразовывать и 
трансформировать.  
 

 
 
Для того, чтобы выполнить разбиение объектов по разным позициям 
пялец 
1 Выберите режим Hoop Layout. 
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Хотя наш проект полностью накрывается тремя выбранными положениями пялец, 
некоторые объекты, которые не попадают полностью под одни пяльцы, обозначаются 
на экране черными стежками.  
 

 
 
 
2 Выберите инструмент Splitting Guide. 
На перекрытиях вышиваемых полей вам надо указать начальную точку разделительной 
линии. 
 

 
 
 
 
 
 
 
 
 
Оцифровка разделительных линий производится 
также, как для незамкнутых кривых линий. 
 
 
 
 
 
 
 

 
3 Оцифровка разделительных линий производится также, как для незамкнутых кривых 
линий. Для кривых используется правая клавиша мыши. Для угловых точек – левая.  
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Поскольку разделение производится в пределах зоны перекрытия соседних положений 
пялец, разделенные части объекта покрываются одними пяльцами и помечаются на экране 
зеленым цветом.  

 
Линии, полностью пересекающие неучтенный пока объект, при сохранении (выводе) 
проекта станут разделительными. Разделение не обязательно будет сделано строго по 
оцифрованным линиями. Программа постарается сделать разделительные линии 
максимально  
незаметными. Объекты при этом сохраняют свой тип, угол вышивки стежков, параметры и 
цвет.   
 
4 Повторите прежние действия или нажмите Enter для завершения работы. 
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7  После этого используйте кнопку Calculate Hoopings, чтобы определить количество 
перезаправок пялец на основе текущей компоновки пялец. 
 

 
 
 
 Мы теперь готовы к тому, чтобы сохранить проект в одном или нескольких файлах или 

передать их в машину. Распечатайте копию проекта, показывающую положение пялец, 
чтобы при вышивании иметь представление о порядке перезаправки пялец. 

 
Примечание: в нашем проекте при использовании выбранных пялец оптимальным 
будет выполнить пять (5) перезаправок пялец, если не использовать функцию 
изменения последовательности выполнения проекта. 
 
 
Печать крупных проектов 
 
Если ваш проект не помещается в одних пяльцах, есть возможность распечатать вид 
пялец в много-пяльцевом режиме с сохранением правильной последовательности цветов. 
Функция Hooping Sequence позволяет получить распечатку типа Color Film, 
показывающую объекты в каждых пяльцах. См. также раздел Создание проектов, не 
помещающихся в одних пяльцах. 
 
 
Чтобы распечатать образец, занимающий несколько пялец: 
 
1 Выберите пункт меню File > Print Preview. 
 
2 Нажмите кнопку Options. 
Откроется диалог возможностей печати Print Options. 
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3   Выберите опцию Hooping Sequence (последовательность пялец). 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Выберите  
опцию  

Hooping  
Sequence 

 
 
 
 
4   Выберите опцию Actual Size и щелкните по ОК. 
 

 
 
Объекты показаны для каждых пялец и следующая информация отображается на 
следующей странице.  
Примечание: отображается та же самая информация, что и в диалоге 
Hooping Sequence. См. раздел Сохранение проектов, не помещающихся в пяльцах. 
 

Выберите опцию 
Actual Size 
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5  Щелкните по кнопке Print. 
 
6 Наложите распечатку на ткань, и с ее помощью отметьте на ткани мелом или 
смываемыми чернилами положения центров пялец. 
 

 
 
Совет:  При работе с перезаправкой пялец у вас может образоваться множество пометок на 
ткани, что может вызвать затруднения. Удобно помечать пометки по номерам положений пялец 
маленькими наклейками. Это поможет сравнивать пометки с правильным шаблоном на 
странице 2. 

Пометьте центры 
положений пялец 
мелком 

Пометьте мелком также 
центральные линии 
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Сохранение и вывод проектов, не помещающихся в пяльцах 
 
 
При выводе проектов, размер которых больше размеров пялец,  каждая часть 
вышивается отдельно после перезаправки ткани в пяльцах. 
При сохранении таких проектов в файл или при отправке их на машину, сохраняются 
положения перезаправки пялец и линии раздела. Включается режим 
последовательности перезаправки пялец (Hooping Sequence mode), где отображаются 
отдельные положения пялец.  
Совет: при использовании техники перезаправки пялец рекомендуется использовать 
самоклеящийся или приглаживаемый утюгом стабилизатор, который потом можно 
удалить. Стабилизатор должен быть достаточно плотным, чтобы не порваться при 
прошивании контрольных точек.  
 
Сохранение проектов, не помещающихся в пяльцах 
 
Если для вашего проекта требуется больше одних пялец, вы можете разделить проект на 
несколько файлов для каждой позиции заправки пялец. Программа автоматически 
определит, какие файлы надо сохранить и отобразит содержимое сохраненных файлов.  
См. также Закрепление в пяльцах крупных проектов.  
 
 
Как сохранить проект, не помещающийся в одних пяльцах  
 
1  Выберите режим «Hoop Layout“.  
 
2  Выберите File (Файл)> Save As (Сохранить как…). 
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Появится стандартное диалоговое окно MS Windows® Save As (Сохранить как…), 
позволяющее перейти к любой папке, выбрать любое имя для экспортируемого файла и 
выбрать формат файла из выпадающего списка. 
 

 
 
3  Измените имя файла, если требуется, выберите папку и/или формат файла и щелкните 

по Save. 
 

Если имеется больше одной позиции пялец, вам будет предложено расчленить проект  
на несколько файлов или экспортировать все в виде единственного файла. 

 

 
 
 
4  Щелкните по Yes.  
Система проверит, охватываются ли все вышивальные объекты. Вы будете 
предупреждены, если не все объекты помещаются в пяльцах. В другом случае все 
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перезаправки пялец, требуемые для вышивания проекта, пересчитываются и 
отображаются в диалоговом окне Hooping Sequence (Последовательность заправки 
пялец). Позиции перезаправки именуются как файлы с выбранным расширением. 
 

 
 
 
5  Выберите позицию заправки пялец и щелкните по Save. 
 
 
Все вышивальные объекты, ассоциированные с выбранной  позицией заправки пялец, 
сохраняются в файле с указанным  в списке именем. Как вариант, щелкните по Save All 
(Сохранить все).  
Все файлы в списке сохраняются со своими именами. 
 

 
 
4 Нажмите «закрыть» (Close). 
Программа BERNINA Embroidery Software выходит из режимаHooping Sequence и 
отображает проект в окне редактирования (Design Window) в исходном виде – с 
разделительными линиями, но объекты при этом не разделены. 
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Передача не помещающихся в пяльцах проектов в машину 

 
Используйте инструмент Write to Machine (панель General),  
чтобы передать проект в машину.  

 
Вы можете передать в машину или на карту памяти один или несколько вышивальных 
файлов крупного, не помещающегося в пяльцах проекта. Программное обеспечение 
автоматически рассчитает, какие файлы должны быть направлены в машину и покажет, как 
они будут выглядеть. См. также  
Закрепление в пяльцах крупных проектов.  
 

Как передать не помещающийся в пяльцах проект в машину 
 
1  Выберите режим Hoop Layout. 
 
2  Убедитесь в правильном подключении вышивальной машины или модуль считывания 

карт.  
 

 
 
 
3  Щелкните по кнопке Write to Machine (Передать в машину). 
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 Система проверит, имеются ли только одни пяльцы в проекте и охватываются ли все 

объекты. Все перезаправки пялец, требуемые для вышивания проекта, отображаются в 
режиме Hooping Sequence.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4  Выберите любую позицию заправки пялец в списке. 
 Выбранная позиция заправки показывается пунктирной линией, оконтуренной сплошной 

линией, тогда как остальные позиции показываются только пунктирными линиями. 
Объекты внутри выделенной позиции перезаправки показываются с фактическим 
цветом стежков. Объекты, которые должны быть вышиты вначале или позже 
показываются соответственно серыми или светло-серыми контурами. 

 
5  Щелкните по кнопке Send Now (Переслать сейчас). 
 Система выдаст файл, содержащий все, что должно быть вышито в текущей позиции 

заправки пялец. 
 
 
Совет: При вышивании в каждом из положении пялец обращайте внимание на 
контрольные отметки, прошиваемые при последней смене цвета ниток. Они помогут 
выровнять положение пялец после перезаправки. 

Список 
заправок пялец 

текущего 
проекта

 
 
Цвета позиции
заправки пялец 
соответствуют 

цветам 
отображения 

пялец

Объекты, 
подлежащие 
вышиванию после 
этой перезаправки 
пялец, отображаются 
светло-серыми 
линиями

Объекты, уже 
вышитые перед этой 
перезаправкой пялец, 
отображены темно-
серыми линиями 

Объекты, 
вышиваемые в 
текущей позиции 
заправки пялец, 
отображаются в 
фактическом цвете 
стежков 
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6  Повторяйте эту операцию столько раз, сколько требуется для передачи всех позиций  
    заправки пялец. 

 
 
При выравнивании положений пялец: 

• Чтобы точно найти центр позиции пялец, используйте пометки, сделанные 
мелком, в сочетании с шаблоном Bernina hoop template. 

• Чтобы точно выровнять положение пялец относительно ткани, используйте 
намеченные мелком центральные линии. 

 
 
Совет: После каждой перезаправки пялец, поместите их в вышивальную машину и 
прошейте первую перемену цвета ниток. Это даст набор контрольных отметок, 
которые должны согласоваться с отметками, прошитыми при предыдущих заправках 
пялец. Это еще одна возможность проверить правильность выравнивания пялец.  
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ЧАСТЬ III 
 

СПИСОК ФУНКЦИЙ 

ВЫШИВАЛЬНОГО ПО 

BERNINA 
------------------------------------------ 
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Список функций вышивального программного обеспечения BERNINA  
 
Возможность Название 

функции EditorPlus DesignerPlus Соответствующие темы в экранном 
руководстве 

Основы     "Основные процедуры" 
Открытие проектов из ПК     "Открытие проектов" 
Открытие составных 
проектов     "Открытие проектов" 

Создание проектов 
(шаблонов)      "Запуск новых проектов" 

Сохранение проектов     "Сохранение проектов" 
Отображение пялец и 
сетки     "Пяльцы и сетки" 

Измерение расстояний на 
экране     "Измерение расстояний на экране" 

Отмена команды и 
восстановление действия 
отмененной команды 

Undo/Redo    "Отмена и повторение отмененных 
команд" 

Перемещение/Размещение 
панелей инструментов     "Перемещение и установка панелей 

инструментов" 
Доступ к свойствам 
объекта 
 

   "Доступ к свойствам объекта“ 
 

Просмотр проектов     "Просмотр проектов" 
Просмотр проектов в 
режиме Art Canvas  Art Canvas ∆ ∆ "Режим дизайна Art Canvas“ 

Просмотр проектов в 
режиме Embroidery Canvas 

Embroidery 
Canvas 

∆ ∆ "Режим вышивания Embroidery Canvas“ 

Просмотр проектов в 
режиме Hoop Layout 

Hoop 
Layout 

 ∆ "Режим Hoop Layout" 

Просмотр вида вышивки Artistic 
View   Просмотр вида вышивки 

Просмотр стежков 
вышивки Stitch View   Просмотр вида вышивки 

Просмотр точек прокола 
иглой     "Просмотр точек прокола иглой" 

Просмотр стежков и 
контуров    "Просмотр стежков и контуров" 

Просмотр объектов 
проекта в цвете     "Просмотр объектов в цвете" 

Просмотр проектов в 
обзорном окне 

Overview 
Window    "Просмотр проектов в обзорном окне" 

Увеличение и уменьшение 
изображения     "Увеличение и уменьшение 

изображения" 
Просмотр 
последовательности 
вышивания отдельных 
фрагментов 

   

Просмотр последовательности 
вышивания отдельных 
фрагментов 
 

Обход по стежкам    Обход по стежкам 
Моделирование образцов 
вышивки 

Slow 
Redraw   Моделирование образцов 

вышивки 
Отображение или скрытие 
оригинала    Отображение или скрытие оригинала 

Изменение цветов фона 
или ткани     "Изменение фона" 

Просмотр информации о 
проекте     "Просмотр свойств проекта" 

Предварительный 
просмотр проектов     "Предварительный просмотр проектов" 

Выбор объектов    "Выбор объектов" 
Выбор объектов методом 
"указать и щелкнуть" 

Select 
Object    "Выбор объектов методом указать и 

щелкнуть" 
 

 Стандартная функция   ∆ Новая/улучшенная функция    
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Возможность Название 

функции EditorPlus DesignerPlus Соответствующие темы в 
экранном руководстве 

Выбор объектов 
ограничивающим 
прямоугольником 

    
"Выбор объектов 
ограничивающим 
прямоугольником" 

Выбор объектов 
ограничивающим 
многоугольником 

Polygon 
Select     "Выбор объектов инструментом 

Polygon Select" 

Выбор объектов клавишей Tab      "Выбор объектов клавишей Tab" 
Выбор всех объектов в проекте     "Выбор всех объектов в проекте"
Отмена выделения объектов     "Отмена выделения объектов" 
Выбор цветных блоков и 
манипуляция с ними 

Color Film   "Просмотр и выделение цветных 
блоков" 

Работа с пяльцами    "Закрепление проектов в 
пяльцах" 

Отображение пялец     "Выбор пялец" 
Создание проектов не 
помещающихся в пяльцах 

Hoop 
Layout 

 ∆ "Закрепление в пяльцах крупных 
проектов"  

Разбиение объектов по разным 
позициям пялец 

Splitting 
Guide 

 ∆ Разбиение объектов по разным 
позициям пялец 

Создание собственных пялец     "Определение пользовательских 
пялец" 

Настройка собственных пялец    "Настройка собственных пялец" 

Система setup     "Настройка аппаратных и 
программных средств" 

Калибровка монитора     "Калибровка монитора" 
Настройка опций сетки     "Настройка опций сетки" 
Настройка опций 
автоматической прокрутки  ∆ ∆ Настройка опций 

автоматической прокрутки 
Настройка опций пялец     "Настройка опций пялец" 
Настройка опций замкнутого 
объекта аппликации 

Auto 
Appliqué 

  "Настройка опций 
автоаппликации"" 

Настройка опций удаления 
перекрытий 
 

Remove 
Overlaps 

  Настройка опций удаления 
перекрытий 
 

Установка функции 
автоматического сохранения    "Установка функции 

автоматического сохранения" 
Настройка опций отображения 
указателя мыши    "Настройка опций отображения 

положения указателя мыши" 
Установка других общих опций    "Настройка других общих опций"
Методы оцифровки    "Методы оцифровки" 
Переключение между методами 
оцифровки заполнения и 
контура 

 
  "Переключение между методами 

оцифровки заполнения и 
контура" 

Оцифровка открытых фигур Open 
Object  

  "Оцифровка открытых фигур" 

Оцифровка замкнутых фигур Closed 
Object  

  "Оцифровка замкнутых фигур" 

Оцифровка колонок с 
изменяющейся шириной 

Block 
Digitizing  

  "Оцифровка колонок с 
изменяющейся шириной" 

Оцифровка окружностей и 
овалов Circle/Oval   "Оцифровка окружностей и 

овалов" 
Оцифровка квадратов и 
прямоугольников Rectangle   "Оцифровка квадратов и 

прямоугольников" 
Оконтуривающие и 
заполняющие стежки    "Оконтуривающие и 

заполняющие стежки" 

Выбор оконтуривающих стежков    "Выбор оконтуривающих 
стежков" 

Выбор заполняющих стежков    "Выбор заполняющих стежков" 
 

 Стандартная функция   ∆ Новая/улучшенная функция    
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Возможность Название 
функции EditorPlus DesignerPlus Соответствующие темы в 

экранном руководстве 

Создание контуров 
одинарным/тройным стежком Single/Triple

  "Создание контуров одинарным и 
тройным оконтуривающим 
стежком" 

Создание контуров гладьевым 
валиком Satin    "Создание контуров стежком 

гладьевого валика" 
Создание контуров  
краеобметочным стежком Blanket    "Создание контуров 

краеобметочным стежком" 
Создание заполнения 
гладьевыми стежками Satin Fill    "Создание заполнения 

гладьевыми стежками" 
Создание заполнения 
простегивающими стежками Step Fill    "Создание заполнения 

простегивающими стежками" 
Изменение узоров 
простегивающих стежков Step Pattern   "Применение узоров 

простегивающих стежков" 
Цвета ниток и таблицы ниток   Цвета ниток и таблицы ниток 

Изменение цвета ниток     "Изменение цвета ниток" 
Изменение цвета выбранных 
объектов    Изменение цвета выбранных 

объектов 
Поиск и выбор ниток     "Поиск и выбор ниток" 
Подбор и выбор ниток    "Подбор и выбор ниток" 
Изменение цветов всего 
проекта  ∆ ∆ Изменение цветов всего проекта 

Изменение таблиц ниток    "Изменение таблиц ниток" 
Создание пользовательской 
таблицы ниток    "Создание пользовательской 

таблицы ниток" 
Свойства объекта и шаблоны   Свойства объекта и шаблоны 

Настройка текущих свойств 
объекта    "Настройка текущих свойств 

объекта" 

Изменение свойств объекта    "Изменение свойств выбранных 
объектов" 

Изменение стандартных 
свойств объекта    "Изменение стандартных свойств 

объекта" 
Создание шаблонов проекта    "Создание шаблонов проекта" 
Изменение шаблонов проекта    "Изменение шаблонов проекта" 
Сохранение текущих свойств в 
шаблоне    "Сохранение текущих свойств в 

шаблоне" 
Возвращение к шаблону 
NORMAL    "Возвращение к шаблону 

NORMAL" 

Повышение качества вышивания   Повышение качества 
вышивания  

Регулировка настроек ткани    "Регулировка настроек ткани" 
Применение автоматической 
стабилизации ткани    "Стабилизация ткани стежками"  

Применение автоматической 
компенсации стягивания ткани    "Компенсация стягивания ткани" 

Сохранение длинных стежков  Auto Jump   "Сохранение длинных стежков"  
Настройка закрепляющих 
стежков    "Настройка опции закрепляющих 

стежков" 
Настройка автоматических 
начальных и конечных точек 

Auto 
Start/End 

  "Настройка автоматических 
начальных и конечных точек" 

Оцифровка с оригиналом    "Оцифровка с оригиналом" 
Сканирование растровых 
изображений  ∆ ∆ "Сканирование растровых 

изображений" 
Загрузка растровых и 
векторных рисунков  ∆ ∆ "Загрузка изображений" 

Кадрирование изображений 
для оцифровки    "Кадрирование изображений для 

оцифровки" 
 

 Стандартная функция   ∆ Новая/улучшенная функция    



Список функций вышивального ПО BERNINA 

BERNINA Вышивальное программное обеспечение – Краткое справочное руководство 250

 

Возможность Название 
функции EditorPlus DesignerPlus Соответствующие темы в 

экранном руководстве 
Изменение формы 
кадрированных изображений 

Reshape 
Object 

  "Изменение формы 
кадрированных изображений" 

Редактирование изображений 
в пакете графических 
программ  

Touch Up 
Picture 

∆ ∆ Редактирование изображений в 
пакете графических программ 
 

Сохранение оригиналов в 
отдельных файлах    "Сохранение оригиналов в 

отдельных файлах" 
Подготовка не оконтуренных 
изображений 

Image 
Preparation 

∆ ∆ "Подготовка не оконтуренных 
изображений" 

"Подготовка оконтуренных 
изображений" 

Outlined Image 
Preparation 

∆ ∆ "Подготовка оконтуренных 
изображений" 

Автоматическая оцифровка    "Автоматическая оцифровка" 
Преобразование векторных 
рисунков в вышивки 

Convert to 
Embroidery 

∆ ∆ Преобразование векторных 
рисунков в вышивки 
 

Преобразование образца 
вышивки в векторный рисунок 
 

Convert 
Selected 
Embroidery to 
Art Vectors  

 ∆ Преобразование образца 
вышивки в векторный рисунок 
 

Автоматическая оцифровка 
заполненных форм Magic Wand 

  "Автоматическое оцифровка 
заполнения" 

Автоматическая оцифровка 
контуров Magic Wand   "Автоматическая оцифровка 

контуров" 
Автоматическая оцифровка 
всего изображения Auto Digitizer   "Автоматическая оцифровка 

всего изображения" 
Автоматическое создание 
контуров и границ 

Auto Digitizer ∆ ∆ Автоматическое создание 
контуров и границ 

Создание проектов вышивки 
по фотографиям PhotoSnap   "Создание проектов функцией 

PhotoSnap" 

Комбинирование и последовательность 
объектов   

"Комбинирование и 
последовательность 
объектов" 

Вставка объектов 
    Вставка объектов 

Копирование и вставка 
объектов    "Копирование и вставка 

объектов" 
Дублирование объектов 
    "Дублирование объектов" 

Клонирование объектов 
 Quick Clone   "Клонирование объектов" 

Группировка/разгруппировка 
объектов Group/Ungroup   "Группировка и разгруппировка 

объектов" 

Отделение части объекта Break Apart   "Разбивка объектов на 
компоненты" 

Изменение 
последовательности объектов    "Установление 

последовательности объектов" 

Манипулирование цветными 
блоками и объектами Color Film 

∆ ∆ "Установление 
последовательности объектов 
функцией Color Film" 

Автоматическое установление 
последовательности всего 
проекта 

Stitch 
Sequence 

  "Автоматическое установление 
всего проекта" 

Расположение и 
трансформация объектов    "Расположение и 

трансформация объектов" 
Позиционирование объектов    "Позиционирование объектов" 
Выравнивание объектов    "Выравнивание объектов" 
Изменение размеров 

объектов  
  

"Изменение размеров объектов" 

Вращение объектов    "Вращение объектов" 
Перекос объектов    "Перекос объектов" 

 
 Стандартная функция   ∆ Новая/улучшенная функция    
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Возможность Название 
функции EditorPlus DesignerPlus Соответствующие темы в 

экранном руководстве 
Перевод объектов в 
зеркальное отображение    "Перевод объектов в зеркальное 

отображение" 
Зеркальное переворачивание 
с дублированием объектов    "Зеркальное переворачивание с 

дублированием объектов" 

Создание венков    "Создание венков" 

Изменение формы и правка 
объектов    "Изменение формы и правка 

объектов" 

Изменение формы объектов Reshape Object   "Изменение формы объектов" 

Подгонка углов наклона 
стежков  ∆ ∆ "Подгонка углов наклона 

стежков" 
Изменение точек входа и 
выхода    "Изменение точек входа и 

выхода" 

Редактирование стежка    "Редактирование стежков" 

Выбор стежков    "Выбор стежков" 

Вставка стежков    "Вставка стежков" 

Перемещение стежков    "Перемещение стежков" 

Удаление стежков    "Удаление стежков" 

Специальная техника 
оцифровки    "Специальная техника 

оцифровки" 

Создание “ручных”вышивок   ∆ Создание “ручных”вышивок 

Упрочнение контуров    "Упрочнение контуров"  

Вырезание отверстий в 
объектах Add Holes   "Вырезание отверстий в 

объектах" 
Удаление подстилающих 
стежков  

Remove 
Overlaps 

  "Удаление подстилающих 
стежков"  

Заполнение отверстий в 
объектах Fill Holes   "Заполнение отверстий в 

объектах" 
Создание контуров и границ Outline Design  ∆ Создание контуров и границ 

Создание пуговичных петель Add Buttonhole   "Создание пуговичных петель" 

Эффекты художественного 
вышивания    "Эффекты художественного 

вышивания" 
Создание контурного 
заполнения Contour  ∆ Создание контурного 

заполнения 
Создание заполнения 
орнаментными стежками  Fancy Fill   "Создание заполнения 

орнаментными стежками" 
Создание заполнений 
перекрестными стежками Cross Stitch   ∆ Создание заполнений 

перекрестными стежками 
Создание текстурированных 
краев Textured Edge   "Создание текстурированных 

краев" 
Создание эффекта 
волнистости Wave Effect   "Создание эффекта 

волнистости" 
Создание эффекта 
заполнения звездочками   ∆ Создание эффекта заполнения 

звездочками 
Создание заполнения с 
плавным тоновым переходом Gradient Fill   "Создание заполнения с 

плавным тоновым переходом" 
Создание открытых 
заполнений 

Travel on 
Edges 

  "Создание открытых 
заполнений" 

Создание эффекта 
смешивания цветов Color Blending   "Создание эффекта смешивания 

цветов" 
Создание эффектов плавного 
преобразования Morphing   Создание эффектов плавного 

преобразования 
 Стандартная функция   ∆ Новая/улучшенная функция    
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Возможность Название 
функции EditorPlus DesignerPlus Соответствующие темы в 

экранном руководстве 
Оконтуривание и 
заполнение узорами    Узорные штампы, контуры и 

заполнения 
Добавление узорных 
штампов Pattern Stamp   "Добавление узорных штампов" 

Создание цепочки узоров Pattern Run   "Создание узорных контуров" 

Создание узорных 
заполнений Pattern Fill   "Создание узорных заполнений" 

Создание собственных 
комплектов узоров    "Создание собственных 

комплектов узоров" 
Создание узоров фукнкция 
“резной штамп” Carving Stamp  ∆ Функция “резной штамп” 

Оконтуривание и 
заполнение рукодельными 
стежками 

   "Оконтуривание и заполнение 
рукодельными стежками" 

Создание контуров в технике 
"черной вышивки" 
("блэкуорк")  

Blackwork 
Border   "Создание контуров в технике 

"черной вышивки" ("блэкуорк")"  

Создание контуров стежками 
"назад в иголку" ("бэкстич")  Backstitch   "Создание контуров стежками 

"назад в иголку" ("бэкстич")" 
Создание контуров 
стебельчатыми стежками  Stemstitch   "Создание контуров 

стебельчатыми стежками"  
Создание контуров 
узелковым швом 

Candlewicking 
Border   "Создание контуров узелковым 

швом" 
Создание заполнений в 
технике "черной вышивки" 
("блэкуорк")  

Blackwork Fill  
 "Создание заполнений в технике 

"черной вышивки" ("блэкуорк")"  

Создание заполнений 
узелковыми строчками 

Candlewicking 
Fill   "Создание заполнений 

узелковыми строчками" 
Создание заполнения 
стежками кружевного 
переплетения 

Lacework  
 "Создание заполнения стежками 

кружевного переплетения" 

Создание спиральных 
заполнений Ripple  ∆ Создание спиральных 

заполнений 
Создание пунктирного 
заполнения  Stipple  ∆ "Создание пунктирного 

заполнения"  

Аппликации    "Оцифровка для аппликаций" 

Создание аппликаций Auto Applique   "Создание замкнутого объекта 
аппликации" 

Создание частичного 
покрытия объектов 
аппликации 

Partial Applique  
 "Создание частичного покрытия 

объектов аппликации" 

Создание открытого объекта 
аппликации 

Open-Curve 
Applique   "Создание открытого объекта 

аппликации" 

Вышивание текстов    "Вышивание текстов" 

Добавление текста к 
проектам вышивки     "Добавление текста к проектам 

вышивки"  
Создание горизонтальных 
базовых линий    "Создание горизонтальных 

базовых линий" 
Создание вертикальных 
базовых линий    "Создание вертикальных 

базовых линий" 
Создание базовых линий по 
окружности    "Создание базовых линий по 

окружности" 
Создание сложных базовых 
линий    "Создание сложных базовых 

линий" 
Создание пользовательских 
базовых линий    "Создание пользовательских 

базовых линий" 
Формат текста (курсив, 
полужирный, выравнивание)    "Форматирование текста" 

 
 Стандартная функция   ∆ Новая/улучшенная функция    
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Возможность Название 
функции 

EditorPlus DesignerPlus Соответствующие темы в 
экранном руководстве 

Настройка интервалов между 
буквами     "Настройка интервалов" 

Правка текста    Правка текста 

Изменение размеров текста    "Изменение размеров текста" 

Отмена стабилизации для 
небольших букв    "Отмена стабилизации для 

небольших букв" 
Преобразование текстовых 
объектов     "Преобразование текстовых 

объектов" 
Установка положения 
отдельных букв  ∆ ∆ Установка положения отдельных 

букв 
Добавление угла наклона 
стежков к буквам    "Добавление угла наклона 

стежков к буквам" 

Изменение цвета букв    "Изменение цвета букв" 

Текстовые эффекты    Текстовые эффекты 

Преобразование текста в 
вышивку  ∆ ∆ Преобразование текста в 

вышивку 
Конвертирование шрифтов 
TrueType в вышивальные 
шрифты 

 
  "Конвертирование шрифтов 

TrueType в вышивальные 
шрифты" 

Добавление специальных 
шрифтовых знаков и 
символов 

  
  "Добавление специальных 

символов" 

Специальные алфавиты    "Использование специальных 
алфавитов" 

Создание специальных 
эффектов функцией Elastic 
Lettering 

Elastic Lettering
  "Создание специальных 

эффектов функцией Elastic 
Lettering" 

Создание монограмм    "Создание монограмм" 

Создание текста монограммы 
с инициалами Monogramming ∆ ∆ "Создание текста монограммы с 

инициалами" 
Создание текста монограммы 
с именами  ∆ ∆ "Создание текста монограммы с 

именами" 
Добавление орнаментов к 
монограммам    "Добавление орнаментов к 

монограммам" 
Компоновка элементов 
орнамента    Компоновка элементов сложного 

орнамента 
Добавление бордюров к 
монограммам    "Добавление бордюров к 

монограммам" 
Создание собственных 
бордюров    "Создание пользовательских 

базовых линий" 

Обработка проекта    "Обработка и вывод проекта" 

Распечатка проектов    "Предварительный просмотр и 
распечатка проектов" 

Настройка опций распечатки 
проектов     "Настройка опций распечатки 

проектов"  
Распечатка выкроек 
аппликации    "Распечатка выкроек 

аппликации" 
Распечатка таблицы Color 
Film    "Распечатка таблицы Color Film" 

Распечатка проектов, не 
помещающихся в пяльцах  ∆ ∆ Распечатка проектов, не 

помещающихся в пяльцах 

Распечатка таблиц ниток    "Распечатка таблиц ниток" 

Сохранение проектов как 
изображений"    "Сохранение проектов как 

изображений" 

Вышивание проектов    "Вышивание проектов" 

 Стандартная функция   ∆ Новая/улучшенная функция    
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Возможность Название 
функции 

EditorPlus DesignerPlus Соответствующие темы в 
экранном руководстве 

Вывод проектов, не 
помещающихся в пяльцах   ∆ "Вывод проектов, не 

помещающихся в пяльцах" 
Открытие стежковых файлов 
с конвертированием объекта    "Открытие файлов с 

конвертированием" 
Открытие стежковых файлов 
без конвертирования объекта    "Открытие файлов без 

конвертирования" 
Открытие проектов из 
машины    "Считывание проектов из 

машины" 

Запись проектов в машину    "Запись проектов в машину" 

Запись проектов на USB stick    Запись проектов 
непосредственно  на USB stick 

Сохранение проектов 
функцией Magic Box    "Сохранение проектов функцией 

Magic Box" 
Сохранение проектов в 
формате PES     "Сохранение проектов в 

формате PES"  

Управление проектом    "Управление проектом" 

Обзор проектов в папках    "Обзор проектов в папках" 

Просмотр архивированных 
проектов в папках    "Просмотр архивированных 

проектов" 
Определение 
местоположения 
отсутствующих файлов 

 
  "Определение местоположения 

отсутствующих файлов" 

Изменение региональных 
установок    "Изменение региональных 

установок" 
Открытие проектов в 
BERNINA Embroidery Software    "Открытие проектов в BERNINA 

Embroidery Software" 
Создание новых проектов с 
шаблонами пользователя    "Создание новых проектов с 

шаблонами пользователя" 
Запуск простой и сложной 
сортировки    "Сортировка файлов в папках" 

Распечатка проектов    "Распечатка проектов из 
приложения BERNINA Portfolio" 

Распечатка каталогов 
проектов    "Распечатка каталогов проектов"

Вышивание проектов    "Вышивание проектов" 

Конвертирование файлов 
проектов    "Конвертирование файлов 

проектов" 
Архивирование файлов 
проектов    "Архивирование файлов 

проектов" 
Систематизация проектов в 
папках    "Систематизация проектов в 

папках" 
 
 

 Стандартная функция   ∆ Новая/улучшенная функция    
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ЧАСТЬ IV 
 

КРАТКИЙ СПРАВОЧНИК 
-------------------------------------------
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Краткий справочник по вышивальному 
программному обеспечению BERNINA 
Embroidery Software 
 
Режим вышивания - Embroidery Canvas 

 
 
 
 
 

Режим позволяет оцифровывать и 
редактировать образцы вышивки. 
Показывает как образцы вышивки, так и 
графические заготовки. Дает 
возможность просматривать образцы 
реалистически в трехмерной графике 3D 
 
Программа BERNINA Embroidery Software 
интегрируется с программой CorelDRAW® 
Essentials 4 , образуя единое приложение.  
Приложение имеет общее рабочее пространство 

(‘Design Window’), но работать в этом 
пространстве можно в двух разных режимах:  
Art Canvas (для дизайнерской работы) и 
Embroidery Canvas (для вышивок). Третий 
режим, Hoop Layout, предназначен для работы 
с большими проектами, не помещающимися в 
пяльцах.   
 
В этом кратком справочнике подробно 
описываются все опции меню и панелей 
инструментов, имеющиеся в режиме Embroidery 
Canvas. Не все описанные здесь опции имеются 
во всех уровнях продукта. См. также Список 
функций программного продукта. 
 
Окно Embroidery Canvas Design 
Design  
 
На показанном внизу экране отображены в 
развернутом виде все панели инструментов 
приложения BERNINA DesignerPlus.в окне 
Embroidery Canvas Design. 

 

 
 
 

Title bar – 
Menu bar – 

General toolbar –  
Stitch and Color Bar – 

Edit Toolbar –  
 

Строка заголовка  
Строка меню 
Общая панель инструментов 
Панель Стежок и Цвет 
Панель инструментов правки 
 

Edit Toolbar – 
Digitize Toolbar -
Arrange Toolbar-

Craft Stitch Toolbar– 
View  Mode Toolbar- 

Status bar - 

Панель инструментов правки 
Панель оцифровки  
Панель размещения 
Панель рукодельных стежков 
Панель режима просмотра   
Строка состояния 

Режим  Art Canvas 
 

Загружайте, 
редактируйте, 
сохраняйте в качестве 
фона для оцифровки 

вышивок любую графику. Это включает весь 
набор, предоставляемый программами 
CorelDRAW® Essentials 4. Дополнительно, 
предоставляется возможность 
конвертировать векторные рисунки и тексты 
непосредственно в объекты вышивания. 

В режиме Art Canvas, панель инструментов 
View Mode содержит кнопку Show Embroidery 
для включения/выключения дисплея вышивок. 
 
Ниже на рисунке показан вид рабочего экрана в 
режиме Art Canvas,  доступ к которому 
осуществляется через панель инструментов 
View Mode. Этот режим работы позволяет 
создавать и изменять векторную графику, 
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используя инструментарий CorelDRAW® 
Essentials 4,  позволяющий использовать 

различные продвинутые техники для создания 
набросков и рисунков прямо с экрана. 

 

 
 
Дополнительно к инструментарию CorelDRAW® 
Essentials 4, режим Art Canvas предоставляет 
возможность конвертировать векторную 
графику и тексты непосредственно в объекты 
вышивки. Векторная графика и тексты, 
созданные или импортированные в режиме Art 
Canvas можно непосредственно конвертировать 
в объекты вышивки. Можно использовать режим 
Art Canvas, чтобы вставлять векторную графику 
других производителей, например заготовочные 
рисунки для образцов вышивки. Дополнительно 
можно использовать растровые образцы для 
использования в качестве оцифровывающего 
фона.  
 
ВНИМАНИЕ: Полное описание инструментария 
программы CorelDRAW® Essentials 4 приводится 
в электронном Руководстве пользователя, 
которое можно найти в разделе меню Windows 
Start > Programs. Можно использовать экранную 
систему помощи с помощью меню Help в режиме 
Graphics. 

 

Режим Hoop Layout 
 
 
 
 
 

Позволяет просматривать и 
редактировать проекты, не помещающиеся 
в пяльцах. Если ваша вышивка слишком 
велика, или содержит много образцов, 
расположенных на пространстве, 
разбитом для вышивки на многих пяльцах. 
 
Ниже на рисунке показан вид рабочего 
экрана в режиме View Mode,  доступ к 
которому осуществляется через панель 
инструментов View Mode. 
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Если ваша вышивка слишком велика, или 
содержит много образцов, можно разбить 
ее на несколько пяльцев. Это позволяет 
вам создавать и работать с образцами, 
размер которых превышает размер любых 

отдельных пялец. Режим Hoop Layout 
позволяет установить положение и 
последовательность использования каждых 
пялец. См. раздел Закрепление в пяльцах 
крупных проектов

 
 
Строка меню Embroidery Canvas   
 
Строка меню окна Embroidery Canvas 
располагает описываемыми ниже 
выпадающими меню. Не все команды 
имеются во всех уровнях продукта. 
Некоторые их них доступны также через 
кнопки панелей инструментов. 
 
Примечание: Стандартная клавиша Alt 
системы Windows® используется для 
клавиатурных команд. Используйте 
клавишу Alt совместно с подчеркнутой в 
меню буквой. Для отмены операции 
нажмите дважды клавишу Esc. 
 
Меню File (Файл) 
 
New  Открыть новый пустой проект   
Open  Открыть проект.  
Close  Закрыть текущее окно проекта  
 

 
 
 
 
 
 

 
 
 
 
Portfolio  Запустить приложение BERNINA 

Portfolio и открыть проект  
 

Cross Stitch  Запустить программу вышивки 
крестом  
 

Quilter  Запустить программу квилтинга 

Insert Design  Вставить существующий проект  

Save  Сохранить текущий проект  
Save As  Сохранить текущий проект под 

другим именем, в другом месте 
или формате  
 

Save Design 
As Image  

Сохранить изображение проекта 
в режиме Design View или Artistic 
View. Сохраненное изображение 
точно такое, как появляется на 
экране.  
 

Design 
Properties  

Показать информацию о 
проекте, такую как размеры или 
количество стежков, и добавить 
комментарии о проекте для 
распечатки.  
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Print  Распечатать проект.  

 
Print Preview  Показать рабочий документ 

проекта. Распечатка рабочего 
документа из этого окна.  
 

Card / 
Machine Read  

Считать (открыть) проект из 
карты BERNINA Design Card или 
вышивальной машины 
BERNINA.  
 

Card / 
Machine Write  

Записать (сохранить) проект на 
карте BERNINA Design Card или 
в вышивальной машине 
BERNINA.  
 

Write to Magic 
Box  

Записать (сохранить) проект на 
карте памяти в приборе Magic 
Box.  

Read from 
Magic Box  

Считать (открыть) проект с 
карты памяти в приборе Magic 
Box.  
 

Recent File 
List  

Показать список недавно 
использованных файлов. 
Выбрать файл для открытия.  
 

Exit  Закрыть все открытые проекты и 
выйти из программы BERNINA.  

 
Меню Edit (Редактирование) 
 

Undo  
Отменить последнюю команду.  
 

Redo  Повторить выполнение 
отмененной команды.  
 

Cut  Удалить выделение с 
помещением в буфер обмена.  
 

Copy  Скопировать выделение в 
буфер обмена.  
 

Paste  Вставить содержимое буфера 
обмена в окно проекта.  
 

Duplicate  Дублировать выделение с 
помещением в текущее 
выделение.  
 

Delete  Удалить выделение без 
помещения в буфер обмена.  
 

Select All  Выделить все объекты в 
проекте.  
 

Deselect All  Отменить выделение всех 
объектов в проекте.  
 

Stitch Edit  Переместить вставленную точку 
в выбранную точку проекта.  

 

 
Smooth Curves Используйте функцию  

Smooth Curves, чтобы удалить 
лишние узлы изменения формы 
объектов вышивки. 
 

Lettering   
 

Изменить настройки текста.  

Elastic 
Lettering  

Применить специальные 
эффекты  к текстовым 
объектам, чтобы сделать текст 
выпуклым или дугообразным, 
растянутым или сжатым.  
 

Monogramming Создать персонализированные 
монограммы с выбором 
стандартных стилей монограмм, 
форм обрамления и 
орнаментов.  
 

Touch Up 
Picture  

Открыть стороннюю программу 
рисования для правки рисунка. 
  

Crop Image  Кадрировать изображение для 
использования в приложении 
PhotoSnap.  

 
 
Меню View (Вид) 
 
By Color  Показать только выбранные 

цвета в проекте.  
 

Needle Points Показать или скрыть точки 
прокола иглы. 
 

Picture  Показать или скрыть рисунок 
фона.  
 

Overview 
Window  

Показать или скрыть 
пиктограмму проекта.  
 

Show 1:1  Показать проект в натуральную 
величину.  
 

Show All  Показать проект целиком.  
 

Center Current 
Stitch 

Выровнять по центру текущий 
стежок. Есть и команда С + F6. 
 

Previous View Вернуться к предыдущему 
экрану просмотра. Есть и 
команда V + F5. 
 

Zoom Out 2X  Уменьшить 50 % текущее 
изображение проекта. Есть и 
команда Shift + Z + F10. 
 

Zoom In 2X Увеличить текущее 
изображение проекта до 200%. 
Есть и команда Z. 
 

Zoom   Увеличить и уменьшить 
изображение в окне проекта и 
увеличить в оконтуренных 
областях до полного размера 
окна. Есть и команда F8. 
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Zoom Factor Коэффициент масштаба 
Есть и команда F + F3. 
 

Redraw  
 

Перерисовать проект.  

Slow Redraw  Медленно перерисовать проект, 
чтобы увидеть 
последовательность 
вышивания.  
 

Hoop  Показать или скрыть пяльцы и 
изменить размеры и положение 
пялец.  
 

Grid  Показать или скрыть сетку и 
настроить размеры ячеек.  
 

Measure  Измерение размеров проекта.  
 
 
Меню Arrange (Расположение) 
 
Start and End  Установить начальную и 

конечную точки проекта.  
 

Stitch 
Sequence  

Автоматический выбрать 
последовательность вышивания 
для сведения к минимуму числа 
обрезок нитки и изменений 
цветов.   
 

Sequence as 
Selected  

Установить последовательность 
вышивания выделенных 
объектов в порядке выбора.  
 

Sequence to 
Start  

Переместить выбранный объект 
в начало последовательности 
вышивания.  

Sequence to 
End  

Переместить выбранный объект 
в конец последовательности 
вышивания.  
 

Sequence by 
Color  

Установить последовательность 
вышивания объектов в порядке 
выбранных цветов.  
 

Color Film  Открыть диалоговое окно Color 
Film.  
 

Mirror 
Horizontal  

Перевернуть выбранные 
объекты по горизонтальной оси. 
  

Mirror Vertical  Перевернуть выбранные 
объекты по вертикальной оси.  
 

Group  Сгруппировать выбранные 
объекты в единый объект.  
 

Ungroup  Разделить сгруппированные 
объекты в отдельные 
компоненты.  
 

Break Apart  Разделить монограммы, 
аппликации, тексты и элементы 
"черной вышивки" на отдельные 
объекты.  

 

 
Lock / Unlock 
All 

Блокировка и разблокировка 
объектов, с целью защитить их 
во время оцифровки или при 
редактировании. Клавиши 
быстрого выбора команды: K и 
Shift+K.  
 

Remove 
Overlaps  

Удалить нижний слой вышивки в 
перекрывающихся объектах.  
 

Add Holes  Удалить вышивальные стежки из 
формы (оставление отверстия).  
 

Fill Holes  Заполнение отверстий в 
объектах.  
 

Add Buttonhole Добавить пуговичную петлю к 
проекту.  
 

Pattern Stamp  Добавление единичных узоров в 
проект. 
 

Close Object Используйте эту команду, если 
вы хотите замкнуть объект, 
указав в опциях, какую 
замыкающую линию 
использовать: прямую или 
кривую. 
 

 
Меню Settings (Настройки) 
 
Thread 
Colors  

Назначить цвета ниток для 
использования в проекте.  
 

Fabric 
Settings  

Назначить типы тканей и настройки. 

Fabric 
Display  

Выбрать ткани и цвета фона.  

Object 
Properties  

Настроить свойства для выбранных 
форм.  
 

Options  Выбрать настройки для 
отображения окна.  
 

Security  Ввести коды для обновления или 
добавления опциональных функций.
  

Display 
Setup  

Калибровать экран.  

Scanner 
Setup  

Настройка опций сканера.  

Create 
Pattern  

Создание узоров с присвоением 
имени   
 

Create 
Border  

Создание обрамлений с 
присвоением имени   
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Меню Help (Справка) 
 
Help Topics  Вывести список тем 

онлайновой справки  
 

Onscreen Manual  Открыть отображаемое на 
экране руководство в 
формате Adobe Acrobat 
(PDF).  
 

Quick Start Guide Краткое справочное 
руководство 
 

Release Notes Информация о версии 
About  Показать информацию о 

версии ПО BERNINA.  
 

Show Design 
Warning  

Отобразить предупреждение 
при открытии проекта, 
размеры которого не могут 
быть изменены.  
 

BERNINA® 
International Home 
Page  

Открыть веб-сайт BERNINA® 
International.  

BERNINA® of 
America Home 
Page  

Открыть веб-сайт BERNINA® 
of America.  

Embroidery Online  Открыть веб-сайт Embroidery 
Online.  
 

Access Code 
Order Form  

Открыть код доступа (Access 
Code) к онлайновому 
формуляру заказа.  
 

Purchase Upgrade 
on the Internet  

Купить программу 
обновления непосредственно 
через Интернет.  
 

Install Upgrade  Загрузить коды доступа для 
вашего донгла после 
уведомления по электронной 
почте об успешной 
онлайновой покупке 
программы обновления.  

 

Режимы просмотра 
 
В программном пакете BERNINA 
предусмотрено три режима просмотра. В 
разных режимах отображаются разные 
панели инструментов. 
 

 

Загружайте, редактируйте, 
сохраняйте в качестве фона 
для оцифровки вышивок любую 
графику. Это включает весь 
набор, предоставляемый 
программами CorelDRAW® 
Essentials 4. Дополнительно, 
предоставляется возможность 
конвертировать векторные 
рисунки и тексты 
непосредственно в объекты 
вышивания. 
 

 

Режим позволяет 
оцифровывать и редактировать 
образцы вышивки. Показывает 
как образцы вышивки, так и 
графические заготовки. Дает 
возможность просматривать 
образцы реалистически в 
трехмерной графике 3D. 
 

 

Позволяет просматривать и 
редактировать проекты, не 
помещающиеся в пяльцах. 
Если ваша вышивка слишком 
велика, или содержит много 
образцов, расположенных на 
пространстве, разбитом для 
вышивки на многих пяльцах. 
 

 В режиме Art Canvas, панель 
инструментов View Mode 
содержит кнопку Show 
Embroidery для 
включения/выключения 
дисплея вышивок. 
 

 
Панели инструментов BERNINA  
 
В окне проектов имеются описываемые 
ниже панели инструментов. Не все панели 
инструментов имеются во всех уровнях 
продукта. Некоторые из них снабжены 
кнопками для открытия выпадающих меню. 
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Общая панель инструментов (General) 
Эти инструменты доступны в режиме просмотра 
Embroidery Canvas. 

New  То же, что File > New.  
 
 
Open  

 
 
То же, что File > Open.  

 
 
Save  

 
 
То же, что File > Save.  

 
 
Print  

 
 
Печать проекта с 
текущими настройками 
печати.  

 
Print 
Preview  

То же, что File > Print 
Preview.  

 
Write to 
Machine  

То же, что File > Card / 
Machine Write.  

 
Read from 
Magic Box  

Считывание проектов с 
карты памяти с 
использованием Magic 
Box.  

Write to 
Magic Box  

Сохранение проектов на 
карте памяти с 
использованием Magic 
Box.  

Cut  То же, что File > Cut.  

 
Copy 
 
 

То же, что Edit > Copy.  

Paste То же, что Edit > Paste.  

 
Undo То же, что Edit > Undo.  

 
 
 
Redo 

 
 
Same as Edit > Redo.  

 
 
Show Grid 

 
 
То же, что View > Grid.  

 
 
Show Hoop 

 
 
То же, что View > Hoop. 

 
Show 
Picture 

 
 
То же, что View > 
Picture.  

Dim Artwork 

Понизить или повысить 
яркость изображения, 
чтобы более четко 
видеть стежки 

Show 
Vectors 

Включение/отключение 
функции просмотра 
векторной графики. 
 

Show 
Stitches  

Включение/отключение 
показа стежков.  

 
  

 
Show Artistic 
View 
 

Включение/выкключение 
просмотра вида вышивки. 

Show Appliqué 
Fabric показа ткани/цвета аппликации. 

 
Object 
Properties 

То же, что Settings > Object 
Properties.  

Auto Underlay Автоматическое добавление 
стабилизирующих стежков.  

Textured Edge Добавление к объекту 
текстурированных краев.  

 
Color Film То же, что Arrange > Color Film.  

Carving Stamp

Задатьпоследовательности 
протыканий иглы, используя в 
качестве шаблона “резной штамп”. 
 

Morphing 
Effect 

Cоздание наброска 
преобразуемого объекта и его 
стежков  

 
Zoom Box То же, что View > Zoom Box.  

Show 1:1 То же, что View > Show 1:1.  

 
Show All То же, что View > Show All.  

 
Панель изображения (Image) 
Эти инструменты доступны в режиме 
просмотра Art Canvas. 
 

Load Picture  
Вставка изображения в окно 
проекта в ПО BERNINA Embroidery 
Software.  

 
 
 
Scan Picture  

 
 
Сканирование изображения в 
BERNINA.  

Touch Picture  

 
Отделка рисунка в программе 
Corel PHOTO-PAINT Essentials 4 
 

Save Picture  Сохранение изображения после 
правки.  
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Панель Art 
Эти инструменты доступны в режиме 
просмотра Art Canvas. 
 

Convert Vectors 
to Embroidery 

 
Преобразование векторной 
графики в объекты вышивания. 
 

 

Convert Text to 
Embroidery 

Преобразование векторного 
графического 
текста в образцы вышивки) 
 

 
ВНИМАНИЕ: Полное описание инструментария 
программы CorelDRAW® Essentials 4 приводится 
в электронном Руководстве пользователя, 
которое можно найти в разделе меню Windows 
Start > Programs. Можно использовать экранную 
систему помощи с помощью меню Help в режиме 
Graphics. 
 
Панель инструментов правки (Edit) 
 
Эти инструменты доступны в режиме 
просмотра Embroidery Canvas. 
 

Select 
Object  

Выбор объектов вышивки для 
изменения размеров, 
перемещения, перевод в 
зеркальное отображение или 
вращения.  
 

Polygon 
Select  

Выделение зон неправильной 
формы.   

 
Reshape 
Object  

 
Изменение выделенных 
вышивальных и текстовых 
объектов.  

 
Mirror 
Horizontal 

То же, что Arrange > Mirror 
Horizontal.  

 
 
Mirror 
Vertical  

То же, что  Arrange > Mirror 
Vertical  

Rotate 
45°CCW 
/CW  

Поворот выделенных 
объектов шагами по 45°. Для 
поворота против часовой 
стрелки щелчок левой 
кнопкой мыши. Щелчок 
правой кнопкой – поворот по 
часовой стрелке.  

 

Scale by 
20% 
Down /Up  

Изменение размера 
выделенного объекта шагами 
по 20%. Щелчок левой 
кнопкой – уменьшение, 
правой кнопкой – увеличение 
объекта. 

 

 
Double 
Run  

Повторное выполнение стежков в 
выбранных объектах.  

 
 
Remove 
overlaps 

То же, что Arrange > Remove 
overlaps 

 
 
Add Holes 

 
 
То же, что Arrange > Add Holes 

 
 
 
Fill Holes 

 
 
То же, что Arrange > Fill Holes 

 
 
Break 
Apart 

 
То же, что Arrange > Break Apart 

 
 
Color 
Blending  

 
Оцифровка объектов со 
смешанным цветом.  

Image 
Preparation

 
Подготовка изображения к 
автоматическому 
оцифровыванию 
 

Convert 
Selected 
Embroidery 
to Art 
Vectors 

Преобразование образца 
вышивки в векторный рисунок 
 
 

  

 
Панель оцифровки (Digitize)  
Эти инструменты доступны в режиме 
просмотра Embroidery Canvas. 
 

Auto 
Digitizer  

Автоматическая оцифровка 
подготовленных изображений.  

 
Magic 
Wand  
 

Оцифровка простых форм в 
проекте.  

PhotoSnap Преобразование ч/б или цветной 
фотографии в вышивку.  

 
Open 
Object  
 

Рисование и оцифровка открытых 
форм.  

Closed 
Object  

Рисование и оцифровка закрытых 
форм.  

 
Free Hand 
Embroidery 
Open 
Object 

Рисование контуров вышивки 
прямо на экране, с просмотром  
вида стежков по мере рисования. 
 

 
Free Hand 
Embroidery 
Closed 
Object 

Рисование “от руки” заполненных 
замкнутых объектов на экране. 
 

 
Block 
Digitizing  

Оцифровка колонок с 
переменными стежками.  
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Circle / Oval  

Рисование и оцифровка 
овалов или 
окружностей.  

 
 
Rectangle  

Рисование и оцифровка 
прямоугольников или 
квадратов.  

Lettering / Fill 
Values 

Создание и изменение 
свойств букв. 
 

Monogramming 

Создание 
персонализированных 
монограмм с выбором 
стандартных стилей 
монограмм, форм 
обрамления и 
орнаментов.   

 
Auto Applique  

Оцифровка замкнутого 
объекта аппликации.  

 
 
Partial 
Applique  

Создание объектов 
аппликации с частичным 
покрытием вышивкой.   

Advanced 
appliqué 

Generate open-object 
applique 
from one or more source 
objects. 
 

Outline Design 

Вышивка контуров 
объектов одинарными, 
тройными или 
гладьевыми линиями, 
 

 
Cross Stitch 

То же, что File > Cross 
Stitch.  

 

Quilter То же, что File > Quilter.  

 
Панель рукодельных стежков (Craft 
Stitch) 
Эти инструменты доступны в режиме просмотра 
Embroidery Canvas. 
 

Blackwork 
Run  

Автоматический выбор 
последовательности 
вышивания выбранных 
объектов.  

Blackwork 
Border  

Оцифровка обрамления 
стежками черной 
вышивки.  

Blackwork Fill  
Оцифровка заполнения 
стежками черной 
вышивки.  

Candlewicking 
Border  

Оцифровка линии 
узелковым швом.  

 
Candlewicking 
Fill  

Оцифровка заполнения 
узелковыми строчками.  

 
Lacework  

Оцифровка заполнения 
стежками кружевного 
переплетения .  

 

Stipple Run Оцифровка заполнения 
пунктирными стежками.  

Backstitch  
Оцифровка линии 
стежками  "назад в 
иголку".  

 
Stemstitch  

Оцифровка линии 
стебельчатыми 
строчками.  

Ripple 

Спиральное 
прострачивание от 
центра любого 
заполненного объекта. 
 

 
Панель стежков и палитры цветов (Stitch 
and Color) 
 

Выбор 
оконтуривающих 
стежков для новых и 
выделенных 
объектов.  
 
Показ типов 
оконтуривающих 
стежков для 
выделения.  
 
Выбор заполняющих 
стежков для новых и 
выделенных 
объектов.  
 
Показ типов 
заполняющих стежков 
для выделения.  
 
Установка углов 
наклона стежков для 
выбранных объектов. 
 
Удаление углов 
наклона стежков для 
замкнутых объектов с  
поворачиваю-щимися 
стежками. 
 
Формирование 
поворачивающихся 
заполняющих стежков 
нескольких типов, 
например, гладьевых 
и типа татами. 
 
Контурные 
заполняющие стежки 
вдоль оцифрованной 
направляющей линии, 
поддерживающие 
постоянную плотность 
и варианты игольных 
проколов  
 

 
 

 
 
 
 

 
 

 
 
 
 
 
 

 

Список доступных 
цветных ниток.  
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Панель размещения (Arrange) 
Эти инструменты доступны в режиме 
просмотра Embroidery Canvas. 
 

Group  То же, что Arrange > Group.  

Ungroup  То же, что Arrange > Ungroup. 

 
Lock 
 
 

 

Unlock  

 
Align Left 
(Vertical)  

Выравнивание выбранных 
объектов по левому краю.  

 

Align 
Centers 
(Vertical)  

Выравнивание центров 
выбранных объектов по 
вертикали.  

 
Align Right 
(Vertical)  

Выравнивание выбранных 
объектов по правому краю.  

 
Align Top 
(Horizontal)  

Выравнивание  выбранных 
объектов по верхнему краю.  

 

Align 
Centers 
(Horizontal)  

Выравнивание центров 
выбранных объектов по 
горизонтали.  

 

Align 
Bottom 
(Horizontal)  

Выравнивание  выбранных 
объектов по нижнему краю.  

 

Align 
Centers  

Выравнивание центров 
выбранных объектов по 
центру проекта.  

 

Mirror- 
Merge 
Horizontal  

Зеркальное переворачивание 
по горизонтали с 
дублированием объектов  

 

Mirror- 
Merge 
Vertical  

Зеркальное переворачивание 
по вертикали с 
дублированием объектов  

 

Mirror- 
Merge 
Horizontal 
& Vertical  

Зеркальное переворачивание 
по горизонтали и вертикали с 
дублированием объектов  

Wreath  Дублирование объектов 
вокруг центральной точки.  

 

Kaleidos-
cope  

Зеркальное переворачивание 
объектов вокруг центральной 
оси.  

 

 
Панель Color Film 
 

Show 
Individual 
Objects  
 
 

Просмотр индивидуальных объектов в 
порядке последовательности 
вышивания. Перетаскивание значков 
объектов для изменения 
последовательности.   

Sequence 
As 
Selected 
 

Изменение последовательности 
выделенных объектов  

Sequence 
By Color  
 

Изменение последовательности 
объектов по цвету  

Sequence 
to Start  

Перемещение выбранного объекта в 
начало последовательности 
вышивания.  

Sequence 
to End  

Перемещение выбранного объекта в 
конец последовательности 
вышивания.  
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Панель Multi-Hooping 
Эти инструменты доступны в режиме 
просмотра Hoop Layout. 
 

Selection 
on 

Выбор пялецев в окне 
проекта. 

 
Reshape 
Splitting 
Guide 

 
Перерисовка разделительных 
линий в окне проекта Design 
Window. 

 
 
Add 
Hoop 

 

 

Центровка новых пялец в окне 
проекта в вертикальной 
ориентации.  

Add 
Hoop 
Right 

Помещение новых пялец 
непосредственно справа от 
выбранных пялец с 10-мм 
перекрытием полей 
вышивания.  

Add 
Hoop Up 

Помещение новых пялец 
непосредственно над 
выбранными пяльцами.  

Add Four 
Adjacent 
Hoops 

Автоматическое добавление 
четырех новых положения 
пялец по периметру 
выбранной позиции пялец. 

 
 
Add Eight 
Adjacent 
Hoops 

 
Автоматическое добавление 
восьми новых положения 
пялец по периметру 
выбранной позиции пялец. 

Splitting 
Guide 

Оцифровка разделительных 
линий большого образца 
перед тем, как передать 
информацию в файл, на 
машину или на карту памяти.  

 
 
 
Delete 
Hoop 

 

Удаление пялец из окна 
проекта.  

Rotate 
Hoop 

Щелкните по кнопке  левой 
или правой кнопкой мыши, 
чтобы повернуть выбранные 
пяльцы на 45° по или против 
часовой стрелки.   

 

Calculate 
Hoopings 

Определение количества 
перезаправок пялец на основе 
текущей компоновки пялец. 
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Клавиатурные команды 
 
Команды выбираются таким же образом, 
как и в других приложениях Windows®, – из 
меню или панелей инструментов. Для 
наиболее часто используемых команд 
имеются также клавишные комбинации 
быстрого вызова – клавиатурные команды. 
 
Общие функции   
Чтобы … следует нажать 

создать новый проект 
 
 

открыть существующий 
проект  
 
сохранить проект 
 
распечатать проект. 
 

отменить выполненную 
команду 
повторить выполнение 
отмененной команды 
отменить команду 
 

выйти из программы 
 

 
Выбор объектов 
Чтобы … следует нажать 

выделить все объекты 
 
отменить выделение всех 
объектов 
активировать инструмент Select 
Object 
выбрать объект, находящийся 
ниже 
выбрать несколько объектов 
 
выбрать нескольких 
последовательно 
расположенных объектов 
выбрать следующий объект 
выбрать предыдущий объект 

добавить следующий по 
очереди объект к выделенным 
добавить предыдущий по 
очереди объект к выделенным 

 
 

Просмотр проектов 
 

Чтобы … следует 
нажать 

или 

увеличить в 2 раза 
 
уменьшить в 2 раза 
увеличить до размера выделенной 
зоны 
установить масштаб 1:1 (100 %) 
задать коэффициент 
масштабирования 
показать проект целиком 
Показать предыдущий вид 
просмотра  
 

 
Чтобы … следует 

нажать 
или 

задать коэффициент 
масштабирования 
выровнять по центру текущий стежок 
вернуться к предыдущему экрану 
просмотра 
перерисовать экран 
показать / скрыть изображение 
показать / скрыть векторы 
Включить / выключить просмотр 
вышивки 
показать точки прокола иглой 
 

 
показать только выделенные 
объекты 
измерить 
показать контуры (только для 
BERNINA Quilter) 

 
Просмотр последовательности 
вышивания 
 

следует нажать Чтобы перейти ... 
на основной 
клавиатуре 

 на цифровой 
 панели  

к началу проекта  

к концу проекта  

к следующему цвету  

к предыдущему цвету  

к следующему объекту  

к следующему выбранному 
объекту 

 

к предыдущему объекту  

к предыдущему выбранному 
объекту 

 

на 1 стежок вперед †  

на 1 стежок назад †  

на 10 стежков вперед †  

на 10 стежков назад †  

на 100 стежков вперед  

на 100 стежков назад  

на 1 сегмент вперед  

на 1 сегмент назад  

активировать замедленное 

перерисовавание 

 
 

* Клавиша Num Lock отключена  
† Функция инструмента Select Object отключена 
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Оцифровка и создание текстов 
 
Чтобы …  следует нажать 
Запустить двойной прогон  
Удалить последнюю 
введенную точку 

* 

завершить оцифровку 
объекта 

* 

включить / выключить 
стабилизирующие стежки 

 

отобразить диалоговое окно 
текста 

 

* Только для BERNINA DesignerPlus 
 
 
Работа с объектами и стежками 
 
 

Вырезание и вставка объектов 
 
Чтобы … следует нажать 
вырезать объект  

скопировать объект  

вставить объект  

дублировать объект  

клонировать объект   
усилить контур 

удалить выделенный объект / 

объекты или последний 

объект 

 

 

 
Для того, чтобы …  нажать или щелкнуть мышью
перемещать выделенные объекты 
отдельными шагами 

 

переместить объект по горизонтали и 
вертикали 
 

 

сохранить пропорции объекта во 
время изменения размеров 
 

† 

изменить тип контрольной точки 
изменения формы 

 

 
 
 
 

 

объединить в группу выделенные 
объекты 

 

разгруппировать выделенные 
объекты 

 

перегруппировать разгруппированные 
объекты 

* 

Заблокировать выделенный объект  
Разблокировать выделенный объект 
 

 

перевести объект на передн. план * 
перевести объект на один слой 
вперед 

* 

перевести объект на задний план 
 

* 

перевести объект на 1 слой вперед * 
активировать редактирование стежка  

 
†Используйте Alt+Drag с BERNINA Quilter  
* Только для BERNINA Quilter  
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